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SmartPTT Radioserver Configurator

Settings

In this tab you can configure the general settings of SmartPTT Radioserver:
e Radiosener,
e Licenses,
¢ Radio network seniices,
e Add-on Modules,
e Profiles,

e Subscriber groups,

e Metadata.

Radioserver

To set up the radioserver, click Radio Server in the left list of the SmartPTT Radioserver Configurator window. At

that, the Radio Server window opens.

’
@ SmartPTT Server Configuration - C:\Program Files (xB6\SmartPTT\Server\RadioService.exe.config E‘Elg
Settings | Networks | Client List | Rules | Activity | Log | Bxport/import Settings | Statistics |
E Radio Server
f?, Licenses
B4 Radio Network Services Server Fole [F‘rimary -
"'La-' Add-on Modules
ﬁ Profiles Name Radioserver
@ Subscriber Groups
l__ﬁ Metadata Inteface Port
[y ) [
Authentication
([ )
VolP Listen Port 18500
Block option [Hadio Disable -
Limit Radios to Service
[ Enabled Bxample: 199,150
Alowed Radio Mumbers
Process priorty Above nomal -
Language English
SmartPTT PLUS 9.1 6
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o Server Role: Sets the radioserver role: Primary or Redundant. Primary radioserver can have only one
redundant radioserver and vise versa. To configure the redundant radioserver settings, see the Redundant Radio

Senver section.

o Name: Radioserver alias. You cannot type more than 20 characters into this field.
e Interface and Port: Radioserver IP address, i.e. the IP address of the PC where the radiosener is installed.

Default port is 8888.

Note: If the specified port is occupied, you will see the warning icon @ next to the input field. Hover the mouse

over the icon to see where the port is being used.

o Authentication: Authentication parameters required for connection to the radioserver. Select No to set

anonymous authentication. Select Windows to set Windows authentication.

Note: If Windows is selected, to connect, the dispatcher must use the user name and password of the account

where the radioserver senice was started.

e VolIP Listen Port: Number of a UDP port for receiving wice data from the dispatcher.
o Block option: Allows selecting the way how to block a radio. When Radio Disable is applied, radioserver
sends the Radio Disable command to block the radio. The Deny Channel option denies the subscriber radio to

work on the given channel.

Note: The Deny Channel option is applicable only to IP Site Connect (direct IP connection) or NAI based

configurations.

Note: When the Block Radio command is sent from one radio unit to another, the radio will be blocked, even if

Deny Channel is selected.

e Limit Radios to Service: Allows to manage the number of radios allowed in the network. Here the user can
specify which radios are to be controlled by the system and which are not.
o Enabled: Select to make this functionality active.

o Allowed Radio Numbers: Enter ID's of the radios which are to be controlled by the system.
Warning! All the radios whose ID's were not specified will be ignored by SmartPTT system.

e Process priority: Allows selecting the priority that the system associates with a process. By setting this
parameter you can speed up or slow down SmartPTT performance. The highest possible priority is Real time.

Use it wisely! It may cause malfunctioning of the whole system. We recommend to use the Normal priority.
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e Language: Allows selecting languages of the user interface of the SmartPTT Radioserver Configurator

application.
You can save changes made by clicking Save . If you want to cancel changes made, click Restore L= . All

the changes made after the last save will be restored. To exit SmartPTT Radioserver Configurator, click Close

. To view help, click Help .

The radioserver is implemented as Windows senice SmartPTT Radio Senice. To enable saved changes you must

restart the senice. Senice is managed using the following buttons: Start, Stop and Restartl [> ] lﬁ] ll][} J

m)

Rl lg,j‘||§h| |
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Redundant Radio Server

To set up the redundant radioserver, perform the following actions:
1. Click Radio Server in the left list of the SmartPTT Radioserver Configurator window. In the Radio Server
window in the Server Role field select Redundant. At that the Redundant Radio Server item appears in the

left list of the SmartPTT Radioserver Configurator window.

-
] SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config S
Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Export/Import Settings | Statistics |
Select Redundant
----- pigaom, e s )
- Lndal [[&] enrer.‘___‘
""" T Licenses Bl | Server Role [H&duﬂdant 'T/
H-gf Radio Network Services
Bl Add-on Modules Name |P|1'mar:,l radioserver |
ﬂ Profiles
----- & Subscriber Groups nteface Port
- Metadata (192.168.37.85 ~|  [ss89
Mo -
ValP Listen Port 18500
Block option | Radio Disable -
Li Radios to Service
[ Enabled Example: 1-59.150
Process priority |f-\bove nomal - |
Language Endlish
SmartPTT PLUS 9.1 9
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2. Click Redundant Radio Server and in the Redundant Radio Server Settings window configure the required

settings.
-
@] SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config EIM
Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |
""" B8 Radio Server Redundant Radio Server Settings
----- L=} Redundant Radio Server
..... % Licenses Hedundancy
- Radio Network Services Primary server address 192.168.37.85:8888
G-{al Add-on Modules fhost:part)
ﬁ Profiles ) )
----- & Subscrber Groups Connection tmeout (&) &0
G-{gl Metadata Synichronize with primary radio server
[ Copy Settings ]
Comespondence table
AddVale || Add || Dekte |
Change Type Value/Parameter E;ﬂl;ndant R e
Value 1000 1010
Farameter Mame - Radio Server Redundant Radioserver

o Redundancy: The redundant server can be useful in case of the primary server breakdown. Switching between
the servers is made automatically. In the Network Configuration tab you can set up automatic radioserver

redundancy error notifications.

Attention! The redundant server is activated only on the condition that the last connection to the

primary server was no later than 31 days ago.

o Primary server address (host:port): The primary radioserver IP address and port.

o Connection timeout (s): Time interval that starts ticking as soon as the primary server is down. If the
primary server has not recovered within the specified time interval, the redundant server takes over. The least
possible value is 20 seconds.

o Synchronize with primary radio server: Enabling/disabling the auto synchronization of the redundant

server with the primary one.

Note: When Synchronize with primary server is selected, the Settings, Networks, Network

Configuration and Rules tabs are unavailable for editing except for the following parameters: Server Role and
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Language (Settings > Radio Server), redundant radioserver settings (Settings > Redundant Radio

Server) and alarm notification settings (Network Configuration > Radio Server).

o Copy Settings: Copies the primary radiosenver settings to the redundant one.

Note: If Synchronize with primary server is selected, the primary radioserver settings will be copied in
accordance with Correspondence table.
o Correspondence table: Table of value and parameter replacement rules. It is available for editing only if

Synchronize with primary server is selected.

Click to add a parameter to
Corespondence table

Click to add a walue ta
Corespondence table

Click to delete a value or parameter
from Conespondence table

-...,_H_h Comespondence table

AddValie | [ AddParmmeter | | Delete
Change Redundant Radio Server
Torz Value/Parameter Value

Value 1000 1010
Parameter Name - Radio Server Redundant radio server

o Change Type: Data type to be changed: Value or Parameter.
o Value/Parameter: The numerical value or the parameter name to be changed on the redundant radioserver.
o Redundant Radio Server Value: The value assigned to the redundant server.
To replace a certain value of all primary server parameters and add it to Correspondence table, click Add Value.
In Correspondence table in the Value/Parameter field enter the value to be replaced and in the Redundant
Radio Server Value field enter the replacing value.
To replace a certain parameter for the redundant server and add it to Correspondence table, click Add
Parameter. At that the Parameter Overriding window opens.
To edit a certain value or parameter in Correspondence table, double-click the required table row and make
necessary changes.

To delete a value or parameter from Correspondence table, click the required value or parameter and click Delete.
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To change a certain parameter value for the redundant server, perform the following actions in the Parameter

Overriding window:

’
Parameter Cverriding E@u

Settings |Networks|
o ] Radio Server | Parameter

-4 Radio Network Services Name b
- SMS Gateway
. L. Modem Settings Value
i i File Receive Redundant radio server

=, Add-on Modules
.. B8 Indoor Tracking

L:J"‘. Evertt Log Add

&-{[%] Phone Calls
EIL]:| Telephone Interconnect
i Incoming Calls
i.gm Outgoing Calls
----- a Clients Connection
2- Monitoring
E{ﬁ} Settings
% Automatic Database Backup

Parameter Walue

Redundant radio server |

1. In the setting tree of the Settings or Networks tab select the required item.

Note: The structure of the Settings and Networks tabs corresponds to the structure of the same SmartPTT

Radioserver Configurator tabs.

SmartPTT PLUS 9.1 12
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2. In the Parameter drop-down list select the required parameter.

Select the required parameter

Parameter /

Irteface
Process priorty
Paort

Language

3. Inthe Value area either enter the value, select it in the drop-down list or select/unselect the checkbox.

Enter the parameter value

Select the parameter walue

Below nomal
Momal
Above nomal
High

Real time

Select/Unselect the checkbow

4. To add the changed parameter to Correspondence table, click Add.

5. Having added all the required parameters click Finish.

Attention! You must always override the Peer ID parameter for the following network topologies: NAI
IP Site Connect, NAI Capacity Plus and NAI Linked Capacity Plus. The primary and redundant servers

must have different Peer IDs in the mentioned topologies.

SmartPTT PLUS 9.1 13
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How to Set up the Redundancy in SmartPTT Radioserver Configurator and

SmartPTT Dispatcher.

To make the redundant server work correctly, perform the following actions:

1. Take two radioservers and define their roles: Redundant or Primary. In the settings of the redundant server
enter the IP address of the primary radioserver. A primary server can be backed up only with one redundant
sener. If needed, configure the synchronization of the redundant server with the primary one.

2. Make sure that both radioservers are up and running.

3. Add both radioseners into the dispatch console (Settings > Radioservers). Make them both active.

4. Check that you can see both radioservers online in the Radio Fleet panel of SmartPTT Dispatcher.

SmartPTT PLUS 9.1 14
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Licenses

In the Licenses menu you can see the senices which are available to you in the SmartPTT software and install

a new license if needed.

-
@] SmartPTT Server Configuration - C:\Program Files (x88)\SmartPTT\Server\RadioService.exe.config @m

Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |

----- B9 Radio Server Licenses
----- 4§ Licenzes
EJ--# Radio Netwark Services licensedto:  SmartPTT Customer Name
[-]l__,'_J Add-on Modules Licenze key (D ADADADAD
""" B Tallysman Cortacts:
----- B Indoor Tracking ]
R Evert Log Address:
-] Phone Calls Support expiration date: 10172016
E'" Bridging iration -
----- Wy Voice Netfications License Quantity DE:E
..... Web Servi =
Ea--g Voo Telephone Interconnect Service 1 w206 =
E]--ﬂ Profiles Additional Dispatchers 2 10/1/2016
----- Subscriber G
EJ__% M';:g;t:r roups Radio Network Eridging Service 1 10/1/2016
Monitoring Service 1 10412016
SHMP Service 1 10/1/2016
Web Service 1 10/1/2016
Indoor Tracking 1 10412016 i

| Change License |

Activation
Hardware |0

Collect | | Copy

Availability of the seniices is regulated by the license file. It contains licenses—permissions to use the particular
number of particular senices. They'll be Those licenses are being called here as senices.

At the fresh start the SmartPTT software generates demo license file which works for a small period of time. You
cannot extent its activity period and you should obtain a regular license file.

Regular license file binds to the hardware of the primary radioserver PC or redundant radioserver PC. Hardware 1D
(HID) is required for the binding.

To obtain hardware ID via SmartPTT Radioserver Configurator:

1. Run SmartPTT Radioserver Configurator.
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Radioserver Configurator User Guide



2. Inthe Settings tab click Licenses.
3. Click the Collect button in the Activation area of the Licenses window. The code which appears in the

Hardware ID field is the hardware ID.

Activation
Hardware 1D

Click to collect HID { Collect Copy

4. Click Copy to copy the hardware ID to the clipboard.

Activation
Hardware 1D
B610FB4B-BEDBE423-B0253BCF-6508CBF5-51242659

Collect Coy ] Click to copy HID
£y to the clipboard

To obtain hardware ID without SmartPTT Radioserver Configurator, please, refer to the following article on the
SmartPTT Technical Support Center website.
When you get the license file, you should install it. To do this:

1. Run SmartPTT Radioserver Configurator.

2. In the Settings tab click Licenses.

3. Click the Change License button.

l Change License l ‘ | I Clic:l-g to inst;:ll
| | | I the license file

SmartPTT PLUS 9.1 16
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4. Open the received license file. The License Installation window will appear.

.
License Installation u

Licensed to: SmartPTT Enterprise Demo 9.0 (expires on
2016-08-31) Mame of the service
License key 1D: FSCF3C30| o _
IUpdate subscription expiration date: 10.04 2017 Availability of the service or
Cortacts: number of permitted
: connections to the service
Address:
; . L - I The last day of the
License Quantity Expiration Date service availability

Telephone Interconnect Service 31.08. 2016

Repeater |IP Connections 5 31.08.2016 -

Additional Dispatchers 2 31.08. 2016

Radio Metwork Bridging Service 1 31.08. 2016

Monitorng Service 1 31.08.2016

SHMP Service 1 31.08.2016

Web Service 1 31.08 2016

Indoor Tracking 1 31.08.2016

Connect Plus Data Support 1 31.08. 2016

Woice Console for Web Service 2 31.08.2006 i

Ay || Cancel

Installing the right license file

SmartPTT PLUS 9.1 17
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5. Check the information in the License Installation window. Pay attention to the table to check if you have

all the seniices you need.

Note. If the license does not match the product or the hardware, Licensed to text will be red and the senvices table

will be empty.

’
License Installation u

Licensed to: SmartPTT Basic 9.0 Demo {expires on 2016-08-31)
License key 1D: BECBEOFD
|Update subscription expiration date: 10.04 2007
Cortacts:
Address:
License Cluantity Expiration Date

Installing the wrong license file

6. To accept the license click Apply. To cancel the license installation click Cancel.

7. Click OK in the notification window, save changes and restart the radioserver.

Click to save changes

Click to restart
the radioserver

L
P @ @ Service: Running

After the license installation in the Licenses window the available senices will appear as they were in the License

Installation window.
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Different senices may have different expiration date. When the senice is expired, it will be written red in the table.

License Cuartity E;gatiun
Indoor Tracking 1 31.08.2016
Connect Plus Data Support 1 31.08.2016
Voice Console for Web Service 2 3.082016
MAl Data for IP Site Connect 1 31.08.2016
MAI Data for Capacity Plus 1 31.08.2016
MAI Data for Linked Capacity Flus 1 31.08. 2016

When the expiration data approaches, you will start to get notifications at the start of SmartPTT Radioserver

Configurator:

rWa rning u

Your SmartPTT PLUS Support license will expire in 59 dayis). Please contact
Motorola Solutions or your distibutor to renew your Support license and
continue to get SmatPTT PLUS support, latest software uparades.,
mairtenance releases, and license updates.

Select to remind in 5 days, ] Remind mein 5 days

not at the every start of
SmartPTT Radioserver Configurator
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In addition, yellow triangle will appear near the dates, notifying about the approaching of the expiration date.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

P

Settings | Networks | Client List | Rules | Activity | Log

| Export/import Settings | Statistics |

- E8 Radio Server Licenses
E
G-§# Radio Network Services Licensedto:  Sm..
[#-{... Add-on Modules (expires o ev . _
-4, Profiles License key 1D FSCF3C30
i, Subscriber Groups Contacts:
l_j] Metadata

Address:

Update subscription expiration date:

.f, \\
10042017 .L /

License Quantity E;}i:;mﬁon i
Web Service 1 31.08.2016 D
Indoor Tracking 1 31.08.2016
Connect Plus Data Support 1 31.08.2016
Woice Console for Web Service 2 3.08.2016 i

You cannot update or upgrade to the SmartPTT software released later of the expiration date of annual support.

Newertheless, your current software will continue to operate without any limitations until the licensed services are not

expired. You could also be provided with the limited technical support for the SmartPTT software.

To use the newest version of the SmartPTT software with all new features, please, renew the annual support.

SmartPTT PLUS 9.1
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Services

ARS

ARS or registration senice provides information on the availability of radio subscribers in the radio network.
To set up the registration senice parameters, click ARS in the list in the left area of the SmartPTT Radioserver

Configurator window. At that, a new window appears on the right.

-
ﬁ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |
----- F9 Radio Server ARS
----- :ﬁ Licenses )
g Radio Network Services Active
..... ARS )
{:) ope [ Use Radio Check
-6 TM3 Radio Inactivity Timeout, s 600
----- (s Telemetry
""" "?) Subscriber Blacklist Global Minimum Regquest Interval, ms 1000
2] Email Gateway
E]---E SMS Gateway Automatic update of registration, h 0.5 =

Active: Select to enable the senvice.

Use Radio Check: This setting defines the mechanism used for checking radio subscriber presence in the network.
If selected, the system uses the Radio Check command. This option was implemented for radios that do not support
ARS.

Radio Inactivity Timeout, s: Time period, after which the radio that did not display any activity becomes potentially

absent. In this case the system includes this radio into a special presence check process.
Note: Radio activity includes the following events: GPS location, telemetry signal, text message or wice call.

Generally, a radio can be sent 5 presence check requests successively with a 30-second interval. This parameter is
called Individual Minimum Check Interval and equals 30s; it can't be changed in SmartPTT Radioserver Configurator.
This parameter sets the interval between presence check requests sent to one radio. Therefore, it can be increased
depending on the number of radios to check. If the radio does not respond to the presence check requests and does
not display any activity, it will acquire the Offline status after the 5th unsuccessful presence check request.

Global Minimum Request Interval, ms — sets the minimum interval between presence check requests sent to all
inactive radios in all networks. Instead of sending presence check requests to all inactive radios at one time, the
system puts them on a queue and sends one presence check request to one radio at a time with the interval set in

the Global Minimum Request Interval field. This method allows us to eliminate the risk of sending too many

SmartPTT PLUS 9.1 21
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presence check requests at one time, thus removing traffic overload on the channel and spreading network load
evenly.

Example

There are three radios active till 10:00:00 and 10:00:02 (see pic. below). Then, for the following 600s they do not
display any activity. So, the radio activity timeout for Radios 1 and 2 runs out at 10:10:00 and for Radio 3 at
10:10:02. When it happens, the system creates a pool of inactive radios. The system puts the radios on a queue
and starts sending presence check requests with the interval set in the Global Minimum Request Interval field.
Radio 2 responds to the presence check request and is no longer regarded as potentially offline. Radios 1 and 3 do
not respond to the presence check request and do not display any activity, so the system sends another request in

30s to each radio. After the 5th presence check request, the radios get the Offline status.

30s

Individual Minimum
30s Check Interval

(=) 10:00:00 10:10:00 10:10:01 10:10:02 10:1(! 03 I

B —| & — O ..., —— ' | >

Radic 2 Radic 2 —\ Radie 2 . ‘I\/'YI ! !

.
€00 s .
’“- ------- 1 -‘@ @‘/ (=] =) |’-‘5\ I
1 . CJ [j CJ Global Minimum
1
= 10:00:00 10:10:00 1 . Iﬁ‘ 1 .-‘ Radic 1 Radio2 Radio 3 Radio 1 Radio 3 Request Interval
= = 1 Radic 2 J .
= @) 1.
_’I Cl _’I e > Radio 1 |
Radio 1 Radio 1 Radio 1 1 @ 1
1 Radie 3 1
S -
.‘ Pecl of inactive
= 10:00:02 10:10:02 .’ radios
=) O] =" i
Radio 3 Radio 3 Radio 3
=

@ - active radio

@ - inactive radio

v
@ - radio responded to check request

Automatic update of registration, h: If selected, the radio will send its ARS data to server at specified intervals.

Note: We recommend to specify the automatic reqistration update interval larger than the radio inactivity timeout

interval.
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GPS

GPS or location senvice provides coordinates of radio subscribers with a GPS receiver so you can determine their

current location.

To set up location service parameters, click GPS in the list in the left area of the SmartPTT Radioserver Configurator

window. At that, the following window opens.

~
ﬁ SmartPTT Server Configuration - ChProgram Files (x88\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Export/import Setiings | Statistics |
----- F9 Radio Server GPS
----- fﬁ Licenses _
=g Radio Network Services Active
..... ARS
&9 Minimum location update interval, = 30
G TMS
----- (& Telemetry Minimum Request Interval, s 1
----- 3 Subscriber Blacklist
[ __-'_'] Email Gateway ) L
518 SMS Gateway Radio Inactivity Timeout, 5 &0
----- @ File Receive
{1 Add-on Modules Get Subscrber Location for Following Groups:
-k, Profil
% Sublszs'iber Groups Group Mame Time Interval, = O /Off
E-{gll Metadata

Allow Dispatchers to Amend Location Update Time Interval

Active: Select to activate the location senvice.

Minimum location update interval, s: Minimum update time interval. If the time interval specified by the
dispatcher is less than Minimum location update interval, the new value set by the dispatcher will be ignored,
and subscriber location will be updated within Minimum location update interval.

Minimum Request Interval, s: The minimum interval between GPS requests sent to the radios within one network.
The requests can be sent automatically or initiated by the dispatcher. This method allows us to eliminate the risk of

sending too many GPS requests at one time, thus removing traffic overload on the channel and spreading network

load evenly.
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Radio Inactivity Timeout, s: Time period, after which the radio that did not send GPS becomes potentially absent.
In this case the radio receives a location update request.

system includes this radio into a special presence check process.

The Get Subscriber Location for Following Groups list allows you to specify location update time interval per
subscriber group added in SmartPTT Radioserver Configurator under Subscriber Groups.

If Allow Dispatchers to Amend Location Update Time Interval is selected, dispatchers can reduce the location
update time interval configured in the table above. However, if the time interval specified by the dispatcher is less
than Minimum location update interval, the new value set by the dispatcher will be ignored, and subscriber
location will be updated within Minimum location update interval. If Allow Dispatchers to Amend Location
Update Time Interval is not selected, dispatchers won’'t be able to change the time interval for location update,

and location will be updated within the time interval set in the table per each group.

Warning! If "Allow Dispatchers to Amend Location Update Time Interval” is not selected and there are no

subscriber groups in the table, the dispatcher won't receive any subscriber location data.

TMS

TMS or text messaging senice is used to exchange text messages between radio subscribers and SmartPTT
Dispatcher. To set up the messaging senice parameters, click TMS in the setting tree of the SmartPTT Radioserver
Configurator window. At that, the TMS window opens. To enable the messaging senice, select the Active check

box.

”
ﬁ SmartPTT Server Configuration - C\Program Files (x86\5martPTT\Server\RadioService.exe.config E@ﬂ

Settings | Networks | Client List | Rules | Activity | Log | Export/import Setiings | Statistics |

;- F Radio Server TMS
-4 Licenses
=-g# Radio Network Services Active
5 ARS

() GFS
-&EE
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Telemetry

The telemetry seniice is used for transmission and processing of telemetry signals between SmartPTT Dispatcher
and radio subscribers. To set up the telemetry senice parameters, click Telemetry in the list in the left area of the
SmartPTT Radioserver Configurator window. At that, the Telemetry Senice window opens. To enable the telemetry

senvice, select the Active check box.

.
@ SmartPTT Server Configuration - ChProgram Files (x86\5martPTT\Server\RadioService.exe.config E@g

Settings | Networks | Client List | Rules | Activity | Log | Bxport/import Settings | Statistics |

Telemetry Service

Active

Subscriber Blacklist

Subscriber blacklist allows managing the number of available radio subscribers and operators in the network.
To create a blacklist, first it is necessary to create subscriber groups. We will need these to form a blacklist.
To add a subscriber group, click Subscriber Groups in the setting tree of SmartPTT Radioserver Configurator. At

that, the Subscriber Groups window opens on the right.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Export/import Setiings | Statistics |
;-8 Radio Server Subscriber Groups
b % Licenses
&5 Radio Network Services Sample List of Subscribers for Group: 1.5.10-20
B+ .. Add-on Modules
ﬁ Profiles
B {Suosciver Goups dd | | Remove
- Metadata
e f‘ﬁ Group Mame Subscribers
Mew Group 1 1-12
Mew Group 2 13-24
Mew Group 3 25-36

Group Name: Any name of a subscriber group.

Subscribers: The list of radio IDs that are to be included in the created group.
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To configure blacklist parameters, click Subscriber Blacklist in the setting tree of SmartPTT Radioserver

Configurator. At that, the following window opens.

r
'ﬁ SmartPTT Server Configuration - Ch\Program Files (x86\5martPTT\Server\RadioService exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Export/import Setiings | Statistics |
----- % Radio Server Subscriber Blacklist
----- fﬁ Licenzes _
=g Radio Network Services Active
..... ARS
g GPS Action for Selected Groups
----- e TMS © Alow @ Deny
..... G Telemetry
----- 4% ] Subscriber Blacklist to Subscriber G
@-{—] Email Gateway Apply to Subscrioer Groups
- g SMS Gatn.ewa}r Group Name Active
----- @ File Receive
E-) .. Add-on Madules Mew Group 1
'ﬂ Profiles Mew Group 2 [
& Subscriber Groups
EJ"Eﬁ Metadata Mew Group 3 [
Blacking Retry Interval, s &0 EI
Blacking Retries 10 EI

Active: Select to enable the subscriber blacklist senice.

Note: Subscriber Blacklist allows not only blocking certain radios, but also creating the so-called "whitelist" of
radios that are allowed in the radio network. In the latter case all other radios, that is not included in the whitelist,

will be blocked.

To block certain groups of subscribers, choose Deny and select groups that are not permitted to communicate in
MOTOTRBO network.

To allow certain groups of subscribers to communicate in MOTOTRBO network, that is to create a whitelist, select
Allow and mark those groups that will be available in radio network when all other radios are blocked.

Blocking Retry Interval, sec: Sets a minimum time period for sending a command to block the radio added in the
blacklist.

Blocking Retries: Number of retries to send the Block command to the radio before confirmation comes.
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To save changes, click Save and then click Restart to restart SmartPTT Radioserver.

If a radio is in the blacklist and MOTORBO control station is used (MOTOTRBO control station, Capacity Plus
system), then the radio will be completely unavailable. When the radio is unavailable, some actions are still
available: Monitoring, Radio Check and Radio Unblocking. The dispatcher can remove the block from the radio
by sending the "Unblock" command. To enable the radio without dispatcher's help, just read the codeplug of the
radio in MOTOTRBO Customer Programming Software (called MOTOTRBO CPS) and then write the settings to the
codeplug.

To be able to process the Radio Disable command, the radio must have the Radio Disable Decode parameter
selected in the codeplug. You can find it in MOTOTRBO CPS, in the Signaling Systems section. If Radio Disable
Decode is not selected, the radio can't be blocked even if it is in the blacklist.

When direct IP connection is used (for example, IP Site Connect) in MOTOTRBO network, radio blocking allows to
block the channel only. At that, "Channel Denied" is displayed on the radio screen. The radio can change the
channel and resume its operation. To enable the blocked channel, the dispatcher should send the "Unblock"
command to the radio. To enable the radio without dispatcher's help, delete the blocked channel and create the

channel equal to the deleted one.
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Email Gateway

Email gateway provides the ability to exchange digital messages between e-mail users and MOTOTRBO radio

SmartPTT ‘

Dispatcher . / MotaTRBO Radio
Console / Hetwork
i IP-rgtwerk Subscribers
s ‘im”“ \\
~

network subscribers. The following scheme displays how it is done.

SmartPTT
Radiozerver

Email users

Corporate or public Email Server

To be able to exchange email messages between radio subscribers and email users you need:
1. Create and configure email account.

2. Configure the radiosenver.
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Create and Configure Email Account

First of all, create your email account, if you do not have one. This section describes how to do it as well as how to
configure it properly.
1. Create your email account. You can use your corporate email server or any other server. In this example we
are using gmail.com.
2. In the settings of the newly created email account specify all the necessary parameters.
3. In the settings of the email account in the Forwarding and POP/IMAP tab select the following items:
1) Enable POP for all email (even mail that has already been downloaded).
2) Enable IMAP.

3) Sawe changes.

General Labels Inbox Accounts and Import  Filters Forwarding and POP/IMAP  Chat Web Clips Labs Offline Themes

POP Download: 1. Status: POP is enabled for all mail that has arrived since /31,09
Learn mare () Enable POP for all mail (even mail that's already been downloaded)
() Enable POP for mail that arrives from now on
() Disable POP
2. When messages are accessed with POP | keep Gmail's copy in the Inbox hd

3. Configure your email client {e.g. Qutlook, Eudora, Metscape Mail)
Configuration instructions

IMAP Access: Status: IMAP is disabled
{azcess Gmail from other clients using [WA&F) @ Enahle IMAP

Learn maore : /O Disable IMAP

When | mark a message in IMAP as deleted:
(& Auto-Expunge on - Immediately update the server. {default)
O Auto-Expunge off - Wait for the client to update the server

When a message is marked as deleted and expunged from the last visible IMAP folder:
Archive the message (default)
Move the message to the Trash
Immediately delete the message forever

Folder Size Limits
& Do not limit the number of messages in an IMAP folder (default)

O Limit IMAP folders to contain no mare than this many messages | 1,000

) Configure your email client (e.g. Outlook, Thunderbird, iPhone)
Configuration instructions

__*[ Sawve Changes ] [ Cancel ]

4. If you have an email client (for example, Microsoft Outlook), for the outgoing messages you need the
following settings:
1) Use plain text as message format.

2) Use Unicode (UTF-8) for outgoing images (with Base64 encoder).
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Configure SmartPTT Radioserver Settings

The radioserver configuration includes the following steps:
1. Configure email gateway (activate email gateway, choose the direction of text message sending).
2. Setup POP3/IMAP4 protocols for sending text messages.

Email Gateway Configuration
Select Email Gateway in SmartPTT Radioserver Configurator.

~
@ SmartPTT Server Cenfiguration - C:\Program Files (x86\SmartPTT\Server\RadioService.exe.config E‘m
Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |
- Radio Server E-mail Gateway
ok Licenses )
=4 Radio Network Services Active
..... ARS
-{gd GPS
5%, TMS [7] Forward Messages to E-mail
""" G Telemetry Sender Name 1

(SR Email Gateway Recipients example @gmail com
L..{0h Settings

[]--@ SMS Gateway

----- @ Fil= Receive
G- .. Add-on Modules
ﬁ Profiles Add l [ Remove
&% Subscriber Groups
D"l__ﬁ Metadata Enable Direct Messages Delivery from Radio Netwark

Enable Direct Messages Delivery to Radio Netwoark

Receive protocol | POP3 -
Split Long Messages
Sender ID

Defemed actions
[ Ignore After Line

Select the Active check box to enable the email gateway senice.
Forward Messages to E-mail: Select to enable message forwarding from radio subscribers to the email addresses

specified in the Recipients list.

Note: When a radio subscriber sends a text message to another radio subscriber, all email users whose emails are
given in the Recipients list will receive 1 or 2 text messages. The first one with the confirmation that the message

was sent and the second — with the confirmation on delivery.
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Sender Name: Specify domain name, in the name of which all email messages will be sent (for example,
smartptt.com).

Recipients: List of email addresses to receive forwarded text messages.

Enable Direct Message Delivery from Radio Network: Forwarding mail messages directly from radio
subscribers.

Enable Direct Message Delivery to Radio Network: Forwarding mail messages directly to radio subscribers.
Receive protocol: Select protocol for email message receiving (POP3 or IMAP4).

Split Long Messages: If not selected, a long E-mail message, i.e. a message that contains more characters than
allowed in one message in the radio network, addressed to a radio is trimmed to not exceed the limit (some
information will be lost). If selected, the original message is split into several packages during transmission. Thus,
the radio subscriber receives the message without information loss.

Sender ID: When selected, the received message contains the sender e-mail address.

Deferred actions: When selected, it allows to deliver an information to the offline subscriber. When subscriber
becomes online, it will immediately receive it.

Ignore After Line: Ignore everything after a certain string in the received e-mail message.

Example:

The original e-mail message: Due to technical works on the PBX, the Pl will have no telephony for the whole day.To
turn off these notifications, open Personal Settings, click Manage Alerts. Clear check boxes next to unwanted

notifications.
If you enter To tumn off in the Ignore After Line field, the radio subscribers will receive the message: Due to

technical works on the PBX, the Pl will have no telephony for the whole day.
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POP3 Protocol Configuration
In the Receive Protocol field, select POP3 and click Settings in the left setting tree.

-
ﬁ SmartPTT Server Configuration - C:\Program Files (x86\SmartPTT\Server\RadioService.exe.config E‘E‘g
Settings | Networks | Ciient List | Rules | Activity | Log | Export/import Settings | Statistics |
--F Radio Server E-mail Gateway Settings
-, Licenses
-4 Radio Network Services Dutgoing Message Server (SMTF)
ARS SMTPF server smitp gmail com -
... GPS
-G TMS Port 587 =
..... (& Telemetry Use S5L
----- 2 Subscriber Blacklist
E_]H_J Email Gateway Authentication [LOgiI"I.‘"PEB&WOI‘d b
=y iree o oot
EJ"E SMS Gateway gin example@gmail .com
----- @ Fil= Receive Password AR EEEEEERERRNRES
G- .. Add-on Modules
ﬁ Profiles Send Test Message
&5 Subscriber Groups
D"l_-ﬁ Metadata Incoming Message Server (POP3)
POP3 Server pop.gmail.com -
Port 995 =

Enable S5L

Authertication | Login/Password -
Login example @gmail com
Password T TY T T,
Polling Delay 30 2 sec

Check Connection

SMTP server: Domain name of the SMTP server which is used for delivering outgoing email messages (for
example, smtp.gmail.com).

Port: SMTP server port number.

Use SSL.: Select this checkbox if you need secure connection to SMTP server.

Authentication: Select authentication method for SMTP server (Anonymous — connect anonymously, Windows —
connect to the server under Windows user account, Login/Password — connect with Login/Password specified).
Login: Email address or login required by the mail server.

Password: User password.

Send Test Message: Click the button to check server connection. In case of successful connection and correct
settings, the mail user specified above will receive a test email message.

POP3 Server: Specify domain name of POP3 server which is used to deliver incoming e-mail messages.
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Port: Enter POP3 server port number.

Enable SSL: Select this checkbox if you need a secure connection to POP3 server.
Authentication: Select authentication method for POP3 server.
Login: Enter email address or login required by mail server.

Password: User password.
Polling Delay: Polling interval for the mail server.

Check Connection: Click to check connection with the sener. In case of successful connection, the pop-up

window message shows the number of unread email messages in your email box. In case of connection failure, a

window with connection error message opens.

IMAP4 Protocol Configuration
Select "IMAP4" in the drop-down list of Receive protocol and click Settings.

r
@] SmartPTT Server Configuration - C\Program Files (x86\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Bport/import Settings | Statistics |
----- F Radio Server E-mail Gateway Settings
----- f?, Licenses
=g Radio Network Services Outgoing Message Server (SMTF)
ARS SMTP server smitp gmail com -
- GPS
..... G TMS Port 587 Iﬂ
----- (s Telemetry Use 55L
----- ©» Subscriber Blacklist
=) Email Gateway Authertication [chinr"l’asswnrd -
"o e | .
EEI---E SMS Gateway Login excample @gmail.com
----- @ File Receive Password EEREREREERRRRR RS
Bt Add-on Modules
ﬂ Profiles Send Test Message
----- & Subscriber Groups
-l Metadata Incoming Message Server (IMAP4)
IMAP4 Server imap .gmail com -
Port 953 e
Enable 55L
Authentication [ Login/Password -
Login escample@gmail.com
Fassword RN NNRNNERRRRS
o 0 -
Check Connection
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IMAP4 Server: Specify the domain name of IMAP4 server which is used for incoming email messages delivery.
Port: Enter IMAP4 server port number.

Enable SSL: Select this checkbox if you need secure connection to IMAP4 sener.

Authentication: Select authentication method for IMAP4 server.

Login: Enter email address or login required by mail server.

Password: User password.

Polling Delay: Polling interval for the mail server.

Check Connection: Click the button to check connection with the server. In case of successful connection, the
pop-up window shows the number of unread mail messages in your email. If connection is failed, connection error

window opens.

Supported Message Formats

When sending an email message to radio subscribers, use the following format of the message.

.| <ID|IP> <text message>

: — prefix indicating that this message is addressed to a radio subscriber or talkgroup.
<ID|IP> — ID or IP address of the radio subscriber or subscriber group.
Space indicates the beginning of the message body.

Use the Split Long Messages option to guarantee that a message won't be cut.

Example:

1. The email message :12.0.0.77 Hello! or :77 Hello! received from the mail server will be forwarded to the radio
subscriber with ID 77.

2. The email message :225.0.0.1 Please, call to the station received from the mail server will be forwarded to the
subscriber group with ID 1.

The email message :12.0.0.80,12.0.0.81,12.0.0.82,12.0.0.50 Hello! or :9080,9081,9800,9050 Hello! received from

the mail server will be forwarded to the radio subscribers with corresponding IDs.

SmartPTT PLUS 9.1 34
Radioserver Configurator User Guide



When sending a text message from a radio subscriber to an email user, use the following format.

<email_address> <text message>

: — prefix indicating that this message is addressed to an email user.
<email_address> — email address of the email user.

Space indicates the beginning of the message body.

Example:

1. The message :email_address@example.com Hello! from a radio subscriber will be forwarded to the email user
with the email address email_address@example.com.

2. The message :email_address1@example.com,email_address2@example.com Hello! from a radio subscriber

will be forwarded to the email users email_address1@example.com and email_address2@example.com.

Note: When Forward Messages to E-mail is enabled together with the options of receiving messages from radio
network and from the email, all messages sent or received by email users will be duplicated to the specified email

addresses.

SMS Gateway

SmartPTT Radioserver has an integrated SMS Gateway senice, which allows establishing communication between
radios and mobile phones There are 2 possible ways to communicate between each other:

1. A radio subscriber sends an SMS to a phone subscriber.

2. A phone subscriber sends an SMS to a radio subscriber.

To be able to send an SMS, it is necessary to do preliminary settings on both modem and SmartPTT Radiosenver.
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Configuring SmartPTT Radioserver and incoming messages

Select the SMS Gateway item in SmartPTT Radioserver Configurator.

-
Ql SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E‘M
Settings | Wetworks | Client List | Rules | Activity | Log I Export/Import Settings | Statistics|
- [E Radio Server SMS Gateway
ik Licenses .
=4 Radio Network Services Active
..... ~| ARS
e 5MS sending
5% TMS Alow SMS Delivery from Radios
----- Gg Telemetry Allow SMS Delivery to Radios
----- ©» Subscriber Blacklist
(] Email Gateway Incoming SMS messages
E'E Split Long Messages
0T Modem Settings
----- @ Fil= Receive Sender ID
- Addon Modules Defemed actions
-, Profiles
i Subscriber Groups
G- Metadata

Active: Select to enable SMS Gateway senvice.

Allow SMS Delivery from Radios: Select this option if you need to forward SMS directly from subscriber radios.
Allow SMS Delivery to Radios: Select this option if you need to forward SMS directly to subscriber radios.

Split Long Messages: If selected, a long message, i.e. a message that contains more characters than allowed in
one message in the radio network sent to a radio, will be split into several messages. If not selected, a long
message addressed to a radio is trimmed to not exceed the limit (some information will be lost).

Sender ID: If selected, the radio subscriber will see the phone number of the sender with the received SMS.
Deferred actions: If selected, it allows to deliver an information to the offline subscriber. When subscriber becomes

online, it will immediately receive it.
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Configuring a modem and outgoing messages

Warning! To enable modem settings, stop SmartPTT Radioserver.

-
Ql SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E‘m

Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |

- Radio Server SMS Gateway Settings
ﬁﬁ Licenses
E—]\ﬁ“ Radia Network Services Modem settings become enabled after stopping the radioserver.
..... ARS
-{g GPS Port name: Comi r
..... (s Telemetry Speed:
----- ©» Subscriber Blacklist L __
B1-() Email Gateway Data bits:
E_]ﬁ SMS Gateway Stop bits:
= Voden Scings|
..... @ Filz Receive Parity-
e Add-on Modules ) =
ﬁ i Read timeout: 1000 =
i Subscriber Groups Wirite timeout: 1000 :
G-l Metadata

Checlk: Modem

[7] Use text mode

SMS Center for outgoing messages

Test Settings

Phone Mumber

Meszage

R

Port name: COM port number which modem is connected to. You can find the COM port number by

opening modem properties in Windows Control Panel.

Speed: Data flow rate through COM port (in bits/sec).

Data bits: Number of data bits to transmit.

You can configure Data Bits to be 5, 6, 7, or 8. Data is transmitted as a series of five, six, seven, or eight bits (five
and six bit data formats are used rarely for specialized communications equipment).

Stop bits: Number of bits used to indicate the end of a byte. You can configure Stop Bits to be 1, 1.5, or 2. If Stop
Bits is 1.5, the stop bit is transferred for 150% of the normal time used to transfer one bit.

Both the computer and the peripheral device must be configured to transmit the same number of stop bits.
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Parity: Method of detecting errors in transmission.

You can configure Parity to be None, Odd or Even.

If Parity is None, parity checking is not performed and the parity bit is not transmitted.

If Parity is Odd, the number of mark bits in the data is counted, and the parity bit is asserted or unasserted to
obtain an odd number of mark bits.

If Parity is Even, the number of mark bits in the data is counted, and the parity bit is asserted or unasserted to
obtain an even number of mark bits.

Read timeout: Number of milliseconds before a time-out occurs when a read operation does not finish.

Write timeout: Number of milliseconds before a time-out occurs when a write operation does not finish.
Check Modem: Modem operation test. If a modem is detected, you will see information regarding the type of

modem installed on your system. If there is no modem detected, you will see "Modem not found" message.

Check modem

Iheck modem connection
COMZ: opened!

Modem Response: Madem found.
Manufacturer data:

ATI

Cinterion

MC52

REVISION 01.201
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The next step is to check settings for outgoing messages and to send a test message.

-
@ SmartPTT Server Configuration - C:\Program Files (xB6\SmartPTT\Server\RadioService.exe.config E‘E‘g
Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |
--#8 Radio Server SMS Gateway Settings
% Licenses
E—]"# Radio Network Services Madem settings become enabled after stopping the radioserver.
..... ARS
..... e Speet
----- ©» Subscriber Blacklist .
(-] Email Gateway Data bits:
- e Setics| et :
----- @ Fil= Receive Parity:
- .. Add-on Modules Readt ] 1000 -
ﬁ Prafiles ad timeout: =
& Subscriber Groups Wirite timeout: 1000 :
[]--l‘_ﬁ Metadata

Check Modem

[ Use text mode

SMS Certer for outgoing messages +73876543210

Test Settings
Phone Mumber +70123456789
Message Type message

Send

Use text mode: Allows selecting Text or PDU mode for SMS sending.

There are two ways of sending and receiving SMS messages: in text mode (the check box selected) and in the
protocol description unit (PDU) mode (the check box is not selected). The text mode (unavailable on some phones)
is just an encoding of the bit stream represented by the PDU mode, and can be used only for English; PDU mode
and Unicode are used for all languages. Unicode is the universal character encoding which provides the basis for the
consistent encoding, representation and handling of text expressed in most of the world's writing systems.

SMS Center for outgoing messages: SMS message center number. If the number is registered on modem’s SIM-

card, there is no need to fill this field.

Running tests on SMS sending

Make sure SMS messages can be sent to recipients from SmartPTT Radioserver. Use Test Settings to do it.

First, in the field Phone Number specify the phone number where you will send the test message.
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Second, enter the text of the message in the field Message. And then click Send.

If the message is successfully sent, you will get a confirmation notification.

’
Modem Response E

—
4 e

Message
e <

When modem is selected and test message is successfully sent, save the changes and start the radioserver

@. After the radioserver is started, Check modem and Send (test message) will be unavailable. It will mean that
now you are ready to send SMS messages from the radio and to the radio.
To send an SMS from the mobile phone to the radio, the message forwarded to the modem number should comply

with one of the following formats.

g?:&;lﬁ:j <SMS text>
Radio ID <SMS text>

: — prefix indicating that this message is addressed to a radio subscriber or talkgroup.
<Radio/Talkgroup IP> — radio or talkgroup IP address of the recipient

<Radio ID> — radio ID of the recipient

Space indicates the beginning of the message body.

Use the Split Long Messages option to guarantee that a message won't be cut.
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Example:

When the radioserver gets the following message, it sends the message to subscriber 77 (or to talkgroup ID=2):
To subscriber 77:

:12.0.0.77 SM S text

:77 SMS text

To talkgroup 2:

:225.0.0.2 SMS text

To multiple subscribers simultaneously:

:12.0.0.80,12.0.0.81,12.0.0.82,12.0.0.50 SM S text

:9080,9081,9082,9050 SM'S text

Note: When only ID is specified (with no IP address of the radio or talkgroup), SMS can be sent only to the

subscriber with the specified ID. To send a group SMS, it is necessary to use a full talkgroup IP address.

To send an SMS from a radio to a mobile phone, the message should comply with the following format.

&phone number <SMS text>

: — prefix indicating that this message is addressed to a mobile phone.
&phone number — mobile phone number of the SMS recipient (symbol "&" is used instead of "+" because there is
no "+" symbol on the MOTOTRBO radios).

Space indicates the beginning of the message body.

Example:

On receiving the message :&71234567890 SM S text, the radioserver sends it to the mobile radio with the phone
number +71234567890.

To several mobile subscribers simultaneously:

:8&71234567890, 871234567890 SM S text
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File Receive

File Receive senice is an easy and useful tool, which allows sending files for almost all MOTOTRBO radios. This
function is even more necessary in field communication characterized by the absence of the Internet connection and
other channels to transmit data.

In version 2.0 SmartPTT File Transfer allows receiving files without the server application or base stations. The user
needs to have only a radio connected to the PC via USB port and the client application SmartPTT File Transfer

version 2.0.

Note: Not all networks support the new scheme of file transfer. It is possible for IP Site Connect only. For other
network types use the old file transfer method, that is using control stations and server application SmartPTT File

Transfer version 1.0 or 2.0.

To enable this functionality the following steps should be taken:
1. Configure SmartPTT Radioserver settings.
2. Configure the radio with the help of MOTOTRBO CPS.
3. Configure routing settings for file transfer on a remote computer.

4. Configure the client application SmartPTT File Transfer 2.0.

How to Configure SmartPTT Radioserver

To configure the settings, select the File Receive menu item in the left setting tree of SmartPTT Radioserver

Configurator. At that, the File Receive Service window opens on the right.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config l = | E g
Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |
----- P Radio Server File Receive Service
----- =t Licenses )
=g Radio Network Services Active
[ ARS
g GPS Part 5001 -
5y TMS _
s, Telemety Recsived File Folder  C:\ProgramData'\SmartPTT'File Transfer' L]

-2y Subseriber Blacklist

[ __j Email Gateway

-§4 SMS Gateway
By Recene

e Add-on Modules

ﬂ Profiles

- Subscriber Groups

[]--Eﬂ Metadata

Active: Enables the senice.
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Port: Port used by file receive senice.
Received File Folder: Field to specify the folder name where received files are to be stored.

To apply the changes, save the new settings and restart the radioserver.

How to Configure Radio Settings in MOTOTRBO CPS

For the best file transfer rate a radio should be configured in the following way:

1. Open MOTOTRBO CPS and go to General Settings and configure the TX Preamble Duration parameter
to be 60 ms.

2. Go to Network and configure the Max TX PDU Size parameter to be 500 byte.

3. Clear Data Call Confirmed for the channel where the files are to be transmitted.

How to Configure Routing Settings for File Transmission

To configure file transmission correctly, add information on the new route for file transmission in the routing table of
the PC to which a radio is connected.
The routing table is configured via Windows command line. To open the command line, run file C:\\WINDOWS

\system32\cmd.exe.

C:AWINDOWS\system3 2\cmd. exe

Microsoft Windows XP [Bepcua 5.1.2600]
¢G> Kopnopauwa Madkpocoor, 1785-2001.

G SHINDOWS N system3 2

To add the file transmission route, use Windows command line:
route —p add 13.0.0.0 mask 255.0.0.0 192.168.X.X, where:
route is a command to add a route;

—p — the key for adding a route into the list of fixed routes;

add — adding the route;

13.0.0.0 — IP address of all radios available in the radio network;
mask 255.0.0.0 — network mask;

192.168.X.X — radio IP address.
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Example:

To transmit data packets from the radio with IP address 192.168.10.1 (radio IP address can be found in the
MOTOTRBO CPS application, Network menu item), the following command needs to be entered:

route —p add 13.0.0.0 mask 255.0.0.0 192.168.10.1

C:AWINDOWS\system3 2\cmd. exe

Microsoft Windows XP [Bepcua 5.1.2600]
¢G> Kopnopauwa Madkpocoor, 1785-2001.

G sHINDOWS ssystem32route —p add 13.0.0.0 mask 255.0.0.0 122.168.10.1

C:~UINDOUS\system32>_

How to Configure SmartPTT File Transfer Settings
Download and install the latest version of the application SmartPTT File Transfer (http.//www.smartptt.com/

demo_versija.html).

Launch the client application (Start > All Programs > SmartPTT File Transfer > SmartPTT File Transfer

Client).

2 SmartPTT - File Transfer 2.0 {client)

File  Service Help

=% - AN v
Metwork, ztatiztics
Packetz tranzmitted: 0 FPacketz received ]
Last command name:  unknown FPacketz lost: ]
Last command state:  success Current state: waiting
Retmy ] Last state: waiting

File tranzfer statistics

File name: file not zelected

File zize: unk o

Transfer progress: | 1

Connection management

Server [0 o (5001

Ready Mo messages
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In the Server ID field, enter the radio ID of the IP Site Connect, which will be used for file transmission. The radio ID

is set in Smart PTT Radioserver Configurator, in the NAI Control Station window.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config [ = | E g
Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |
----- §> Control Stations NAI Control Station
-y Connect Plus )
Si-hag NAI Systems Active
E|h- MAl - IP Site Connect 1
El__.n(]:u MName  Slot 1
Talkgroups St ID |1 :
Securty Settings
24" Slot 2 [Hadio ID 1 : ]
i il Talkgroups
LB Security Settings CAl Network 12 =

|8 DDMS Settings

: CAI Network for G 225 s
. g® MNIS Data Gateway woreerarups

To connect to the radioserver, click Connect.

2 SmartPTT - File Transfer 2.0 [client)

File  Service Help

=% - NN
Metwork, statistics
FPackets tranzmitted: 0 FPacketz received ]
Lazt command name:  unknown Packets lost: 1]
Last command state:  success Current state: waiting
Retmy ] Last state: waiting

File transfer statiztics

File narme: TEKCTOBRIA AOKYREHT. R
File size: Jbute(z], 1 packet(z]
Tranzfer progress: | )

Connection management
Server (D | | : | | Dizconnect

Ready Mo messages 13.0.0.1
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Select file to transmit (File > Select File) and click the Start File Transfer button 4 . At that, the radio will start
transmitting the file to the radioserver, and at the bottom of the window a record will appear informing about the

ongoing file transmission process.

2 SmartPTT - File Transfer 2.0 [client)

File  Service  Help

gk | b @ |\
Metwiork, statishics
Packetz tranzmitted: 3 FPacketz received 1
Last command name: GET_LOST_LIST_SID + ECHO FPacketz lozt: 0
Last command state:  success Current state: Transfer file
Retmy ] Last state: Responze OF.

File transfer ztatiztics

File name: T ekCTOBRIA QOKYMEHT. bt
File zize: 3 butelz], 1 packet(z]
Tranzfer progress: [ =

Connection management
Server |D: | | : | |

Transfer File File transfer 13.0.0.1

As soon as the file is successfully transmitted, the corresponding notification appears at the bottom of the window.

™ SmartPTT - File Transfer 2.0 (client) =3
File  Service Help
=% - IR NI
Fetwork, statiztics
Packets transmitted: 4 Packets received A
Lazt command name: SAWE_TO_FILE_SID + ECHO Packets lost: 1]
Last command state:  success Current state: Responze OF.
Retmy ] Last state: Save to file

File transfer statiztics

File narme: TEKCTOBBIA AOKYREHT. R
File size: Fbute(z], 1 packet(z]
Tranzfer progress: [ e e =

Connechion managenment

Server D: | | : | | Digconnect

Response CF File transferred 13.0.0.1

Note: For more information about the settings of SmartPTT File Transfer, please check SmartPTT File Transfer User

Guide.
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Add-on Modules

Tallysman

SmartPTT provides a more efficient radio monitoring that works in the Lone Worker mode. The option is compatible
with MOTOTRBO DM/DP 3000 and 4000 series radios.

SmartPTT ensures the following features for the generic option board with the Tallysman Sprite™ TW251 firmware:

e Mandown, i.e. activating the alarm signal if the radio position (its tilt) no longer corresponds to the
parameters set for the option board in Tallysman Sprite Configurator.

e Heartbeat messages. Messages that provide information about subscriber presence in the radio network. If
message delivery failed, SmartPTT Dispatcher is notified about the radio unavailability. The radio is also
informed about radioserver unavailability (e.g., when the channel is busy).

Example of the option board configuration:
When the radio tilt changes, a signal is played on the radio. The signal stops after the radio is returned to its normal
position. If not, an emergency alarm is sent to SmartPTT Radioserver. The emergency alarm LED on the radio can

be turned off by a long press on the emergency alarm button (depends on the radio MOTOTRBO CPS settings).
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For proper operation of the radios with the built-in option board with the Tallysman Sprite™ TW251 firmware, do the
following radio settings in MOTOTRBO CPS:
e enable option board on the selected channel by selecting the Option Board check box;

¢ enable the Emergency Alarm Indication option and select digital signaling system from the list in the

Emergency System field. To set up a signaling system, go to Signaling Systems > Digital Emergency

item.
B~ § DP3s01
....... s Rep1_SlotA
....... g Accessories Top RX X
....... Buttons ! -
....... Ed Text Messages ARS IOnS,rstemChange Yl
....... @ Telemstry
....... Gﬁ Menu Privacy [

....... F SBCU 7 . .
ity Privacy Alias I Privacy Key1 - l
= Network

8 o

E

S Contacts Option Board Trunking |
[+ (8 RX Group Lists

Bl €3 Channels Lone Worker [

- [ Zone 1 Alow Takaround [
Il Channel ool

8 Zone2

IP Site Connect [~

E- @8 Zone3 Messaging Delay (ms) lﬂ
B {8 Zone 4
— Compressed UDP Data Header [
........ n .?_.
- [ Scan RxOnty [
B (B8 Roam
3] Ca | Hus
i e
Offsst (MHz)
IE.DDDDDD
Freguency (MHz) [137.000000 Freguency (MHz) |[142.000000
e |

Ref Freguency (MHz) IDB‘FaLit VI Ref Freguency (MHz) IDefaLit VI
Group List ILis‘H vl Contact Name |45 -

Emergency Alarm Indication =2 I |Ernergency5;stem Ig,,m jl

SmartPTT PLUS 9.1 48
Radioserver Configurator User Guide



To enable Tallysman, click Tallysman in the setting tree of SmartPTT Radioserver Configurator and select the

Active check box.

-
ﬁ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |
----- F9 Radio Server Tallysman
----- T4 Licenses _
-gF Radio Network Services Active

- Add-on Madules H

: eartbeat Message

B Tob e s 5000
B Indoor Tracking
'.. Evert Log
-]/ Phone Calls

Ak

Response Delay, s o

Ak

Heartbeat Message Port: UDP port to receive messages about the radio presence in the network. This value must
match Host UDP Port in the option board configurator (the Heartbeat item, the SmartPTT GOB Configurator
application). Use the default value of 5000.

Response Delay, s: The time period that passes before SmartPTT Radioserver sends heartbeat message
confirmation to the radio. Set the value taking into consideration the network load. Otherwise, if the radio does not

receive acknowledgment, the radio gets a signal about radioserver unavailability.

Indoor Tracking

Big organizations with huge premises require constant control over their employees' displacement inside buildings.
For this purpose Indoor Tracking system was implemented. Indoor Tracking system allows getting data from special
beacons and transmitting it to SmartPTT Dispatcher or any other client application using API. Contact our technical
support (http://support.smartptt.com/hc/en-us) for SmartPTT Client APl documentation.
Currently, SmartPTT system supports the following technologies and products:

e iBeacon technology: with the use of MOTOTRBO radios with the firmware version 2.6 and above and the

beacons that support iBeacon technology,
o Blufi option boards (RF800) with special beacons (Connect-RTLS RF800), and

o Kilchherr option boards (K-TERM 44) with special beacons (K-TERM 70IC Beacon Transmitter).

Note: Indoor Tracking functionality requires the corresponding license. Connect Plus systems support Indoor

Tracking based on the iBeacon technology only.
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The following scheme shows how SmartPTT Radioserver gets subscriber location data.

K-TERM FOIC

Beacen f"
Transmitter w
Radic ID + : /
Beacon ID E @ f.
e o "
USB e i
i" " » Cuntml Radio Subscribers
% SmartPTT Stations
Radioserver
f Radio ID +
Thmil pa_rty Beacon I
application )
IP Network  yd—> =
/ -’
Repeater m
5 BTT I Radic ID + 5 ID\
il Beacon ] 2accn
Dispatcher 4___..--‘ f
IP Network - |
el w

iBeacon-based technology scheme: Each beacon installed is transmitting at an interval ranging from a fraction of a
second to some minutes the data packages of the following format: iBeacon prefix—the title of the package, UUID—
the unique identifier of the beacon, Major—the group parameter of the beacon, Minor—the individual parameter of the
beacon in the group, Tx power—the strength of the signal, transmitting by the beacon. The radio with the

preconfigured CPS settings (see below) receives the data packages from the beacons, which identifiers (UUID) are

set in the CPS settings, and transmits them to SmartPTT Radioserver via repeater or control station.

Blufi scheme: The RF800 beacons operate in a continual Sleep -> Transmit -> Sleep -> Transmit mode. When the
beacon awakes from its sleep cycle, it transmits its allocated code for the duration of the transmit phase and then
returns to its sleep phase. The portable radios function in a similar fashion except they follow a Sleep -> Listen ->
Sleep -> Listen mode. When a portable radio awakes from its sleep cycle, it listens for any transmitted beacon
codes for the duration of its listen phase and then determines the current active beacon. If the new active beacon is
different from the previous active beacon, a beacon update status message (a special TMS message) is sent via the
radio network to SmartPTT Radioserver. For more information on Blufi beacons and option boards see the

manufacturer's documentation on the products.

Note: Connect-RTLS RF800 option boards transmit data in special TMS messages, therefore it is necessary to have

TMS enabled.
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Kilchherr sheme: Each beacon installed is continually transmitting commands, like Detect, Keep Alive, Lost, which
contain unique Beacon ID, set in K-Term CPS. When a radio gets closer to the beacon, the built-in option board
receives Beacon ID and then transmits it with the Radio ID to SmartPTT Radioserver via repeater or control station.
Further data processing can be handled by SmartPTT Dispatcher or any third party application, connected to the
radioserver using API. For more information on Kilchherr beacons and option boards see the manufacturer's

documentation on the products.

Warning! For the Kilchherr and BluFi option boards, in network systems with MNIS service enabled, make
sure that the ID set in the option board settings (where data is to be sent) should match "MNIS Application
ID". In network systems without MNIS service enabled, any ID can be set in the option board settings
(where data is to be sent), however, it is necessary that "Data call confirmed" should be unselected in the
radio settings. In networks based on control stations it is necessary that the ID set in the option board

settings should match "Radio ID" set in the control station settings.

To use the Indoor Tracking feature based on the iBeacon technology, ensure that the MOTOTRBO radio meets the
following requirements:

e the radio has the firmware version 2.6 and abowe,

e the radio supports Indoor-positioning, and

e the radio is configured properly in MOTOTRBO CPS.
To configure the MOTOTRBO radio for use of the Indoor Tracking feature based on the iBeacon technology, do the
following:

1. Launch MOTOTRBO CPS with the 13.0 version or above and make the following settings:

Note: Below is a description of the Indoor settings only. The complete information on how to program the

MOTOTRBO equipment step by step, see here.
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¢ To ensure that the radio supports Indoor-positioning, click the radio title in the settings tree on the left and

check in the Device Information tab if the Indoor Location Tracking field has the Purchased value.

File Edit View Device Features Remote Window  Help - 2 X

i@ & Ml o | ¥ 4 B Q| »z bE

: RAM Open Save | Reports | Delete | Cut Copy Paste | Search | Read Wrte =

= [ DP4s0le A . ]
——— Device Information

Top Device Features Language Pack Memory L

- Data Services via Bluetooth
- Digital Emergency
- Radic Inhibit
- Bluetooth Permanent Discoverable
- Multi-Button PTT
- Extended Text Messages
| - Indoor Location Tracking
- Authenticated Radic Disable
Connect Flus
Connect Flus Mandown

- @ Sonaingsy | PTore
b ) Jser[ o
P

Expert View |
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¢ To activate GPS positioning, click General Settings in the settings tree on the left and in the Device

Information tab select GPS.

Fle Edit \iew Device Features Remocte ‘Window Help - & X

m = M| 3 | ¥ | & By Qe

RM | Open Save | Reporis | Delete | Cut Copy Paste | Search | Read =
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- [l Text Messages
- @@ Telemetry ) Over-the-Air Programming  Persistent LRR

Backlight  Battery Saver  Alers

EH Menu Lone Worker  PowerUp  Password and
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e To turn on the Indoor Location menu display on the radio, click Menu in the settings tree on the left and in

the Menu tab select Indoor Location.

L Ty
| MOTOTRBO Customer Programming Software - [Untitled4] = | E]
File Edit View Device Features Hemote Window Help - & X
= = 1l K | & Q| pm
RM | Open Save | Reports | Delete | Cut Copy Paste | Search | Read =
= [ DP4s0le -
- [l General Settings
- Q  Accessories Top Contacts Scan  Flexible RXLis
I A8 Butions Status  CallL Utilti
5 = Ies
- [l Text Messages -
o [0 Telemet -
:H M v Accessory Button [
| o Security Home Channel [
| ﬁiﬁ- Metaork GPs
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e To activate Bluetooth on the radio, click Network in the settings tree on

select Enable.

the left, click the Bluetooth tab and

-
' MOTOTRBO Customer Programming Software - [Untitled4]

= | B e |

RM | Open Sawve
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e To activate and configure the Indoor Location mode, click Indoor Location in the settings tree on the left,
select Indoor Location in the tab that opened and add the beacons by specifying the names and identifiers

(UUID) of the beacons in the corresponding fields.

' ™y
| MOTOTRBO Customer Programming Software - [Untitledd] i . [E=REE
Fie Edit View Device Features Remote Window  Help - 8 X

= H :E P ah Q [ 2] "E b 3 192.168.111 -
RM | Open Save | Reports | Delete | Cut Copy Paste | Search | Read Write Clone | B th

= [ DP4sote - -
B General Seffings Indoor Location

Q Accessores Top  Beacon Alias
- @A Buttons
I - [l Text Messages I Indoor Location  [W I
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| Scan Interval on Time (ms) Im
':H Menu
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2. Set up Bluetooth in the radio to activate Indoor-positioning. For that, with use of radio menu buttons, perform
the following commands:
e Main Menu > Bluetooth > My Status > On.

e Main Menu > Bluetooth > Indoor Location > Enabled.
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To enable Indoor Tracking in SmartPTT Radioserver Configurator, select Indoor Tracking in Add-on Modules

and select Active.

’
@ SmartPTT Server Configuration - C\Program Files (x86\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Bport/import Settings | Statistics |
----- F9 Radio Server Indoor Tracking
----- :?, Licenses
-gF Radio Network Services Active
- Add-on Madules
_____ ﬂ Tallysman Indoor source Matorola -
----- B -
-l Event Log Data Port 3100 =
&-{i=] Phone Cals Minimum RSS 130 =
-, Bridging level - =
----- sy Voice Notifications _
+1-[2 Clients Connection Set list of allowed beacons
- Moritoring
-, Profiles
----- &5 Subscriber Groups
-l Metadata

Example: 1.5, 1.6, 2.9-2.15

Indoor source: The Indoor-positioning technology. Specify Motorola, if you use iBeacon technology, specify BluFi
or Kilchherr, if you use the BluFi or Kilchherr products respectively.

Data Port: UDP port for listening to Beacon ID (applicable to Kilchherr beacons only).

Minimum RSSI level: The minimum strength of the signal, that radio receives from the beacon. SmartPTT
Radioserver will not process the signals with the strength that is lower than the specified level (applicable to iBeacon
technology only).

Set list of allowed beacons: You can specify the numbers of the beacons which data must be processed by
SmartPTT Radioserver. If the option is not selected, the radioserver processes data from all the beacons. If you use
Motorola source, specify the numbers of the beacons in the Major. Minor format, where the Major value is separated
from the Minor value by a dot. Major stands for the group number of the beacons, Minor stands for the individual

number of the beacon in the group. For the BluFi or Kilchherr source, specify the Beacon IDs.

Event Log

Event Log tracks all events from all dispatch systems connected to the radioserver. Events are registered in the
event log even if SmartPTT Radioserver Configurator is closed.
To activate First activate the event log by checking off Enable Event Logging. To do it, select Event Log item in

the setting tree in SmartPTT Radioserver Configurator.
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Then create the database for the log.

~
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |
..... EN Radio Server Event Log
----- :?, Licenses )
G- Radio Network Services Active
- Add-on Madules .
..... H Tallysman Creating Database
----- H Indoor Tracking Server Name: localhost'SQ LEpress
P Settings Database Name: RadioServer
{EI} Automatic Database Backup
&-{=| Phone Calls | Create New Database
[ guy Bridging
""" iy Voice Notifications Authorization Mode: lh’u“lndnws NT Authorization -
-] Clients Connection
- Moritoring Login:
ﬁ Profiles
----- &5 Subscriber Groups Password:
G-{gl Metadata
Check Connection

Riestoring Database Backup

L

Restore Database

Optimization
To perform database optimization, please check the connection.

Start

Warning! To enable Event Log on the radioserver, the corresponding license should be available. Go to
the Licenses section to acquire the necessary license.

To create a new database, type in the Server Name and the Database Name fields, and click Create New
Database. If creation is successful, a message about successful database creation is displayed. If a database is

not created, the cause of failure will be displayed at the bottom of the window.

Note: Database creation process at SmartPTT Radioserver is similar to the database creation process at SmartPTT
Dispatcher.

Note: For the database senver installed together with the radioserver enter the name using the following format:

Name of computenSQLExpress (for example, MYCOMP\SQLExpress).

Select Authorization Mode between the two:
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Windows NT Authorization: The user who has logged into the Windows system, must be listed in the SQL
server’s list of users to make connection.

SQL Server Authorization: You must have the login name and password of the account with SQL server access.
Click Check Connection. In case of successful authorization the message "The connection is established
successfully!" is displayed. If authorization fails, the cause will be displayed at the bottom of the window.

To restore the event log database from the backup, select the required database backup file in the Path field and
click Restore Database.

Note: To set up the auto backup of the event log database, go to the Automatic Database Backup window.

To optimize the event log database, click the Start button in the Optimization block. The optimization of the event
log database accelerates the database query processing when getting a large amount of GPS data or events. For
example, when building the Radio Activity Reports, Subscriber Locations, Events for Period and other reports

in SmartPTT Dispatcher.

Note: The optimizing feature is applicable only to non-optimized event log databases created before the release of

SmartPTT 9.0 and higher.

Before performing the optimization, ensure that the radioserver is stopped.
If the event log database is optimized, the Optimization block shows the corresponding message and the Start

button is inactive.
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Settings

To configure the radioserver event log select Settings in the Event Log menu.

:.IEIQ

”
'@ SmartPTT Server Configuration - C\Program Files (x86\SmartPTT\Server\RadioService.exe.config

Settings | Networks | Client List | Rules | Activity | Log | Bxort/import Settings | Statistics |

..... F9 Radio Server

..... fﬁ Licenses

g Radio Network Services
=-... Add-on Modules

Event Log Settings
Event log cleanup settings

@ Do not clear evert log

) Records retention period (days)
; ﬁIZL 100 =

% Automatic Database Backup
[]u:] Phone Calls

..... ) Voice Notifications

(-2 Clients Connection

Audio recording settings
[7] Record incoming calls
[] Record outgeing calls

’ ’ﬁ: Profiles Audio records folder
----- &5 Subscriber Groups
E:I"[i] Metadata C:\ProgramData“Smart P T T RecordedCalls Server E]
Pudio file extension MP3 -
Recording volume of outgoing 1 =
calls hd

Fixed sample rate (8 kHz)

Audio records cleanup settings
@ Do not delete audio records

(7} Records retention period (days)

100 =

To access the settings you should select Active in the Event Log menu.
The following settings are available to you:
o Eventlog cleanup settings: Select the proper variant.
o Do not clear event log: Select to keep as much of events in the log as possible in the hard drive.

o Records retention period (days): Select to enter the maximum number of the last days to be logged.
Note: The following settings are available if server is running. To run it, click Run or Restart in the lower tool bar.

e Audio recording settings: Select the proper variant.
o Record incoming calls: Select to record woice calls initiated by the subscriber.
o Record outgoing calls: Select to record wice calls initiated by the dispatcher.

o Audio records folder: Select the absolute path to the folder where recorded wice calls will be stored
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o Audio file extension: Select the proper extension of the file. Choose between the MP3 (the default
extension), OGG and WAV extensions.

o Recording volume of outgoing calls: Select the volume of the recorded wice call. Set the value between 1
and 5.

o Fixed sample rate (8 kHz): Select to force the sample rate of the recorded wice calls (reduces size of the
file).

e Audio records cleanup settings: Select the proper variant.

o Do not delete audio records: Select to keep as much of recordings (audio files) as possible in the hard

drive

o Records retention period (days): Select to enter the maximum number of days to be “wice-logged”.

Automatic Database Backup

Backing up data on a regular basis helps to protect it from being erased in case of the server hardware or software
failure. SmartPTT Radioserver Configurator allows user to back up the event log database automatically.
In order to set up automatic backup schedule of the event log database, select Automatic Database Backup under

Event Log in the setting tree of SmartPTT Radioserver Configurator.

-
ﬁ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |
----- B Radio Server Automatic Database Backup
----- :?, Licenses _
- Radio Network Services Active
= Add-on Modules Backup Foldsr
----- Bl Talysman E]
----- Bl Indoor Tracking _
=g Evert Log Backup Settings
L Seftings ; =
il @ D Interval (d 1 =
@ Automatic Database Backup > Daiy erval {days)
=-{[=] Phone Calls ) Weekly
[ Bridging

..... W Voice Motfications
EEI" Clients Connection

- Moritoring ) Marthly
,ﬁ, Profiles
----- & Subscriber Groups
E:I--l'_ﬂ Metadata Time: [3:00 =
Backup Perod
Start Date: 01.09.2016 (B~
End Date: ) |02.09.2016
@ Mo End Date
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Active: Select the check box to enable the ability to create current event log database backups in the automatic
mode.
Backup Folder: Full path to the file for saving the database backup.
Backup Settings: Schedule for creating the current database backup:
e Daily: Every fixed day at the specified time (for example, every day, every third day at 9:00 a.m.).
e Weekly: Every fixed day of the week at the specified time (for example, every Monday, Wednesday and
Friday at 11:00 p.m.).
e Monthly: Once a month on the fixed day of the selected month and at the specified time.
Time: Sets the time for database backup. This setting is common to all database backup intervals.
Backup Period: Allows you to set time period when automatic database backup is to be made according to the

selected backup settings.

Note: The number of stored backup files in the same folder is limited to 3. Otherwise, when creating a new copy, the

old files are deleted.

Note: The event log database recovery from the automatically created backup is performed manually in the Event

Log window.
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Phone Calls

Now it is possible to make a conference call between radio subscribers, dispatchers and telephone subscribers

without enabling Telephone interconnect.

For this, do the following:

1. Define Deaccess code. Make sure that it matches the deaccess code specified in subscriber's radio settings.

:@g

~
ﬁ SEmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |

--E Radio Server

-, Licenses

F-g Radio Network Services
B+ Add-on Modules

----- Bl Talysman
----- Bl Indoor Tracking

----- W Voice Motifications
- Clients Connection
I-J Monitoring
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Telephone Calls

Access code |

Deaccess code #

Conference call idle session timeout (=)

Calls to be confimmed by radio subscriber

ﬂ Profiles Private calls
&% Subscriber Groups Group calls
G-l Metadata

] Alcal

Radio subscribers’ notifications
Incoming phone call tane
Pick up tone
Hang up tone
[] Emor messages

Sound Volume Settings
Phone subscriber

Radio subscriber

I:I"'_' Event Log Radio ring timeout {s) 20
[=®1| Phone Calls
=15 Telephone Interconnect Phone ring timeout (=) 20
i Incoming Calls
‘...ga Outgoing Calls Phone call idle session timeout {s) 30
- A Bridgi
-, Bridging 500
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2. Enable Allow Telephone Interconnect in the slot settings.

-
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTThServer\RadicService exe.config E‘M
Settings | Networks | Client List | Rules | Activity | Log | Bxport/import Settings | Statistics |
-G Control Stations NAI Control Station
Connect Plus _
Sl NAI Systems Active
ah MAI - IP Site Connect 1
B‘T“ Mame  Slot 1
i et Securty Settings
Ee ] St 2 Radio 1D 16448250 |2
i 2B Talkgroups
LB Secunty Settings CAl Network 12 IE'
..., DDMS Settings CAl Network for G 795 «
... J& MNIS Data Gateway worteriaredps B
Capacity Max Networls [ Allow Telephone Interconnect I
SIP/RTP Interfaces -
- SmartPTT Radioservers T Time-Out Timer. s |ED IE”
Cptions
Emergency alam confimed
Allow transmit intemupt
GPS Transmission Mode | Data
Corfimed Events
Private calls
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3. In SmartPTT Dispatcher, go to Settings > Telephone Interconnect and set up the following parameters:

Telephone Interconnect
Telephone interconnect settings

General Settings | Codec Settings| SIP Trunk Authentication | SIP Accounts |

— Dispatcher Settings

[ Allow Calls to Telephone Subscribers [¥] ]
Transport uoP | v | Interface | 192168.37.85 | v |
SIP Port RTP Ports | 18700 |-| 18748 |
Phone NMumber 100 Displayed Subscriber Name ‘ |

— WolP Gateway Default Settings

Dial Prefix for Cutgeing Calls

Dial Prefix for Incoming Calls
Default VoIP Gateway Address | 82.200.114.46 SIP Port | 5060

Play Sound Alert for Incoming Call
Play Sound alert for Qutgoing Call

Y

Sound Level — (il

Cancel | [ Finish

e Select Allow Calls to Telephone Subscribers;
¢ Define your radioserver IP address and RTP ports;
e Under the VoIP Gateway settings enter Dial Prefix for Outgoing Calls. This must match the same prefix set
in the VolP gateway.
e Specify the IP address of the VoIP gateway.
To sawe the changes, click Finish.
Additional features, which are applied to telephone calls over SIP protocol:
Radio ring timeout (s): Sets the time interval during which the radioserver waits for the radio subscriber to press

the PTT button.
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Phone ring timeout (s): Sets the time interval during which the radioserver waits for the telephone subscriber to
pick up the phone.

Phone call idle session timeout (s): Sets the time interval starting from the last time the radio subscriber presses
the PTT button after which the telephone call will be automatically finished. This timeout must not exceed TX Time-
Out Timer set in network settings in SmartPTT Radioserver Configurator and in repeater settings.

Conference call idle session timeout (s): Sets the time interval starting from the last time the conference call
participant presses PTT button after which the conference call will be automatically finished.

Calls to be confirmed by radio subscriber: If enabled, when making a private call, group calls, All Call the
telephone subscriber can hear the ring tone until the radio subscriber has pressed the PTT button. If these check
boxes are not selected, the call will start immediately.

Radio subscribers' notifications: Sets notifications of radio subscribers of various events with a special tone:
telephone calls, beginning and end of calls. The radio subscriber can also receive messages about errors.

Sound Volume Settings: Allows setting up sound volumes on a telephone and a radio during incoming or outgoing

radio calls.

Telephone Interconnect

Telephone Interconnect senice allows for communication between radio and telephone subscribers, and uses SIP
and RTP protocols for signaling and wice data transmission. Voice data transmission is done in half-duplex mode.
Switching between receiving and transmitting modes is carried out by wice interrupt initiated by a radio subscriber.

There are several ways how to make the interconnection:

A telephone subscriber makes a private call.

o A telephone subscriber makes a group call.

¢ A radio subscriber makes a call to a telephone subscriber.
¢ The dispatcher connects telephone and radio subscribers.

e The dispatcher connects a telephone subscriber and a talkgroup.

To use Telephone Interconnect senice, configure the radioserver and VolP gateway settings. Also, make sure that

Allow Telephone Interconnect is enabled in the network slot parameters.
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Configuring SmartPTT Radioserver

To configure SmartPTT Radioserver settings, go to SmartPTT Radioserver Configurator and select Telephone

Interconnect as shown on the picture.

-
'ﬁ SmartPTT Server Configuration - C:\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config Elﬂlg
Settings | Networks | Client List | Rules | Activity | Log | Bxport/import Settings | Statistics |
----- F9 Radio Server Telephone Interconnect
----- =% Licenses )
- Radio Network Services Active
Hmﬁi.gd%hﬂ;ﬁes Radioserver Settings
B Indoor Tracking Interface | 192.168.27.85 b
[+ Event Log —
=-4[=] Phone Calls SIP pott 5060
Elﬂj Telephore Interconnect
wb Incoming Calls RTP ports 18650 - 18950
i gm Outgoing Calls
EJ'"& Bridging Transport
- W Voice Notifications
-2 Clients Connection )
D"E Moritoring Audio Codecs
ﬂ Profiles Active Mame Priarity
----- &5 Subscriber Groups GT11A 1 -
[]--l‘_ﬁ Metadata P
G711U 2 1
SPEEX 3 @
G729 4
Permissions for Subscrber Groups:
[ Active
I i )
Group Name Er;;f;mmg Qutgoing Calls

Warning! To activate Telephone Interconnect, install the corresponding license. The license can be

installed under Licenses.

Under Radioserver Settings specify the interface that will be used for sending and receiving commands and woice
data when working with VolP gateway.
SIP port: UDP or TCP port number to receive and send SIP data packets. The default value is 5060. Accordingly,

the specified port must be available for incoming and outgoing traffic.
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Warning! If both SmartPTT Dispatcher and SmartPTT Radioserver are installed on one computer, their

SIP ports must differ. For example, 5060 for the radioserver and 5061 for the dispatch console.

RTP ports: Each connection with a phone subscriber occupies two UDP ports (even port numbers are used by RTP
protocol, and odd port numbers—by RTCP protocol). The specified port must be available for incoming and outgoing

traffic. The default range of values is from 718650 to 18660.

Warning! The address and the port of the VolP gateway must be real (NAT is not supported). If both
SmartPTT Dispatcher and SmartPTT Radioserver are installed on one computer, the port ranges set in

and the RTP ports fields in SmartPTT Radioserver Configurator and SmartPTT Dispatcher must differ.

Transport: Allows selecting between TCP and UPD for SIP commands transmit.

In Audio Codecs you can enable or disable supported audio codecs, as well as change their priorities. Currently,
there are 4 audio codecs: G711A, G711Q, SPEEXwn G729. When connecting to PBX the radioserver always uses
the codec priorities list set in the PBX settings, while the PBX can ignore the priorities list set in the radioserver.
That is why codecs used by the call initiator and the responder can be different.

Permissions for Subscriber Groups: In this section you can allow or forbid particular groups of radio subscribers
to make or answer telephone calls. These groups of subscribers can be created under Subscriber Groups. If the
Active check box is selected, and the table is empty, communication between radio and phone subscribers will be

impossible.
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Incoming Calls

In terms of SmartPTT system "incoming calls" are calls that are made from telephone subscribers to radio

subscribers.
F
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E‘m
Settings | Metworks | Client List | Rules | Activity | Log I Export/Import Settings | Statisticsl
----- P Radio Server Incoming Calls
----- :?, Licenses
- Radio Network Services Private call mask T
= Add-on Modules
""" B4 Talysman Group call mask 32NSST
----- B Indoor Tracking roup cElma
- Event Log Incoming Calls Authentication
E'LL__l Phone Calls
E||_L—_| Telephone Interconnect Enabled
-3 Incoming Calls
i dm Outgoing Calls Realm SmatPTT
-, Bridging
..... @ Voice Motifications Usemame USEMEME
(-2 Clients Connection
[jg Monitoring Password ——
ﬂ Profiles
----- & Subscriber Groups ) )
-8 Metadata Voice Menu Settings
Active
Radioserver call number 1
Woice Menu File
C:\Program Files (c86)SmartP T T\Server\SoundVoice Menu wz E]
Dial Exension Timeout, s 30

A telephone subscriber can make two types of calls to radio subscribers.

1. Private call is a call when the radioserver calls to a radio subscriber. You can use Private call mask when
making a private call.
2. Group call is a call when the radioserver calls to a talkgroup. You can use Group call mask to make a

group call.

A mask is a regular expression. In the following table you can find all the symbols used in masks.

Symbols Description
Used for any figure
[m-n] Used for any figure in the interval from m to n
[a,b,c] or [abc] Used for any figure from the list
T Used for any number of any figures
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() Used to unite regular expressions

{} Used to include everything inside the brackets into the resulting number.

N Used to denote network ID. N=0 when there is only one network. Can be used

only in Group Call Mask.

S Used to denote Slot ID (IP Site Connect) or Site ID (Linked Capacity Plus). Can

be used only in Group Call Mask.

Example:
Let's review sample masks:
Private Call Mask: 37 or 31T
Group Call Mask: 32NSST
Then the dialed numbers will mean the following:
31403, i.e. 31 403: private call to subscriber with ID=403.
3200013, i.e. 32 0 00 13: wide group call to a talkgroup 13, which must be either unique for the radioserver, or
located in the only network connected to the radioserver.
3210013, i.e. 32 1 00 13: wide group call to a talkgroup 13 located in network 1.
32112123, i.e. 32 1 12 123: local group call to a talkgroup 123 in network 1, on site 12.

The S symbol can be assigned different values and they depend on the network type. Below is the list of values that
can be used for the S symbol:
e Inthe IP Site Connect network the S symbol can be assigned values 7 or 2 only, which correspond to the
number of the IP Site Connect slot.
e In the Capacity Plus network the S symbol can have only one value: 0.
e In the Linked Capacity Plus network the 8 symbol can be assigned any value. S=0 stands for a wide group
call. S=1, S=2, S=any other figure stand for a local group call specifying the LCP site number.
To make the All Call, use the following values:
e In the IP Site Connect network: S=7/2 and talkgroup ID=0.

¢ In the Capacity Plus and Linked Capacity Plus networks: S=0 and talkgroup ID=0.

Incoming Calls Authentication: Receiving an incoming call from a phone/softphone, the radioserver asks for the
username and password corresponding to Realm in the described setting. The calling telephone subscriber must

send back the username and password specified in this setting. To activate this ability, select Enabled.
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Realm: Parameter used for the incoming telephone calls authentication.
Username: Username used for authentication.

Password: Password used for authentication. It should correspond to the specified realm.

Voice Menu Settings is used for setting up interactive wice response (IVR), i.e., a technology that allows
SmartPTT system to interact with subscribers through the use of wice and DTMF tones input via keypad. If enabled
and set up properly, the telephone subscriber can make a call to the radioserver and then to the required radio
subscriber or talkgroup using the information heard in the wice menu file.
Radioserver call number: Number to call to the radioserver.
Voice Menu File: The audio file which will be played to the telephone subscriber. The sampling frequency of the
audio file must be 8000 Hz.
Dial Extension Timeout, s: Period in seconds when the caller can dial the ID of the radio subscriber or talkgroup
after listening to the woice menu file. If the caller has not dialed the ID before the time is out, the call will be dropped.
Here is the list of steps to make a call using voice menu:

1. Dial your PBX number.
Dial the radioserver call number.
Dial * to turn on DTMF mode on the telephone (not obligatory, depends on the telephone parameters).

Dial the private or group call mask, and then the radio subscriber or talkgroup ID.

o > »w b

Dial #.

Example:

The radio subscriber ID: 720.
The PBX number: 9649.

The radioserver call number: 10.
The private call mask: 7.

The telephone subscriber will call: 9649 10 (*) 1 120 #.
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Outgoing Calls

-
'ﬁ SmartPTT Server Configuration - C:\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config @m
Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |
..... B9 Radio Server Outgoing Calls
----- T4 Licenses .
[]--ﬁ.‘ Radio Metwork Services Defautt Gateway Settings
=+ Add-on Modules Allow calls to default VolP gateway
Bl Tallysman
Bl Indoor Tracking IP address 82.200.114.46
- Event Log
=+{[=] Phone Calls SIF port 5060
=+{[=] Telephone Interconnect Example: 3215
i Incoming Calls Source mask
-8 Outgoing Calls
E:I---g:\ Bridging Destination mask 12

- digp Voice Notifications

-] Clierts Connection Diaing Fes
C-JE Monitoring TMS prefic A
ﬁ Profiles
----- &5 Subscriber Groups
- Metadata Outgoing Calls Authentication
Enabled
Realm SmartPTT1
Usemame SmartPT Tuser
Password
Example: Radio %
Caller name for private calls Radio %
Bxample: Group %
Caller name for group calls Group %

Talk permit tone for phone subscriber

Allow Calls to Default VolP gateway: If enabled, radio subscriber calls to telephone subscribers are made
automatically, using all the data given, such as IP address of the automatic exchange, Source and Destination
masks, Dialing Rules. If the option is not selected, radio subscribers will need to enter the IP address and the full
number of the telephone subscriber to make a call.

IP address: IP address of the automatic exchange.

SIP port: UDP or TCP port number to receive and send SIP data packets. The default value is 5060. Accordingly,
the specified port must be available for incoming and outgoing traffic.

Source mask: Must correspond to the source mask specified in the automatic exchange. It includes only figures,

for example, 32%15, where % is the number of the radio subscriber.
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Destination mask: Contains only figures, for example, 32%15, where % is the dialed telephone number. It is used
to speed up dialing of the telephone number.

TMS prefix: Used for making a call to a telephone subscriber with the help of a text message sent from a radio.
TMS Prefix can contain any available symbol on the radio keyboard. Figures following the specified prefix are
regarded as the telephone subscriber's number.

Outgoing Calls Authentication: The setting includes parameters required for outgoing call authentication. If Realm
is left blank, the specified user name and password are used in response to any authentication request from the
called party. Otherwise, Realm is checked whether it corresponds to the requesting user name and password. If it
matches, user name and password are sent. If not, the authentication is failed immediately.

Realm: If the value is set, SmartPTT Radioserver responds to authentication requests with the matching Realm
value. If the value is not set, SmartPTT Radioserver sends user name and password given in response to any
authentication request.

Username: User name used for authentication.

Password: Password used for authentication.

Caller name for private calls: Name of the radio subscriber that will be shown to the telephone subscriber. The
percent symbol (%) will be replaced automatically by the radio number.

Caller name for group calls: Name of the talkgroup that will be shown to the telephone subscriber. The percent
symbol (%) will be replaced automatically by the talkgroup number.

Talk permit tone for phone subscriber: If enabled, the phone subscriber will hear a special tone prompting to

start speaking.
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Bridging

SmartPTT bridging senvice allows joining various network systems into a single radio network. The bridging senvice is
implemented in the scope of SmartPTT PLUS Radioserver and provides intelligent means of redirecting woice and
data streams among different network systems.

To activate the Bridging senice, click Bridging in the setting tree of SmartPTT Radioserver Configurator. In the

opened window select the Active check box.

”
'@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadicService.exe.config E@Q

Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |

..... B9 Radio Server Bridging
..... ﬁ?‘ Licenses
-4 Radio Network Services Active
=t Addon Modules

..... H Talysman

----- Bl Indoor Tracking
= Event Log

F-{[=] Phone Calls
Elﬁ Bridging

b ! MuttiGroups
----- & Voice Notifications
E;l-- Clierts Connection
- Moritoring
,ﬁ Profiles
&g, Subscrber Groups
-l Metadata

Multigroups

MultiGroups are used to organize dynamic routing of group calls between channels and different network systems.
Routing of group calls can be global or limited to predefined channels. Configuration of MultiGroups does not require
any bridging settings on SmartPTT Dispatcher, but Bridging must be enabled in SmartPTT Radioserver

Configurator. If it is not activated, MultiGroups settings will be disabled.
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To create multigroups, go to Bridging and click Multigroups.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

=l

Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |

..... F9 Radio Server

..... fﬁ Licenses

g Radio Network Services
=+ Add-on Modules

- Event Log
-}/ Phaone Calls
=4, Bridging

=" h
i il Mew MuttiGroup 1

----- ay Voice Motifications
-2 Clients Connection
EE|-- Manitoring

. ﬂ Profiles

----- &5 Subscriber Groups
Ej--l‘_ﬁ Metadata

To add a new multigroup, click Add. Then open its settings by selecting it in the settings tree.

MultiGroups

’ Add ] [ Remove ]

Apply

MultiGroup Name

Talk Group

Mew MultiGroup 1

K

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

oo

Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics |

----- F9 Radio Server

----- f?, Licenses

H-gF Radio Network Services
=+ Add-on Madules

- Event Log
-] Phone Calls
[—]E Bridaing

Elh MuttiGroups

h New MuttiGroup 1

----- ay Voice Motifications
-2 Clients Connection
EE|-- Monitoring
ﬂ, Profiles
i, Subscrber Groups
G- Metadata

Name: Name of the multigroup.

MultiGroup
MName Mew MultiGroup 1
Talkgroup 1D 1
Bxample: 1.5.10-20
Subscriber 1D
(™) Use all channels
@ Use selected channels
| BpandAl || Colapse Al

EI-- Radioserver
EI--IF‘ Site Connect 1
[¥]Slat 1

[¥]5lot 2
=] NAI - IP Site Connect 1

Talkgroup ID: The ID of the talkgroup whose calls are to be routed.
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Subscribers IDs: Radio IDs of the radio subscribers who will be included in the multigroup.

Use all channels: Select this option if you want the group call to be routed globally.

How it works: If a multigroup is created for a talkgroup, and a group call is made to this talkgroup, SmartPTT starts
to look for all the talkgroups with this ID. Then SmartPTT checks if these groups have radio subscribers that were
defined in the multigroup settings. The group call will be routed only to the talkgroups that include at least one of
these radio subscribers.

Use selected channels: Select this option if you want the group call to be routed within selected channels.

Note: When you add, change or delete a multigroup, it is not necessary to restart the radioserver. Click Apply to

activate the multigroups.

Voice Notifications

The main purpose of the wice notification functionality is to warn talkgroups about the fire or other emergency and to
manage evacuation. However, in normal mode woice notifications can be used to transmit ordinary announcements.
To create a wice notification, select the Voice Notifications item in SmartPTT Radioserver Configurator. At that,

the Voice Notifications window appears on the right. To enable the senice, select the Active check box.

’
ﬁ SmartPTT Server Configuration - C\Program Files (x86\SmartPTT\Server\RadicService.exe.config E@g

Settings | Networks | Client List | Rules | Activity | Log | Bport/import Settings | Statistics |

----- F Radio Server Voice Notifications
----- :?, Licenses

#-€F Radio Network Services Active
= Add-on Modules

=i Evert Log

=-{=] Phone Calls

[+l 4, Bridging

----- @
-] Clients Connection
EEI"E Monitoring

ﬁ Profiles

----- &5 Subscriber Groups
-l Metadata

To add a woice notification, right-click on Voice Notifications and select Add. At that, the Voice Notification

Settings window opens.
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Set the following parameters in the Voice Notification Settings window.

~
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

m@g

Seftings | Networks | Client List | Rules | Activity [ Log

I BExport/Import Settings I Sta’r.isticsl

----- F9 Radio Server

----- :?, Licenses

H-gF Radio Network Services
=+ Add-on Madules

..... B Indoor Tracking
..I Evert Log
[#-[=] Phone Calls

Bridaing

EI iy Vioice Notffications
; Clients Connection
E Monitoring

ﬁ Profiles

----- &5 Subscriber Groups
G- Metadata

Voice Nofification Settings

Mame Motification 1

Settings
Sound File C:\Program Files (<86)\SmatPT | ... |
Flay Count 100
Play Interval, s 20
Channels
| BpandAl || Colapse Al
=-[ZINAI - IP Site Connect 1
=[] Slet 1
-l AiCal
E----Gmup 1
| Group 2

Name: Name of the wice notification displayed in SmartPTT Dispatcher.

Sound File: Sound file in WAV format. Only monophonic files can be used as wice notifications.

Play Count: Specifies how many times the wice notification will be played on the channel. To be set in the range
from 1 to 9999.

Play Interval, s: Specifies the interval between the wice notification plays. To be set in the range from 5 to 276000.

Select channels of the hardware or/and virtual control stations in the Channels area (All Call or Group Call) that

play the wice notification (after it was run in SmartPTT Dispatcher).

Note: Playing woice notification on the channel corresponds to an outgoing call of SmartPTT Radioserver and fully

occupies the selected channel. Thus, each control station (hardware or virtual) can have only one call type to be

used for playing wice natifications on the channel — an all call or a group call.

To delete the wice notification profile, right-click on the selected profile and click Delete.

- #g Voice Notifications

IR F) | Motification 1
Delete
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Clients Connection
SmartPTT Radioserver Configurator allows to enable support for web seniceand third-party applications.
To configure the parameters common for the described above applications, click Clients Connection in the setting

tree of SmartPTT Radioserver Configurator. In the Clients Connection window set the required parameters.

Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |

""" F Radio Server Clients Connection
----- % Licenses

48" Radio Network Services WebSocket Server

=4 Add-on Modules Interface [Pu-q,r v] Port 8191 =
..... H Tallysman

B8 Indoor Tracking

-‘ Event Log :
(=] Phone Calls Codec [Broad‘u’mce hd

[+ /5 Bridging

..... ! Voice Motifications
= Cicris Conecion
L - & Web Service
‘APl Third-Party Applications
ﬂ Manitoring
! ﬁ Profiles
..... &5 Subscriber Groups
Eﬂ"l:ﬁ Metadata

Interface/Port: Radioserver IP address and port used for connection of the web, mobile and third-party applications

to the radioserver.

Codec: Outgoing audio stream compression method.

Web Service

This senice expands SmartPTT bounds, as it allows the dispatchers to do their job without the desktop SmartPTT
Dispatcher. Currently the web version provides the following functionality:

e Displaying radio subscribers on Google Maps,

e Sending TMS messages to and from radio subscribers,

e Getting ARS and GPS data, and

e Blocking and unblocking radios.
For more detailed information on web client configuration, refer to SmartPTT Web Client Installation and

Configuration Guide.
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To enable support for web client, select the Active check box in the Web Service window of SmartPTT Radioserver
Configurator.

Settings | Networks | Client List | Rules | Activity | Log
----- F9 Radio Server
----- T4 Licenses

48" Radio Network Services Active
=-... Add-on Modules

. Tallysman
B8 Indoor Tracking

.,- Evert Log
#-{[=] Phone Calls
E Bridging

----- %y Voice Notifications

EI@ Clients Connection
IR

: t.apl Third-Party Applications
.. Manitaring

gk, Profiles
g Subscriber Groups

Eﬂ"l:ﬁ Metadata

I Export/Import Settings I 5tatistics|

Web Service

Third-Party Applications

To allow access to SmartPTT API, click Third-Party Applications in the setting tree of SmartPTT Radioserver

Configurator and in the Third-Party Applications window select the Active check box.

Note: A special license is required to allow access to SmartPTT API.

Settings | Networks | Client List | Rules | Activity | Log

----- F3 Radio Server Third-Party Applications
----- % Licenses

48" Radio Network Services Active
-+ Add-on Modules

..... H Tallysman
B8 Indoor Tracking
-‘ Event Log

#-{[=] Phone Calls
E Bridging

I Export/Import Settings I 5tatistics|

B Fopioiors
&-J2 Monitaring
! ﬁ Profiles
..... &5 Subscriber Groups
Eﬂ"l:ﬁ Metadata
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Monitoring

The Monitoring senvice gives an outlook for the whole radio system in the real time. With the help of this service the

dispatcher can see what is happening on the channels and get information on the state of the devices.

Warning! Monitoring service requires corresponding license to be installed at SmartPTT Radioserver.

Licenses are installed under the Licenses section of SmartPTT Radioserver Configurator.

By default, the Monitoring senice is not active. Select Monitoring in the setting tree in SmartPTT Radioserver
Configurator and select Active to enable it. If the Monitoring senice is not activated, the radioserver and its network

won't be displayed on the Monitoring panel.

:.IEIQ

e
@ SmartPTT Server Configuration - C:\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config

Settings |Ne°twnrk5 Client List I Metwork Configuration I Rules I Activity I Log

| Bxport/mport Settings | Statistics |

..... B9 Radio Server

..... % Licenses

-4 Radio Network Services
=1+t Add-on Modules

Monitoring
Active

Creating Monitoring Databaze

B Tallysman

B Indoor Tracking Server Name: localhost' SCILExpress
- Event Log

-{[=] Phone Calls Database Name: Monitoring

rl-- iy Voice Motifications

[ Create Mew Database ]
- Clients Connection

£
£
[ /o Bridging
£
£

B--E Manitaring Authorization Mode: [Windows NT Authorization -
i1 Settings
: {@} Automatic Database Backup Login:
ol SNMP Service
ﬁ Profiles Password:
----- é‘é Subscriber Groups
G-l Metadata Check Connection

Restoring Databaze Backup

&

[ Restore Database

To create a database for the monitoring purpose, type in the Server Name and Database Name fields, and click
Create New Database. If creation is successful, a message about successful database creation is displayed. If the

database is not created, the cause of the issue will be displayed at the bottom of the window.

Note: If the database server and SmartPTT Radioserver are installed on one computer, enter the name of the

following format: Computer Name\SQLExpress (for example, MY COMP\SQLExpress).

Select Authorization Mode between the two:

SQL Server Authorization: Login and Password must belong to the account with access to the SQL senrver.
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Windows NT Authorization: The user, who has logged into the Windows system, must be listed in the SQL server

user list to make connection.

Click Check Connection. In case of successful authorization the message "The connection is established

successfully!" is displayed. If authorization fails, the reason will appear at the bottom of the window.

Note: The radioserver event log database, the Monitoring database and the Dispatcher event log database must be

different.

To restore the monitoring database from the backup, select the required database backup file in the Path field and

click Restore Database.

Note: To set up the auto backup of the monitoring database, go to the Automatic Database Backup window.

Settings

To configure automatic cleaning for the monitoring event log, go to the Settings section of the monitoring in

SmartPTT Radioserver Configurator. At that, the following window appears.

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTThServer\RadioService.exe.config

:.IEIQ

Settings | Networkes | Client List I Metwork Configuration I Rules I Activity I Log I Export/Import Settings I Statistics|

g Radio Network Services
B-{k Add-on Modules

- Ewent Log
[#-{/=] Phone Calls
(-4, Bridging
(- Voice Notifications
({2 Clients Connection
- Monitoring
T OEID
.40y Automatic Database Backup
LB SNMP Service
-, Profiles
&% Subscriber Groups
G-l Metadata

Monitoring Event Log Settings

Event Log Truncate Settings
@ Don't Tuncate Event Log

7 Records retention period (days)

100

Don’t Truncate Event Log: If selected, monitoring event log is not cleared automatically.

Records retention period (days): If selected, the system will delete records older than the number of days set in

the field. By default, it is set to 100 days.
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Automatic Database Backup

Backing up data on a regular basis helps to protect it from being erased in case of the server hardware or software
failure. SmartPTT Radioserver Configurator allows user to back up the monitoring database automatically.
In order to set up automatic backup schedule of the monitoring database, select Automatic Database Backup
under Monitoring in the setting tree of SmartPTT Radioserver Configurator.
Active: Select the check box to enable the ability to create current monitoring database backups in the automatic
mode.
Backup folder: Full path to the file for saving the database backup.
Backup Settings: Schedule for creating the current database backup:

e Daily: Every fixed day at the specified time (for example, every day, every third day at 9:00 a.m.).

e Weekly: Every fixed day of the week at the specified time (for example, every Monday, Wednesday and

Friday at 11:00 p.m.).

¢ Monthly: Once a month on the fixed day of the selected month and at the specified time.

Backup Period: Allows you to set time period when automatic database backup is to be made according to the

selected backup settings.

Note: The number of stored backup files in the same folder is limited to 3. Otherwise, when creating a new copy, the

old files are deleted.

Note: The monitoring database recovery from the automatically created backup is performed manually in the

Monitoring window.

SNMP Service

SNMP senvice allows users to monitor network-attached devices such as repeaters, routers and uninterruptible

power supplies (UPS).

Warning! To be able to get information about the state of a device, the user needs to have the
corresponding license and an SNMP client application installed. Use versions 1 and 2 of SNMP client

applications.

To obtain the license, go to SmartPTT Radioserver Configurator and open the Licenses section. Check if you have
the license for SmartPTT SNMP senice installed, and if not install it. For more information how to install licenses,

check the Licenses section.
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After you have obtained the license, enable SNMP senvice. To do that, select Add-on Modules > Monitoring >

SNMP Service. At that, the following window opens.

Note: Monitoring must be activated, otherwise you won't be able to enable SNMP Service.

-
@ SmartPTT Server Cenfiguration - C:\Program Files (x86\SmartPTT\Server\RadioService.exe.config E‘E‘g
Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Export/import Settings | Statistics |
-8 Radio Server SNMP Service
% Licenses _
-4 Radio Network Services Active
e Add-on Modules Interface Settings
iBl] Tallysman

B Indoor Tracking Interface 192.168.37.85 v] Pot  [161 =

‘@ Event Log

=] Phone Calls
Bridaing

B Woice Notfications

Clients Connection

- Monitoring
{5} Settings

0 Automatic Database Backup
ﬁ Profiles

- Subseriber Groups

G-{gd Metadata

Select the Active check box to enable the senice. At that, the Interface Settings will become available.
Interface: The IP address of the radioserver.

Port: Port to listen to the data from the devices. By default, it is set to port 161.
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Then, install SNMP client application. Configure its settings to contain the IP address of the radioserver to get
information on the devices, and the External Community to get information on particular device parameters. The

External Community can be found in SmartPTT Radioserver Configurator in the Network Configuration tab for

each device.
i
@ SmartPTT Server Configuration - C:\Program Files (x86)\5SmartPTT\Server\RadioService.exe.config E@g
| Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Export/import Settings | Statistics |
E Radioserver Device
iy Connect Plus

El-ig NAI Systems General | Alamn Motifications

g NAI - IP Site Connect 1

14" Server Type |Cisco 2900 -
= Cisco Name Cisco
Description
Interface 152.168.37.85 - Port 162 $
|P-address 0000 Port 161 =
SNMP Version V1 A
Community Community 1

Response Timeout, 5 3

Polling Interval, = 30

[ Check Connection

SNMP Parameters
Active

| Exdemal Community External Community

Note: For more information how to get device parameters, read documentation or review the corresponding MIB file

of the device.

Profiles

SmartPTT Radioserver Configurator allows creating permission profiles. The permission profiles are used to limit the
operator's access to objects managed by SmartPTT Radioserver (control stations, talkgroups, senices, IP Site
Connect slots), and to provide additional opportunities in the organization of calls between dispatchers and radio

subscribers.
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To create a profile right-click Profiles in the setting tree of SmartPTT Radioserver Configurator and click Add.

At that, the following window opens.

’
@] SmartPTT Server Configuration - C\Program Files (x86\SmartPTT\Server\RadioService.exe.config

mlﬁlg

Settings | Networks | Client List | Network Configuration | Rules | Activity | Log

I Export/Import Settings | Statistics|

- # Radio Server
:?, Licenzes
.ﬁ‘ Radio Network Services
. ol Add-on Modules
EI ﬂ, Profiles

[ ﬁ Profile 1

#’& Subscrber Groups
-l Metadata

Name: The profile name.

Profile
Mame Profile 1
Limit Radios to Service
Enabled
Example: 1-59, 150
Allowed radio 10's 518 2525
[ Epandm | [ ColepseAl || @ e

=-[¥]MAI - IP Site Connect 1 - Slat 1

L-[J]1D: 16448250

Private calls

Listening to private calls between subscrbers
E| Radio Networ Services

[@GPs

: .TI"-‘IS

----- . Telemetny

=-[¥]MAI - IP Site Connect 1- Slat 2

[#]ID: 16448250

[¥] Private calls

[¥] Listening to private calls between subscribers

S [¥]Radio Networks Services

L3

m

The Limit Radios to Service area was designed to manage the number of radios allowed for this profile. Here the

user can specify which radios are to be controlled by the profile and which are not.

To make this functionality active select Enabled. Then, in the Allowed radio ID's field, enter the ID's of the radios

which are to be controlled by the profile.

Warning! All the radios whose ID's were not specified will be ignored by SmartPTT system.
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The following scheme shows how it works:

Unallowed subscriber or _ . Call to be heard by
group dispatcher
Allowed subscriber or ——— - X Call not to be heard by
group or dispatcher
T T S S :
! | 1 1
1 1
| 1 l :
i [ essiy - W= mm e ==
' 1 I g==== Dispatch =Y==b-=- : !
v ] : 1:. ispatcher : -E H i
[ I [ : ;
1 . I I
O w2l T B 1 -0
pomm=- X== . : L
1 1
200 i ] 100 i 101 i : i ! 202
I
! i I
B i aB Bl itnal
+__: | [nj - [:3 -+~ " (nj
; A - A
I 1
Group 3 1 Group 1 Group 2 1 Group 4
A ! 1 A
| ! 1 |
1 L - 1
T T S —————— .
This is how this scheme can be presented in the table:
Call From Call To

Allowed group Unallowed Allowed radio Unallowed Dispatcher

group radio
Unallowed radio Allowed Not allowed Allowed Not allowed  Not allowed
Allowed radio Allowed Not allowed Allowed Allowed Allowed
Dispatcher Allowed Not allowed Allowed Not allowed Allowed

Note: When adding allowed radios make sure that the same radios are specified in Radioserver > Limit Radios to

Service. Otherwise, the radios not registered in both lists will be regarded as unallowed.

Upwards and downwards arrows are used for changing the order of head elements in the list. This order will be

applied in SmartPTT Dispatcher, if this profile is used.
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In the central list you can select all the elements which are to be controlled by the operator with this profile. If there
are more than one operator on the same channel, set the unique ID for each operator. This will allow radio

subscribers to make private calls to particular operators, dialing the specified ID.

Note. Operator can be assigned to the particular gateway of the network via ID. Therefore, it can be available to a

fewer amount of talkgroups and subscribers.

To assign the ID to the profile in particular network:
1. Select the ID checkbox in particular network,
2. Double-click ID to edit it,

3. Enter the proper ID for the network.

Note. If ID is unselected, Network ID will be used to identify the operator or user. In addition, it will be assigned to
the gateway, for which default radio ID is assigned. For more information see the configuration settings of DDMS or

VRC gateways in you networks.

If several dispatchers have the same ID, they will hear each other's private calls, even if Private calls is not

selected.
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In Capacity Plus and Linked Capacity Plus configurations based on NAI protocol, when using control stations
reserved for dispatcher private calls, a new parameter Reserved Control Station appears and the ID value matches

the reserved control station ID automatically:

-
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g
Settings | Networks | Client List | Network Corfiguration | Rules | Activity | Log | Export/import Settings | Statistics |
----- F9 Radio Server Profile
----- :% Licenses
- Radio Network Services Mame Profile 1
G- .. Add-on Madules o _ ]
E—]ﬁ, Profiles Limit Radios to Service
% ] Profile 1 Enabled
4, Subscriber Groups Bxample: 1-59. 150
E:I-ﬁ] Metadata Allowed radio 1D's B-16, 2528
| EpandAl || ColapseAl || @ Up || @ 0o

=)\ | MAI- Linked Capacity Plus 1 - Slot 1

-|¥/| Reserved Control Station: Contral Station 1
4ID: 1

..[¥] Private calls

Listening to private calls between subscribers
E| Radio Network Services

Private calls: If enabled, it allows the dispatcher to initiate private calls to radio and telephone subscribers, and
dispatchers.

Listening to private calls between subscribers: If enabled, it allows the dispatcher to hear private calls made
from radio subscribers to other radio subscribers, dispatchers or telephone subscribers and vice versa, read their
messages. This feature is available for networks with direct connection to repeater, e.g., IP Site Connect, Capacity
Plus.

To allow the dispatcher to make an All Call or a group call, select the corresponding check box. If a group is
selected, the dispatcher will hear all the calls made to this group.

To allow the dispatcher to use senices like ARS, GPS, TMS, telemetry, select the corresponding check boxes
under Radio Network Services.

Save changes and restart the server to apply the new profile.

Note: To assign the created profile, open the dispatch console, Settings > Radioservers.
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Subscriber Groups

Subscriber groups are used in many places, for example, to organize dynamic bridging of private calls, or to control
telephone calls, or to set different location update intervals.

To add subscriber groups, click Subscriber Groups in the setting tree of SmartPTT Radioserver Configurator

window. At that, Subscriber Groups window is displayed on the right.

-
ﬁ SmartPTT Server Configuration - C\Program Files (xB6)\SmartPTT\Server\RadioService.exe.config Elﬂu
Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Export/Import Settings | Statistics |
;B Radio Server Subscriber Groups
% Licenses
w4 Radio Network Services Sample List of Subscrbers for Group: 1.5,10-20
---'_AJ Add-on Modules
ﬂ Profiles
¥ Subscriber Groups Add ] [ Remove
-l Metadat
[ﬁ =ees Group Mame Subscribers
New Group 1 1-10
New Group 2 11-20
Mew Group 3 21-30

Group Name: Subscriber group name.

Subscribers: The list of radio IDs, which will be included in the created group.

Dynamic routing is configured in SmartPTT Dispatcher in the Route window.

Route Number
Source Control Station Route Type Destination Control Station
Automatically Dynamic v | Automatically
Subscriber Group
-Engineers Group 1 | ']
| oK | [ cancel
- EEF

Select Dynamic in the Route Type list. Select the group in Subscriber Group list.

Note: Routing configuration is described in details in SmartPTT Dispatcher help (Bridging).
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Metadata

To provide several dispatch consoles with one consistent list of subscribers it was decided to keep subscriber
metadata, e.g., radio ID, radio subscriber name, and whether it supports GPS or not. This data appears in SmartPTT
Dispatcher automatically as soon as the radioserver is up and running. This refers only to online radios. If a radio is
offline and is added to the Subscribers list, it won't appear in SmartPTT Dispatcher.

To create the database for subscribers metadata, select Metadata in SmartPTT Radioserver Configurator:

’
'@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadicService.exe.config @M
Settings | Networks | Client List | Rules | Activity | Log | Bxort/import Settings | Statistics |
;-2 Fadio Server Metadata
-4 Licenses _
- Radio Network Services Active
'-"‘ Addon Modules Creating Metadata Database
ﬁ Profiles
f@ Subscriber Groups Server Mame: localhost SQLEXPRESS
N
Subscribers Database Mame: Metadata

{“‘} Automatic Database Backup

[ Create Mew Database

Authorization Mode: lmndcws NT Authorization -
Login:
Password:

Check Connection

Restoring Database Backup

L]

[ Restore Databasze

Type in the Server Name and the Database Name fields, and click Create New Database. If creation is
successful, a message about successful database creation is displayed. If a database is not created, the cause of

failure will be displayed at the bottom of the window.

Note: For the database serer installed together with the radioserver enter the name using the following format:

Name of compute\SQLExpress (for example, MYCOMP\S QLEXxpress).

Select Authorization Mode between the two:
SQL Server Authorization: You must have the login name and password of the account with SQL server access.
Windows NT Authorization: The user who has logged into the Windows system, must be listed in the SQL

senver’s list of users to make connection.
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Click Check Connection. In case of successful authorization the message "The connection is established
successfully!" is displayed. If authorization fails, the cause will be displayed at the bottom of the window.
To restore the database from the backup folder, select the required database backup file in Restoring Database

Backup and click Restore Database.

Note: To set up the auto backup of the database, go to the Automatic Database Backup window.

Subscribers

To add subscriber metadata, select Subscribers:

’
ﬁ SmartPTT Server Configuration - C\Program Files (x86\SmartPTT\Server\RadicService.exe.config E@g
Settings | Networks | Client List | Rules | Activity | Log | Bport/import Settings | Statistics |
-8 Radio Server Subscribers
:?, Licenses
- Radio Network Services ID Input Format
---h; Add-on Modules @
‘Jﬁ Profiles @ |P address
i, Subscriber Groups ) CAl + Radio ID
Ell‘_ﬁ Metadata -
g
{ﬁ} Automatic Database Backup Add ] ’ Remove
D Subscriber Name GPS
12.0.01 Subscriber 1 £l
12002 Subscriber 2
12003 Subscriber 3

ID Input Format: Allows you to select the radio ID format to use.

To add a radio to the list, click on Add. At that, a window for entering the radio ID opens up. The ID format depends
on the selection in the ID Input Format section. In the Subscriber Name column enter the name of the added
radio subscriber. In the GPS column select whether the radio supports GPS.

To delete the radio subscriber from the database, select it in the list and click on Remove.

Click Save to keep changes and restart the radioserver to see the newly added radio subscribers in the dispatch

console.
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Automatic Database Backup

Backing up data on a regular basis helps to protect it from being erased in case of the server hardware or software
failure. SmartPTT Radioserver Configurator allows user to back up the metadata database automatically.
In order to set up automatic backup schedule of the metadata, select Automatic Database Backup under

Metadata in the setting tree of SmartPTT Radioserver Configurator.

~
@ SmartPTT Server Configuration - C:\Program Files (x86)\5martPTT\Server\RadicService.exe.config E@g
Settings | Metworks | Client List | Rules I Activity I Log | Export/Import Settings IStatisticsl
--E Radio Server Automatic Database Backup
. "% Licenses i
i o Act
(- Radio Network Services e
---L\_. Add-on Modules Backup folder
ﬂ Profiles E] CABackup
1"{., Subscrber Groups Backup Settings
Ell‘_ﬁ Metadata
4% Subscribers i) Daity
{@} Automatic Database Backup
(0 Weekly
@ Maonthty Day of month |1 =

Interval fmonth) |1 =
Time: %00 =
Backup Perod
Start date: 06.10.2016 (@~
End date: & (07.10.2016

@ Mo end date

Active: Select the check box to enable the ability to create database backups in the automatic mode.
Backup folder: Full path to the file for saving the database backup.
Backup Settings: Schedule for creating the current database backup:
e Daily: Every fixed day at the specified time (for example, every day, every third day at 9:00 a.m.).
o Weekly: Every fixed day of the week at the specified time (for example, every Monday, Wednesday and
Friday at 11:00 p.m.).
¢ Monthly: Once a month on the fixed day of the selected month and at the specified time.
Backup Period: Allows you to set time period when automatic database backup is to be made according to the

selected backup settings.

Note: The number of stored backup files in the same folder is limited to 3. Otherwise, when creating a new copy, the

old files are deleted.
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Networks

This section contains the description of configuration of control stations, MOTOTRBO topologies, SIP/RTP
Interfaces and SmartPTT Radiosenvers.

e Control stations

e Connect Plus

o NAl systems

o Capacity Max
e SIP/RTP Interfaces

e SmartPTT Radioseners

Control Stations

In this section you can configure MOTOTRBO, analog and remote control stations, which are used as a gateway to
radio network.

The MOTOTRBO control station is a mobile or portable MOTOTRBO radio station connected to the PC via USB and

used as a gateway to radio network.
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To set up the MOTOTRBO control station, right-click Control Stations in the Networks tab of SmartPTT
Radioserver Configurator, point to Add and click MOTOTRBO control station.

At that, a new setting window will appear.

& Control Stations MOTOTRBO Control Station
e
..... F Channels Active
% E:ﬁgmum Name Contral Station 1
E ﬁ:’:’;ﬁ Plus Network ID 1
ems
- Capacity Max Networks Control station IP address  152.168.10.1
sy SIP/RTF Interfaces
----- B9 SmartPTT Radioservers Local interface 192.168.10.2
Radia ID 16448250
CAl Network 12

CAl Netwark for Groups 225

[] Transmit Data Only

[ Alow Telephone Interconnect

GPS
ARS Pot 4005
TMS Port 4007
Telemetry Service Port 4008
fnalog Call Hangtime, ms 3000 =
Options
GPS Transmission Mode [Data "l

5 Tone Signaling
System »| [ Add | | Deete |
Encoder Telegram Numbers (1-32):

Woice Call Silent Intemogate
Stun Emergency Off
Unstun FTT Dekey

Name: Control station name.
Network ID: Unique ID of the network.
Control station IP address: The IP address of the control station. The following address format and range are

used: (001-223).(000-255).(000-255).(001-253). Users can use any address except 127.x.x.x in the range from
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1.x.x.x to 223.x.x.x. We recommend to use the address 192.168.170.1 by default, and in case of conflicts with other

network interfaces you should select a different IP address.

Note: If two or more control stations are connected to the computer, one of the first three octets of the IP address

must be unique for each control station.

Local interface: Local interface used for connection to the control station. A question mark at the beginning of the
field means that the control station was not defined.

Radio ID: Unique radio station identifier used during communication with it. ID is to be set in the range from 7 to
16776415. It is highly recommended to use 716448250 as ID.

CAIl Network: CAl-Network identifier. To be set in the range from 7 to 7126. Use the default value of 12.

CAI Network for Groups: The identifier of the group's CAI-Network. To be set in the range from 225 to 239. Use the
default value of 225.

Transmit Data Only: If selected, the control station is used for data transmission only and is not displayed in
SmartPTT Dispatcher.

Allow Telephone Interconnect: Allows you to enable wice calls to telephone subscribers.

GPS: Enables location senice which provides coordinates of radio subscribers.

ARS: Enables registration senice. Port 4005 is used as default. To register the radio in Capacity Max network, start
radioserver and make a call. At that the radio will be registered in the network untill Radio Inactivity Timeout runs
out and the radioserver is restarted.

TMS: Enables the senice for exchanging text messages amid dispatchers and radio subscribers. Port 4007 is used
by default

GPS Transmission Mode: Allows you to select the way how to transmit location updates: as data packet in

multiple bursts or as a single CSBK (Control Signaling Block).
Note: The GPS Transmission Mode parameter is not applicable to the Capacity Plus systems.

Each solution has its own advantages and disadvantages:

GPS Advantages Disadvantages

Transmission

Mode

Data e No need to configure additional settings for e Increased traffic load on a channel

receiving GPS data except for the Capacity
Max settings. In the Radio Management
program for all Capacity Max channels select

the Trunked Channel type.
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CSBK o

Enhanced CSBK

Low traffic load on a channel
Increased GPS transmission frequency

rate—once in 15 seconds

Low traffic load on a channel
Increased GPS transmission frequency

rate—once in 7.5 seconds

e Not all radios support CSBK commands

e Not all radios support CSBK commands

To transmit location data using CSBK or Enhanced CSBK, enable CSBK Data in radio settings.

Features

Fie Edit ‘View Device

& & |3 01 ¥

RM | Open Save | Reports | Delete

Remote Window  Help
& =R - a

Search | Read Write Clone

192168111 -

Cut Copy Paste

Untitledl

- § DP4s0t

...... General Settings
...... @ Accessories
------ Buttons

[E Text Messages
...... @ Telemetry

...... E Menu

------ B Job Tickets
- [B8 Signaling Systems

RX Group Lists
- @8] Channels

#: IPSC 141 Slot 1
- IPSC 141 Slot 2
JL#- Lnpa 430125

- Ml Channel Pool
L1 Channet2

s

Group List | |jst1 -
Emergency Alarm Indication I3
Emergency Alarm Ack |_

Emergency Call Indication 2

Top RX IX
Contact Name
Emergency System
VOX
Power Level
TOT (zec)
TOT Rekey Delay (sec)
Allow Interruption

TX Interruptible Freguencies

Admit Criteria

In Call Criteria

RS33| Threshold (dBm)
GPS Revert

Private Call Confirmed
Data Call Confirmed

Enhanced Channel Access

Cal -
Sysl A
-

=
-

-

o=

142 slot 2

[cranne: Free
Folow Adnit Criteria +
100

Selected R

=

aoa

CSEK Data

&y

m

Note: Enhanced CSBK can be used on Enhanced GPS channels only.

Analog Call Hangtime, ms: Virtual hangtime which is used for uniting analog calls into one. This was done to not

overload the event log with too many records of analog calls. During this hangtime the channel is not reserved, any

one can start transmitti
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Note: Although the control station can't be seen in the Subscriber panel, you can still find it in Report Wizard and

Radio Activity Report.

5 Tone Signaling: Settings for 5 Tone signaling, also known as SelectV.
SelectV is used in the analog networks to arrange selective calls. As a result, the analog channel provides additional
services other than all call. For example, group and private calls to the radio, blocking or unblocking the radio,

checking the radio presence on the channel.

Note: The current version of SmartPTT Radioserver Configurator supports SelectV signaling for MOTOTRBO DM

46xx Series radios and DP 46xx, DP 48xx Series radios used as control stations.

Note: Make sure that control stations and radios operating on the analog channel are configured properly in

MOTOTRBO CPS.

Selective call is based on subscriber addressing, i.e., on assigning IDs to subscribers. At the beginning of each
session the sound signals of different frequencies are transmitted and received by the radio. Such signals are called
telegrams. Each telegram contains from one to three sequences. Every sequence may include up to 12 tones. The
telegram formed in this way may include the calling subscriber or talkgroup address, the radio ID, a status message

or a command. The radio receives all signals, but handles only its telegrams, i.e., telegrams addressed to this radio.

Note: You can specify one or several identifiers (CAl + Radio ID or IP, MDC ID or 5 Tone ID) as a radio ID in
SmartPTT Dispatcher in the Properties window. If the radio is used on the analog channel only, enter 5 Tone ID or

MDC ID; the CAl and Radio ID or IP fields must be left empty.

System: 5 Tone signaling system. Parameters in this section allow you to match the outgoing command from

SmartPTT Radioserver and the telegram number.

Note: When decoded, telegrams are verified if the telegram sequences correspond to one of the definitions, and then
the command of this definition is applied. To configure the command definition, use MOTOTRBO CPS (Decoder >

Definitions, the Matching Encode Telegram field).

To create a 5 Tone signaling system in SmartPTT Radioserver Configurator, click Add. The several signaling
systems can be added for each control station. To change the control station signaling system, select the required
value from the list.

To delete the selected 5 Tone signaling system, click Delete.

Voice Call: The telegram number conforming to the private or group woice calls.
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Silent Interrogate: The telegram number which corresponds to the check command of the radio presence on the
network without notifying the subscriber.

Stun: The telegram number which stands for sending the Block command to the radio.

Unstun: The telegram number which stands for sending the Unblock command to the radio.

Emergency Off: When the radio receives the telegram number while in an emergency mode, the radio terminates
the emergency mode.

PTT Dekey: When the radio receives the telegram number, the radio stops the current call session.

When the telegram encoding parameters are set, it is required to assign the signaling system for the channel (see

the Channels tab).

If necessary, the control station can be disabled from the connection list. To do this, clear the Active check box.

To delete the control station, right-click Control Stations entry in the setting tree of SmartPTT Radioserver
Configurator and click Delete.
Elt, Control Stations

E‘b-’ Cortral Station 1
i b Channels | Delete

Analog control station

Following user evaluations and to facilitate migration from analog technology to digital technology, SmartPTT has
been complemented with support of analog control stations. Here you can find the configuration manual for the
analog control station connected to the computer COM port via interface card. The interface card schematic is

shown on the website.
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To add an analog control station, right-click Control Stations in the Networks tab of SmartPTT Radioserver
Configurator, point to Add and click Analog control station.

At that a new setting window appears on the right.

Elt Central Stations Analog Control Station
o R
.. ¢ Channels Active
LAy Audi
g Cﬂﬂgd F‘Iul: Mame Control Station 1
g NAI Systems
g Capacity Max Networks Network D 1
g SIF/RTP Irterfaces
----- B9 SmartPTT Radioservers Serial Number
Switch Pin CD (1) -
R Pin CT5 (8) -
Tx Pin RTS () -
T¥ Time-Out Timer, s 60 =
Analog Call Hangtime, ms 3000 =

Name: Control station name.

Network ID: Unique ID of the network.

Serial Number: The control station serial number.

Serial Port: The port to which the control station is connected.

Control station control signals:
e Switch Pin (incoming) is set to 7 (< -3.0V) when the control station is switched on.

e Rx Pin (incoming) is set to 1 when a signal carrier is registered on the channel.

e Tx Pin (outgoing) is set to 7 to switch to transmit mode.
Change the display of the control signals of the control station to the pins of the socket RS323 (see the DE-9 pin

numbers in brackets), if it is different from the one that is specified.
Note: The default values of the control signals are universal and usually do not require any changes.

TX Time-Out Timer, s: Continuous radio transmission timeout. After this time the transmission is interrupted.
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Analog Call Hangtime, ms: A virtual hangtime which is used for uniting analog calls into one. This was done to not
overload the event log with too many records of analog calls. During this hangtime the channel is not reserved, any
one can start transmitting.

In the Control Station Channels window add a channel and name it (otherwise the dispatcher displays 1:1).

=& Control Stations Control Station Channels

(- Control Station 1
...... _'

...... E Audio

g Connect Plus

H MAI Systems

-y Capacity Max Networks
“ SIP/RTP Intedfaces

..... B9 SmartPTT Radioservers

Add ] [ Remaove

Mame

Audio is configured in the same way as for the control stations MOTOTORBO.

Save the changes and restart the seniice.

Note: In SmartPTT Dispatcher the operation of the analog control station is the same as for MOTOTRBO control

stations in analog mode without signaling.

Remote control station

A remote control station is a MOTOTRBO control station located anywhere else, and not connected to the
radioserver PC by a USB cable. The control station is connected to a special gateway for remote control (RG-1000)
which provides IP connection to the radioserver. The remote gateway supports MOTOTRBO control stations (DM

series) on both digital and analog channels.

Site 1

Control station
+ RG 1000

Site 2

Dispatch console Radioserver
Control station
+ RG 1000
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To add a remote control station, right-click Control Stations, point to Add and select Remote MOTOTRBO

Control Station. At that a new setting window appears on the right.

=% Control Stations Remote MOTOTRBO Control Station
Active
Name Remate control station 1
Metwaor [D 1
Remote gateway P 192.168.10.1 XCMP port 30010
Local inteface 192.168.10.2 -
Radio ID 16448250
CAl Network 12
CAl Network for
Groups 225

[ Transmit Data Oty

[ Mlow Telephone Interconnect

GPS
ARS Port 4005
TMS Port 4007
Telemetry Service Port 4008
Analog Call Hangtime, ms 000 =
Options
GPS Transmission Mode Data N

Set local ports

Local ports

#CMP 1024
Audio 1024
GPS 1025
™S 1026
ARS 1027
Telemetry 1028

Remote gateway IP address: The IP address of the remote gateway RG-1000 which provides control over the
remote control station.

XCMP Port: The port of the remote gateway, it should match the XCMP port set in the settings of the remote
gateway.

Local interface: The local interface used for connection to the remote gateway.

SmartPTT PLUS 9.1 101
Radioserver Configurator User Guide



Set local ports: Local ports that can be used for connection to the gateway, if the default ports of the corresponding
senices are already in use. By default the system occupies local ports automatically, but you can define them
manually.

Other parameters of the remote control station correspond to the parameters of an ordinary MOTOTRBO control

station (see here).

How to Configure Control Station Channels

After adding a control station, configure its channels. To set up and edit control station channels, click Channels in

the setting tree of SmartPTT Radioserver Configurator. At that, the following window is displayed.

To add a channel, click Add. At that, you will see a record of the added channel appear in the table.

|_:_|$;_‘_ Contral Stations
(- Cortrol Station 1

Control Station Channels

[ Copy )

[W1]
@
[y

oo

[ a Talkgroups

...... El Audio

ﬁ Connect Plus [ Add

g NAI Systems Channel  Signali
analing

4§ Capacity Max Networks

g SIP/RTP Interfaces 1 1 5 Tone - Sys1
----- F9 SmartPTT Radioservers Channel 2 1 2 Auto

” Remove ]

Name Zone

€<

Name: Channel alias visible to SmartPTT Dispatcher.
Zone: Serial number of a channel group. Information on the maximum possible number of zones and radio station

channels is shown in the following table.

Model Maximum number of |Maximum number of Maximum total number
zones channels per zone of channels

Mobile radio station |50 160 160

with display

Mobile radio station |2 32 32

with seven segment

display

Channel: Channel sequence number.
Signaling: 5 Tone signaling system taken from the MOTOTRBO Control Station settings window. The field is

available only if the MOTOTRBO control station has at least one 5 Tone signaling system.
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When Auto is selected, the automatic detection of the channel type is set (analog, digital, IP Site Connect slot,

etc.). The detection take place when you connect the control station.

Note: If the channel type can't be determined automatically, you should specify the signaling system explicitly.

— selected channel will be set at the control station, when you start the radioserver.
To remowve a channel, click Delete. To edit channel name, zone or channel number, place the cursor on the

corresponding field and make changes.

How to Configure Control Station Talkgroups

To set up and edit Control Station Talkgroups, click Talkgroups in the Networks tab of SmartPTT Radioserver

Configuration. At that, the following window opens.

- Control Stations Control Station Talkgroups
=gz Control Station 1
... i Channels Co Paste
P Takroups | B | h
i Audio
iy Connect Plus [ Al Cal ]
g NAI Systems ' Diown
-y Capacity Max Networks [ Add ] [ Remove ] [ & Up o
g SIP/RTP Interfaces Name ID
----- F9 SmartPTT Radioservers
Al Call
Group 1 1
Group 2 2

To add a talkgroup, click Add. To add an all-call, click All Call The added talkgroups will also appear in the Profiles
window. To change the order of groups in the list, use the Up and Down arrows. The order defined in the window will
be used in SmartPTT Dispatcher.

Name: Talkgroup alias displayed by the control station.

ID: Talkgroup unique identifier used during communications. To be set in the range from 1 to 16776415.

Remove: Delete the selected talkgroup.

Copy: Copy added groups to the clipboard.

Paste: Paste copied groups from the clipboard.

To edit talkgroup name or ID, set the cursor on the corresponding field and make changes.
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How to Configure Control Station Audio Settings

To select audio devices and set up VolP parameters, click Audio in the Networks tab of SmartPTT Radioserver
Configurator.

1§k Control Stations Audio Settings
gt Cortrol Station 1 )
... ¢ Channels Active
a Talkagroups
P E- Audio input
Connect Plus :
E NAI Systems (03 dak, 3
S st (Osuas rpomacn 7
----- B9 SmartPTT Radioservers Cod
ec |CCITT u-Law v
Format 8000 Hz, 20 ms, 64 (36) kbps -
Audio output
DS : Default, 1:L ']

The Active check box allows disabling calls for a control station if it is used to transmit data only.

Audio input: An audio device to which the control station audio output is connected.

Input line: Audio mixer line used for connections. The control station audio output can be connected to the line
input of the audio device.

Codec: Outgoing audio stream compression method.

Format: Sampling frequency of an outgoing audio stream.

Example:

Specifications of the codec format 8000 Hz, 20 ms, 64 (86) kbps:
8000Hz is the sampling rate

20 ms s the frame size

64 kbps is the wice data bit rate

86 kbps is a full bit rate (required network bandwidth)

Audio output: An audio device to which the control station audio input is connected.
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Connect Plus

SmartPTT PLUS supports Connect Plus multi-site trunking system, which starting from version 8.5 can be used not
only for ARS, TMS and GPS functionality, but also for voice communication between the dispatcher and radio
subscribers.
Connect Plus network can include up to 15 repeaters (29 channels + 1 control channel) on each site. Each site
must have at least one XRC Controller. It is the core of the Connect Plus network and its presence on each site is
obligatory. The XRC Controller provides central call processing and real-time resource management for MOTOTRBO
Connect Plus digital trunking systems. There can be two XRC Controllers per site if one of them serves as backup to
the primary XRC. The secondary controller provides backup capability, but it does not increase the number of
repeaters and calls that can be managed per site.
XRT Gateways are required for voice communication only. MOTOTRBO Connect Plus multi-site trunking network
provides extended load capacity and provides digital communication to as many as 2,900 subscribers per site.
When using Connect Plus network, SmartPTT Radioserver plays the role of a virtual repeater.
The Connect Plus network configuration includes the following stages:

1. Adding new network and its basic configuration.

2. Setting up XRC Controller configurations.

3. Setting up talkgroups for group messages.

4. Setting up XRT Gateway parameters for voice communication.

5. Adding talk paths for wice calls.
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How to Configure Connect Plus

Make sure you have the necessary license for the Connect Plus network, i.e. Connect Plus Voice Support and
Connect Plus Data Support.

To configure Connect Plus settings, add new Connect Plus system: right-click Connect Plus in the Networks tab
of SmartPTT Radioserver Configurator and click Add.

At that, the Connect Plus window opens.

o % Control Stations Connect Plus
-y Connect Plus

BRW Corvc s peve

1 XRAC Cortrollers

HE

% ¥AT VoiceGateways Name Connect Flus 1

-

-4 Security Settings
g NA Systoms Metwork 1D 1
g Capacity Max Networks Peer ID 1
g SIP/RTP Interfaces
----- FS SmaritPTT Radioservers Radio 1D 1
Irmterface Ay -
UDP Start Port 15000 o

Active: Enables Connect Plus Network.

Name: Connect Plus network name.

Network ID: Unique ID of the Connect Plus network, which is used inside SmartPTT system. This is important if
you have more than one Connect Plus network. Note that this ID is different from the Network ID defined in the XRC
Controller codeplug.

Peer ID: Unique ID of the virtual repeater in the Connect Plus network. Make sure this ID is different from the

repeater ID in the Connect Plus network.
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Radio ID: The identifier of the radioserver. This is the identifier radio subscribers will see at receiving private calls

and text messages from the dispatcher. If there are several dispatchers, you can create a profile for each operator

(Profiles) and define a unique identifier for each operator. Radio ID set in this window must correspond to the

Console User ID field in the XRT Gateway settings.

Usges Debails
Usemame mbic.
P assword [
Max Talk Pathe 10
[] Bifing Enabled
] Metwork Wide All Call (WAL Enabled
Group Tk Paths
Giouwp ID (1001, 1002
Private Talk Paths

Console User 1D | 100

Save

([ tew ]

Interface: IP address of the virtual repeater, i.e. SmartPTT Radioserver. Specify the IP address of the PC where the

radioserver is installed.

UDP Start Port — this is the starting port number for local UDP ports that will be used by SmartPTT Radioserver for

talk paths. It is recommended to use the default value of 79000. If the created Connect Plus network should not

transmit wice packets, this field can be ignored.

To delete the Connect Plus network, right-click the network you want to delete and click Delete.
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o] t . Contral Stations

-4y Connect Plus

=" Connect Plus 1
4% XAC Contrc
-0 ¥RT Voic

) ’% Security Settings

g NAI Systems

iy Capacity Max Networks

g SIP/RTP Interfaces

----- FN SmartPTT Radioservers

Delete

(
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XRC Controller

The XRC Controller is necessary for transmitting registration and de-registration, GPS data, text messages. The
XRC Controller is also required for making private calls, because without it, radios will be regarded as offline, and the
dispatcher won't be able to make private calls.

You can add only one XRC Controller per site. Right-click XRC Controller to add. At that, the following window

opens:
% Cortrol Stations XRC Controller
EH Connect Flus _
=g Connect Plus 1 Active
=143 XRC Cortrollers
Elh' ¥AC Contraller MName ¥RC Controller
-4} Talkgroups Controller Address remotehost
4% ¥RT VoiceGateways
i % Securty Settings FM, TM5, GP5S
H MAl Systems FM
iy Capacity Max Networks -
—{ag SIP/RTP Interfaces Controller Port s B
----- FS SmaritPTT Radioservers Local Port 50005 =
TMS
Controller Part 4007 =
Local Port 50007 =
GP5
Controller Port 4001 =
Local Port 50001 =

Manitaring

Cortroller Port 38000 |2
Local Port 38000 =
Use NAT

Name: XRC Controller name. This is used only in SmartPTT Radioserver Configurator.
Controller Address: IP address of the XRC Controller. Port is not required in this field.
In order to enable data senices on the controller select PN, TMS, GPS.

Controller port: Port of XRC Controller for the corresponding senvice.

Local port: Port of the virtual repeater for the corresponding senvice.

Note: PN Controller Port should match the port of Presence Notification senice set in XRC Controller.
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To be able to review the XRC Controller on the Monitoring panel in SmartPTT Dispatcher, select Monitoring and
specify Controller port and Local port. If the XRC Controller is in one local network with the radioserver, leave Use

NAT unchecked. If the XRC Controller is outside the local network of the radioserver, select Use NAT.

Note: Make sure that general Monitoring is active.

In order to send group text messages, add talkgroups. Click Talkgroups under XRC Controller. At that, the

following window opens:

Control Station Talkgroups
Eg Connect Plus

Elh Connect Plus 1 [
E{EI} ¥RC Controllers
Eh ¥RC Controller

-3 [ Al Call ]

&4 KAT VoiceGateways [

.5, Security Settings
g NAI Systems
g Capacity Max Networks
g SIF/RTP Interfaces
..... FN SmartPTT Radioservers

XRT Gateway

The XRT Gateway allows making wice calls and monitor call events in the Connect Plus system. You can have
maximum 5 XRT Gateways working in one network.
Note: To support private voice communication, it is necessary to have an XRC Controller. Otherwise, radio

subscribers will be regarded as offline, and private calls will be impossible.
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To add the gateway, right-click XRT VoiceGateways and click Add. At that, the following window opens.

- t__ . Cortrol Stations XRT Gateway
Elg Connect Plus i
E‘h‘ Connect Plus 1 Active
E{E:S ¥R(C Controllers MName ¥RT Gateway
{ E'h' ¥RC Cortroller
&% Talkgroups
El’fﬁf‘ XRT VoiceGateways Gateway Address:Port remotehost: 10001
: i kB Talk Paths Poal IDs 16000001-16000100
o "% Security Settings
g MAI Systems Usemame public
g Capacity Max Networks
g SIP/RTP Interfaces
..... FN SmartPTT Radioservers Password password 1
T¥ Time-Out Timer, s 60 =
Group Call Hang Time, ms 4000 =
Private Call Hang Time, ms G000 =
Emergency Call Hang Time, ms 2000 =

Name: XRT Gateway name, which is displayed only in SmartPTT Radioserver Configurator.
Gateway Address:Port: IP address and port of the XRT Gateway.
Pool IDs: It is recommended to use default values. The values must correspond to the range of IDs set in the XRT

Gateway settings (Pool ID).

SmartPTT PLUS 9.1 110
Radioserver Configurator User Guide



Username and Password: Used for authentication with the gateway and must equal the corresponding values in

the XRT Gateway settings:

Usges Debail:
Usemame | puibibe
P asswoed [———

Max Talk Pathe (10 f
[] Biling Enabled
WA Network Wide Al Call (NWAC) Enabled
Group: Talk Paths
Group 10 1004 1002

Private Talk Paths

Conzole Us=s ID o0

TX Time-Out Timer, s: Time period during which the radio can transmit without interruptions. After this time is over,
the transmission is interrupted.

Group Call Hang Time, ms: Time during which the channel is reserved for a group call after the end of
transmission. During the timeout, only the participants of the talkgroup can transmit. This parameter should match
the same parameter set in the XRC Controller.

Private Call Hang Time, ms: Time during which the channel is reserved for a private call after the end of
transmission. During the timeout, only the participants of the private call can transmit. This parameter should match
the same parameter set in the XRC Controller.

Emergency Call Hang Time, ms: Time during which the channel is reserved for an emergency call after the end of
transmission. During the timeout only the participants of the talkgroup can transmit. This parameter should match

the same parameter set in the XRC Controller.
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The next step is to add talk paths. They are necessary for voice communication. For each talkgroup or/and

dispatcher add a talk path. This can be done in the Talk Paths window. Group IDs should match the IDs set in the

Group ID field in the XRT Gateway settings (see abowe). If the Group ID field is empty in the XRT Gateway settings,

the user should have permission for any Group Talk Path that it validly registers with the XRT 9000.

Dispatcher ID should match the ID set in the Console User ID in the XRT Gateway settings (see abowe).

- &> Control Stations

=8 W Connect Plus

B- h Connect Plus 1
|é| {:} ¥RC Controllers

h ¥RC Controller

P i h Talkaroups
EI {’:} ¥RT VoiceGateways
L B g “RT Gateway

-4 IE3ED

i) T Securty Settings
ﬂ MNAI Systems
g Capacity Max Networks
g SIF/RTP Interfaces
..... FN SmartPTT Radioservers

Talk Paths
[ Al Cal |
| Add || Delete |
MName Type 0
oup Group * | 1001
Group 2 Private 1002
Dispatcher Private 100

Note: When adding talk paths make sure that talk paths with the same identifiers are specified in the XRT Gateway

settings.

Control Stations

Control stations provide voice communication like the XRT Gateway. You can use control stations instead of the XRT

Gateway or together with it to increase the number of talkpaths. One control station can be reserved for one group

call or dispatcher call only.

Note: To use control stations, you need a special license.

To add a control station right-click on Control Stations in the Networks tab of SmartPTT Radioserver Configurator

and then click Add > MOTOTRBO control station. You can also add a remote control station, for more information

about a remote control station see this article.
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- $. Control Stations Connect Plus Control Station
Eﬁ Connect Plus

g Connect Flus 1 Active

Do
ik XRC Controllers Name Cortrol Station 1
=43 XRT VoiceGateways
| E-iy Wnios XRT IP address 152.168.10.1
e & Talk Paths . 192.162.10.2
£-&.. Control Stations Local interface 92.168.10.2
{ b @ Audio
) ’_‘ﬁ Security Settings Reserved for

ﬁ MAl Systems [ Dispatcher

g Capacity Max Networks

g SIP/RTP Interfaces O Group D |0

----- BN SmatPTT Radioservers
= Mame |Group

Note: To configure the remote control station properly, please refer to the “Terminal RG-1000" Customer

Programming Software User Guide”.

The following fields should be filled to connect the control station to SmartPTT Radioserver:

e Name: Control station name.

o [P address: The IP address of the control station. The following address format and range are used: (007-223).
(000-255).(000-255).(001-253). Users can use any address except 127.x.x.x in the range from 1.x.x.x to
223.x.x.x. We recommend to use the address 792.168.10.1 by default. In case of conflicts with other network
interfaces select a different IP address.

o Local interface: Local interface used for connection to the control station. A question mark at the beginning of

the field means that the control station was not defined.

Note: If two or more control stations are connected to the computer, one of the first three octets of the IP address

must be unique for each control station.

e Radio ID: The unique identifier of the control station used for communication. This Radio ID must match
Radio ID set in the settings of the control station. If the control station is used for dispatcher calls, and there
are more than one operator in the system, Radio ID must match the ID set in the profile of the operator for

whom the control station is reserved (see Prdfiles).

e Reserved for: Allows you to define how the control station is to be used. It can be used for private calls
(Dispatcher) or for group calls (Talkpath). You can use one control station per one dispatcher or per one
talkpath. To allow group calls, select Group, and enter the ID of the talkgroup and its name. To allow private

calls to and from the dispatcher, select Dispatcher.
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To make and receive private calls from the dispatcher, make sure that in the “MOTOTRBO™ Connect Plus Option

Board CPS” program the Manual Dial check box is selected.

,
& MOTOTRBO™ Connect Plus Option Board CPS - Version R02.06.02

File Edit View Device

Coderhn

B--C_onnect Plus Option Board

Help SL1K_403_438_Indexd5.cno

i General Settings

Text Messages

-- Zones
[ Netwarks

To learn how to configure audio settings, see How to Configure Control Station Audio Settings.

Security Settings in Connect Plus

i Woice Announcement

Text Messag
Call Alert E
Edit &

[ Manual Dial I
Phone Manual Dial =

Menu
e [

Contacts

Radio Check
Remote Monitor
Radic Enable
Radio Disable

i o

Connect Plus supports two types of privacy mechanisms — Enhanced and Advanced Encryption Standard (AES).

The Enhanced Privacy utilizes Motorola proprietary algorithms and therefore is not interoperable with other vendor's

privacy offerings. The Enhanced Privacy provides high level of protection by means of 40-bit key length and supports

multiple keys in a radio.

The Advanced Encryption Standard (AES) is a specification for the encryption of electronic data established by the

U.S. National Institute of Standards and Technology (NIST). The AES feature supports 256-bit key length, unlike

Enhanced Privacy. Similar to Enhanced Privacy, the AES also supports multiple keys. For AES encryption a

special license is required.
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The Security Settings window allows you to specify the encryption keys for incoming and outgoing traffic on the

digital channel.

- Control Stations

-y Connect Plus

=g Connect Plus 1
{ﬁ} ¥RC Controllers
T ¥RT VoiceGateways
3

g NAI Systems

gy Capacity Max Networks

gy SIP/RTP Interfaces

..... F9 SmarttPTT Radioservers

Security Settings

[ Copy ] Faste

Enhanced Privacy
[ Add ][ Remove ]

Key IO Key Value

AES
[ Add ][ Remaove ]

Key IO Key Value

TX Privacy

Type |No | KeyID

Copy: Copy encryption settings of the channel to the clipboard.

Paste: Paste encryption settings of the channel from the clipboard.
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Enhanced Privacy
To configure Enhanced Privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator add an enhanced privacy key for

incoming traffic. Enter its ID and value in the corresponding fields.

Click to add the
enhanced privacy
lemy

Click to remowve the
selected enhanced

Enhanced Privacy privacy key

‘\[\ Add ][ Hemove‘r—’

Key ID Key Value
1 0123456789

Note: Key ID and Key Value must match the values set in the radio settings in MOTOTRBO CPS and
MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields are the same, but
the values in the Key Value fields do not match, the receiving side hears only a distorted wice. If the key
identifier of the transmitting side does not coincide with one of the key identifiers in the list of the receiving side,

then transfer to the receiving party will not be heard.

2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Enhanced
and add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note above).

=~ § Dr4so1 -
- Bl General Settings Secunty

- @A Buttons

T L Pvay
I Privacy Type |Enhanced jl

- Click to add the o I?L Click to remove the
arc enhanced privacy Basic Privacy Koy |4 = selected enhanced

-1 Announcement ey privacy key

- B Job Tickets Add |

Delete
[~ @8 Signaling Systems

Top Privacy S Restricted Access to System

- Encoder Key 1D Key Alias Key Value
- Decoder 4 1 Privacy Key1 1
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3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.

E--fillesl DR 3000

[ @8 Channels

Top Brivacy

IPr'rvawTvpe IEnhanoed vll

4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Enhanced field

add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note above)

= 4 Untitled

General
=B

[ 8 Group List

[+ 48 Convertional

cﬂ Capacity Plus

[ ®: Linked Capacity Plus
- {88 Advanced

Click to add the
enhanced privacy
by

Click to remowe the
selected enhanced
privacy key

Add || Delete

Alias

Key ID Key Value

o Enhanced Keyl

1 0123456789 |

5. In the radio settings in MOTOTRBO CPS to enable the encryption mode on the required channel select the

Privacy checkbox and in the Privacy Alias field select the enhanced privacy key for this channel.
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& § DP4sod -
! B 174 - Slot1
- [0 (General Settings
g Accessories Top RX T
- HE Buttons
- [ Text Messages Woice Announcement File INO,-,E j
- @0 Telemetry
T Menu Dual Capacity Direct Mode [
P Security = Timing Leader Preference IEIigibIe -I
@) Announcement Scan/Roam List |Nme j
B Job Tickets Auto Sean [
[ Signaling Systems
- Encoder Color Code |1 3:
] Decoder
® Repeater/Time Slot |1 vl
[ @ Centacts L
B RX Group Lists Phone System |174 j
E-| 88 Channels
R #RS | On SystemiSite Change v |
~d=@: & Tone Enhanced GPS [
L 173 - Slot1
S 173 - Slot2 Window Size
- Select the enhanced
- privacy key
S 174 - Slot2
L 145 - Siot! IPF'W‘EE" Alias IPrivacy Key1 Iﬁ]
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AES Privacy
To configure the AES privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator add an AES privacy key for incoming

traffic. Enter its ID and value in the corresponding fields.
Click to add the Click to remove the
AES privacy key AES selected AES privacy key

Qi\- Add ] [ Remave

Key ID Key Value
1 5876543210

Note: Key ID and Key Value must match the values set in the radio settings in MOTOTRBO CPS and in
MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields are the same, but
the values in the Key Value fields do not match, the receiving side hears only a distorted wice. If the key
identifier of the transmitting side does not coincide with one of the key identifiers in the list of the receiving side,

then transfer to the receiving party will not be heard.
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2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Enhanced

and add the AES privacy key. Enter its ID and value in the corresponding fields (see the Note abowe).

£ § DP4sot .
.. B8 General Settings Security

- §  Accessones Top  Privacy AES — Restricted Access to System
- HE Buttons

- [ Text Messages Privacy

- T Telemetry

ﬁ Menu :

[PrwacyType IEnhﬂnoed 'I
T Network Basic Privacy Key |1 3:

{311 Announcement

B Job Tickets Add | Delete |

- @8 Signaling Systems

. @ Encoder Key ID Key fias Key Valus
.. @ Decoder » 1 Privacy Key 1

- [ Contacts

o g oy o O s O O s Y e O e |
| Ly iy i i Iy Ly L

RX Group Lists Click to remove the
selected AES privacy

Channels key

Scan

Roam

Capacity Plus Key ID Key Aias Key Value

3 1 Symmetric Key 987643210

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.
-fillasl DR 3000 .
_____ General Setings Security

Top Erivacy
m Sen::urit',rl

....... Metaork

E Privacy
------- 'z Link Establishment
.(:_> Sites o .
rivacy Type | Il
....... <a§ Talkgroups I Enhanced hd

- Channels

SmartPTT PLUS 9.1 119
Radioserver Configurator User Guide



4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Symmetric Keys
field add the AES symmetric privacy key. Enter its ID and value in the corresponding fields (see the Note

abowe)

= @ Urtitled

G I - i
=nera Click to add the AES Click to remove the
privacy key selected AES privacy

=3 Group List key
[ = Con\r[;ntional Add ] [ De.-leie'—‘]_/

cﬂ' Capacity Flus
2 (ﬂ Linked Capacity Plus Alias Key ID Key Value

- @8 Advanced 7 Symmetric Keyl |'I |33?654321D |

5. In the radio settings in MOTOTRBO CPS to enable the AES encryption mode on the required channel unselect

the Privacy checkbox and in the AES Alias field select the AES privacy key.

B o 174 - Slot1

& (@ o) o X
Bl &8 Zonet
-------:=:§- & Tone Voice Annocuncement File INc.ng j
~-IL% 173 - Slott
L 173 - Slot2
ng Timing Leader Preference |E|igib|g vI
I8 174 - Siot2
S8 145 - Siot! Scan/Roam List |Nme j
o TLE: 145 - Slot2
o ILE: Lingbpalss
U Lneppald? Color Code [+ 2]
n_g Lncppa1sT
eﬂ CapGroupi
0& CapGroup2
eg Al Cal
ﬂ :.g-:. Analog (COM)
- TL8 216 - Slot]

Dual Capacity Direct Mode |

Auto Scan [T

Repeater/Time Slot |4 -

Phone System |174 j

m

#R3 |on systemsie Change |

Enhanced GRS [
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- m Channel Pool ‘Window Size IS 'l
- ZoneZ Pri r
i LCP2
B _ _ Select the AES
G- Digital Privacy Aliss IPrimc*,r Keyl privacy key
F- @8 C3BK

I AES Alias j

H- @@ RA13 [ |symmetric Key1
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TX Privacy

T¥ Privacy

Type ‘Nﬂ TI Key ID
No |
Erhanced

AES (Legacy Key)
AES (Symmetric Key)

Type: Allows you to select encryption mode for outgoing traffic on the side of SmartPTT Dispatcher.

If No is set, radioserver does not support outbound traffic encryption.

If Enhanced is set, specify the Key ID value from the Enhanced Privacy table, which will be used to encrypt
outbound traffic.

Select AES (Legacy Key) or AES (Symmetric Key), with the required Key ID, if you want to use AES (Legacy Key)
or AES (Symmetric Key) for outgoing traffic. If TX Privacy is not set, and you have AES encryption for incoming
traffic, AES (Symmetric Key) will be used for incoming traffic by default.

AES (Legacy Key) — AES encryption (Motorola Solutions implementation, MOTOTRBO firmware earlier than R2.4).

AES (Symmetric Key) — AES encryption (DMR-compliant implementation, MOTOTRBO firmware R2.4 and later).
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NAI Systems

SmartPTT supports MOTOTRBO Network Application Interface (NAI) protocol for networks such as IP Site Connect,
Extended Range Direct Mode, Capacity Plus, and Linked Capacity Plus. NAI network configuration uses this
protocol for voice, data and monitoring data transmission.

Currently, you can configure four network types with the NAI protocol:

1. NAI - IP Site Connect

DDMS
IMNIS L DDrS_
|P-network
Repeater Repeater Repeater
~ J ™~
R ff ”“:\\ ff Y / Y
|I B ; ‘ ‘ ‘ ‘ ‘ ‘
SmartPTT ‘ ‘ ‘ ‘ ‘ J
Dispatcher SmartPTT

Radio Server

2. NAI - Extended Range Direct Mode

DDMS
I MNIS Looms

|P-network
Repeater

g AN

| 'm J ‘
SmartPTT ‘ ‘
Dispatcher SmartPTT

Radio Server
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3. NAI - Capacity Plus

DDMS
IMNIS
|P-network
I I ;
SmartPTT
Dispatcher SmartPTT

Radio Server

4. NAI - Linked Capacity Plus

|
&=

Router

E &

Repeater

L
Eoawm

DDMS

IMNIS
|P-network
|' i 4
SmartPTT
Dispatcher SmartPTT

Radio Server

|
L]

Router

Repeater

Jﬁ;

Ew

JI 1;

Note: You can install SmartPTT Radioserver, DDMS and MNIS on the same PC.
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The MOTOTRBO Network Interface Senice (MNIS) lets you transmit data (text messages, GPS, telemetry, etc.)
without control stations. MNIS connects with the repeater system over IP and uses them to transmit and receive

data packets.

Note: MNIS allows data transmission only. It does not support transmission of wice calls and CSBK commands

(Radio Check, Call Alert commands and so on).

The Device Discovery and Mobility Senice (DDMS) is a senice that monitors the presence of ARS capable radio
units and reports their parameters (IP address, Radio ID, etc.) to interested applications, such as SmartPTT

Radioserver and MNIS.

How to Configure NAI System

To add a NAIl system, click NAI Systems > Add, and select the network type (NAI - IP Site Connect,

NAI - Extended Range Direct Mode, NAI - Capacity Plus or NAI - Linked Capacity Plus):

-
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E‘M

Settings | Metworks |Dierrt List I Rules I Activity I Log I Export/Import Settings | Statistic5|

i t, . Control Stations HAl SYEtEI'I"IS

g Connect Plus

H MAl Systems

g CapactyMax| — pdd ) || NAI - IP Site Connect |
iy SIP/RTP Interreses :

.. SmartPTT Radioservers MAI - Extended Range Direct Mode

MAIL - Capacity Plus
MAIL - Linked Capacity Plus

SmartPTT PLUS 9.1 124
Radioserver Configurator User Guide



At that, a new window with network parameters will open. The network parameters differ depending on the selected

network type.

----- %5 Control Stations MAI - Linked Capacity Plus Network
H Connect Plus _
g NAI Systems Active
ER ] NAK- Linked Capaciy Plus 1 Name NAI- Linked Capacity Plus 1
B { Slot 1
P Metwork |D 1
Peer ID 1
Interface 192.16837.85  ~| Port 50000 |2
k¥ Canacity Max Netwark Master repeater
E 5|§?§|—T: Ir:xerf s address (P remotehost: 50000 Test
aces Address:Part)
----- F SmartPTT Radioservers
Authentication key
Voice transmission [Hepeaters -
Group call hang time, ms 3000 =
Private call hang time, ms 4000 =
Max number of telephone calls 100 =
Diata transmigsion
Monitoring

Name: Name of the created system.

Network ID: Unique ID of the network. The network ID must not match any ID of the other SmartPTT Radioserver
networks.

Peer ID: Unique ID of the radioserver in the network. This ID must not match any of the other repeater IDs in this
network.

Interface: Local interface of the radioserver. The radioserver plays the role of a software peer.

Port: Port number of the radiosenver. It should differ from the corresponding ports in other networks.

Master repeater address (IP Address:Port): IP address and port number of the network Master repeater. Click
Test to check connection between the radioserver and the Master repeater.

Authentication key: Repeater authorization key (should be equal to the Authentication key in the repeater

settings in MOTOTRBO CPS).
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Voice transmission can be carried out in two ways: via repeaters and via control stations.To transmit voice via
control stations, configure control station parameters and profiles for making private calls. To transmit wice via
repeaters, configure virtual control station channels and talkgroups of the channel. The number of channels depends

on the network type. To transmit CSBK commands use control stations for voice transfer.

To transmit data and monitoring data select the corresponding check boxes.

Group call hang time: Time during which the repeater reserves the channel for a group call after the end of
transmission. During the timeout, only the participants of the talkgroup can transmit.

Private call hang time: Time during which the repeater reserves the channel for a private call after the end of
transmission. During the timeout, only the participants of the private call can transmit.

Max number of telephone calls: Sets the limit on the number of simultaneous telephone calls per system.

Note: Max number of telephone calls is not applicable to the NAI - Extended Range Direct Mode systems.
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When selecting NA/I - Linked Capacity Plus network with voice via repeaters, the new section (Sites) appears in the

settings tree:

=8 Radio Server Sites
----- % Licenses
[ -ﬁ.‘ Radio Metwork Services Site Priorty Configuration
- Add-on Modules
"r;"- 2 Mz number of
----- Control Stations Site: telephane calls Priority E]
- IP Site Connect Networks
"8 Capaciy Fos Syses Ol [ 1 &
Connect Plus Site 2 16 2
Radio Activity Metworks Sita 1 16 3
=- MAI Systems )
&g NAI- Linked Capacity Plus 1 Ste 4 16 4
E|"['Slnt1 Site & 16 5
Talkgmups Site & 16 &
H Securty Settings Site 7 16 7
------ ! DDMS Settings Site B 16 8
------ ! MMI5 Settings -
4 SIP/RTP Interfaces Site 3 16 s
----- FN SmartPTT Radioservers Site 10 16 10
il Profiles Site 11 16 11
----- &5 Subscriber Groups
E'"fﬁ Metadata Site 12 16 12
Site 13 16 13
Site 14 16 14
Site 15 16 15
Site 16 16 16
Site 17 16 17
Site 18 16 18
Site 19 16 15
Site 20 16 20

Max number of telephone calls: Sets the limit on the number of simultaneous telephone calls per site.
Priority: Priorities should be set on the basis of the radioserver proximity to the site. The closer the radioserver to

the site, the higher priority it should have. Thus, you will be able to reduce delay in data transmission.
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The following example shows sites' location in respect to the radioserver, and talkgroups' distribution on the sites.
Site 3 Site 2 Site 1
. . | 10ms I 30 ms I 30 ms I
DDMS . , — —
s L2 o o
- |P-network
. Router

2 Repeater
s&ma,mTi'T _ay -y -y
SmartPTT

Dispatcher
.
f‘f RN f’f X x’f ~
groups groups groups
1,45 2,4,56 34,6

Radio Server

Here, talkgroups 3, 4, 6 are assigned to Site 1; talkgroups 2, 4, 5, 6 — to Site 2; talkgroups 1, 4, and 5 — to Site 3.
The Talkgroups tab in repeater MOTOTRBO CPS settings allows you to configure group calls as wide area calls on

specific sites.

[=-fllesl DR 3000
- E General Sefings Talkgroups

. Security All'Wide Area Talkgroups r
o Citen Add | Delete |
- Channels Cal 1D Site 1 Site 2 Site 3 Site 4 Site B

T H r v r r

: = r W r r r

3 = V¥ r r r r

M I 4 v r r

s = r W ¥ r r

r = ¥ V r r r

By default, the repeater sends data to Site 1. Then, data goes from Site 1 to other sites. So, if you call to talkgroup

4, the total time delay will be 130 ms.
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Setting up the site priorities so that sites with less time delay are associated with a higher priority allows sending
data to the nearest site, from which it is distributed to other sites. Ultimately, the total time delay in case of

talkgroup 4 reduces up to 70 ms.

Site Priorty Configuration

Site Priority - @
&

N 3
Site 2 2 _
Site 3 1 [
Site 4 4
Site 5 5

If connection with the site of the highest priority fails, the radioserver tries to work through the site of lower priority.

To assign site priority, drag the site name to the desired location or use arrows on the right to the table.

Note: Talkgroup distribution data is provided by the Talkgroups table on each site (repeater settings in MOTOTRBO
CPS).
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When selecting NA/ - IP Site Connect with voice via repeaters, the Local Slots table appears. Local slots allow

multiple communications at one time. To add a local slot, click the Add button above the table.

-4y Connect Plus
-y MAI Systems
WA~ ke Comct 1
= 7" Slot 1
E Talkgroups
..... % Security Settings
= %" Slot 2
.88 Talkgroups
..... % Securty Settings
=~ " Local slot 1
E Talkgroups
..... % Security Settings
=% Slot local 1
©..8a Talkgroups
..... ot Securty Settings
-1 Local slot 2
- Talkgroups
..... &t Securty Settings
..... & DDMS Settings
..... & MNIS Data Gateway
g Capacity Max Networks
H SIF/RTP Interfaces

----- FN SmartPTT Radioservers

HAl - IP Site Connect Network

Active
MName
Netwar |D
Peer ID

Imterface

Master repeater
address (IF
Address:Port)

Authertication key

Voice transmission

NAI - IP Site Connect 1

1

1

192.168.37.85

Port

:

rematehost: 50000

Test

Fepeaters

1

Group call hang time, ms

Private call hang time, ms

Mz number of telephone calls

Data transmission
Manitaring

5 g

[ [EE| [

Local Slots

[ pad |

Delete

Mame

Peer ID

Slot

Local slot 1

—_

Slat 1

Slet local 1

—_

Local slat 2

Slat 2

Slot 1

Name: Name of a local slot, which will be displayed in SmartPTT Radioserver Configurator and SmartPTT

Dispatcher.

Peer ID: The identifier of a repeater.

Slot: Selection between slots (Slot 1 or Slot 2).
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To configure NA/I - Extended Range Direct Mode, ensure that the following settings are specified:

1. The repeater has the corresponding license in MOTOTRBO CPS.

-
B MOTOTRBO Customer Programming Software - [Untitled1] R
Fie Edit View Device Features Remote Window Help - 8 x
@ W 3 Kk Qe »E 192168111 .
: RM | Open Save | Reports | Delete | Cut Copy Paste | Search | Read Wnte Clone | Bluetooth |
_______ Senersl Setings Device Information
L Top  Device Features
| Feature | Status |
Digital Free
& i Channels - IP Site Connect Free
= i Z[.’_rfm - Capacity Pius - Single Site Purchased
it ﬂ IpSite - Enhanced Privacy Free
n:) ERDM - Transmit Interrupt Free
wan e
¢ " CapacitySingle - Dynamic Moced Mode Fres -
) o i
<-_'?'_ CapaciyLinked - Enhanced GPS Free
"'""?:' InSiteSFR - Digital Phone Patch Avaistls for Purchase
{1 analog - Digital Voting Available for Purchase
- Sateliite Receiver Free -
- Capacity Plus - Multi-Site Purchased
- Restricted Access to System Free
- Network Application Interface Voice Purchased
- Network Application Interface Data Purchased
| - Extended Range Direct Mode Purchased | o
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2. Extended Range Direct Mode has the Enabled value in MOTOTRBO CPS.

’
B MOTOTRBO Customer Programming Software - [Untitled1] E=REER
Fie Edt ‘iew Device Features Remote Window  Help - & X

= H ] K d Q 2=J 1 |1g;|_.153.11.1 ,|
Bluetooth

RM | Open Save | Reports | Delete | Cut Copy Paste | Search | Read Write Clone

=il SLR 5500 . ;
- B General Settings IpSiteSFR

- € jAccessories Top Enhanced GPS RX IX
.
i Network Color Code |1 3; T

B Link Estabiishment

s Ses [ Extended Range Direct Mode |Emu&d vl l

-4, §8 Talkgroups Inbound Color Code [y =
=l {@8 Channels £
- @3 Zonet Outbound Color Code |4 =2
- IU- IpSite
b Metwork Application Interface Phone [
-1 ERDM

e 33:: CapacitySingle System Controller Mode [ B

e W gy Linked
IP Site Connect ING"& vl

Messaging Delay (ms) |gg -

3. The SFR Mode check box is selected in the MOTOTRBO Network Interface Senice Configuration Utility.

i il
{ MOTOTRBO Network Interface Service Configuration Utility * =@ =

Configuration  View  Edit  Service Help

Dk 0O e

= @ Urtitled
General
’; Security
o @ Group List Master IP Address  0.0.0.0
L g8E Listt
= &8 Conventional
. = Domain 1
- % Capaciy Plus MNIS LEpot @ Atomatically Assigned
= -(:'& Linked Capacity Plus @ Manually Assigned
i o [B Stes
= {8 Advanced
'ﬁiﬁ' Netwark Authentication Key
= Forwarding Rules
Application Overide

Master UDP Port 50000 B

SFR Mode
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How to Configure NAI Slots

After you have selected the network type, configure the slots. In order to do that, click the required slot in the

Networks tab of SmartPTT Radioserver Configurator. At that, the following window appears.

----- % Control Stations NAI Control Station
g Connect Plus _
=iy NAI Systems Active
Elh MAl- Linked Capacity Plus 1
EI T, Mame Slat 1
PRl oy
P ey Radio 1D 5535 |
o Talkgroups
- eyl Securty Settings CAl Network 12 :
i DDMS Settings
... MNIS Data Gateway CAl Metwork for Groups (225 =
-y Capacity Max Networks
g SIP/RTP Intefaces Allow Telephone Interconnect
----- B9 SmartPTT Radioservers T¥ Time-Out Timer, s |60 z
Options

[] Emergency alam confimed

[] Allow transmit intemupt

GPS Transmission Mode | Data -

Confimed Ewvents
Private calls

Note: For the NAI - Extended Range Direct Mode, NAI - Capacity Plus orNAI - Linked Capacity Plus networks, there

is only one slot to configure.

Name: Slot name.

Slot ID: Local slot identifier. This identifier is used in telephone calls (e.g., when there are many local slots to
differentiate between them).

Radio ID: Unique identifier of a virtual control station corresponding to the network slot.

CAI Network: CAl-network identifier. Use the default value of 712 (must match MOTOTRBO CPS settings).

CAIl Network for Groups: CAl-network for groups identifier. Use the default value of 225 (must match MOTOTRBO
CPS settings).

Allow Telephone Interconnect: Enables telephone calls on the slot.
Note: Allow Telephone Interconnect is not applicable to the NAI - Extended Range Direct Mode systems.

Emergency alarm confirmed: Determines if the emergency alarm is allowed to be acknowledged.
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Confirmation of private calls sets private calls on the current digital channel as confirmed.

Allow transmit interrupt: Enables or disables the ability to interrupt a radio subscriber.

Private Calls: Enables or disables the private calls confirmation.

GPS Transmission Mode: Allows you to select the way how to transmit location updates: as a data packet in

multiple bursts or as a single CSBK (Control Signaling Block).

Each solution has its own advantages and disadvantages:

GPS Advantages

Transmission

Mode

Data e No need to configure additional settings for

receiving GPS data
CSBK e Low traffic load on a channel
e Increased GPS transmission frequency

rate—once in 15 seconds

Enhanced CSBK' e Low traffic load on a channel
e Increased GPS transmission frequency

rate—once in 7.5 seconds

Disadvantages

Increased traffic load on a channel

Not all radios support CSBK commands

Additional MNIS settings*

Not all radios support CSBK commands

Additional MNIS settings*

Note: The Enhanced CSBK GPS Transmission Mode is not applicable to the NA/ - Extended Range Direct Mode

systems.

* To transmit location data using CSBK and Enhanced CSBK, configure additional MNIS settings, which include

adding repeater latitude and longitude. This information is used for calculation of radio locations.
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For NAI - IP Site Connect configuration specify latitude and longitude for each network system:

{% MOTOTREO Network Interface Service Configuration Utility * ! s
Configuration  View  Edit Help
= @ Untitled )
General
o Socty Enable
= &8 Group List
E Revert Channel
! L g8 Lstt el
\ =B i Convertional Securty Setting
| (=] PSC 1
! e-s- Capacity Plus Securty Alias
(= @ Linked Capacity Plus
= &8 Advanced
ﬁ- MNetwork
B Forwarding Rules
\ Application Overmide Rules 3
[ Ad | [ Deete |
I Peer ID GPS5 Latitude GPS Longitude
P |56 I
' -
a
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For NAI - Capacity Plus configuration specify latitude and longitude just in one place:

MOTOTREQ Network Interf: : [EEE )

Configuration  View  Edit  Service Help

D hbdHd ©0 @ '
= @ Untitled -
- [ Generl MNISLEFot @ Automatically Assigned
Secur
= Securty ) Manually Assigned Mone =
£ 488 Group List
" L g8 Lst il
I = &8 Convertional Authentication Key
=B IPsci
e
& <8 Linked Capacty P Securky Setting
i B Stes
5 @ Advanced Security Alias | vl
ﬁ- Network )
[ Forwarding Rules Group List E
Application Overide Rules Outbound Data Limit |2 EI
GPS Lattude 56
GPS Longitude 84

For NAI - Linked Capacity Plus configuration specify latitude and longitude for each site:

Configuration  View  Edit  Service Help

DL H OO e '

= @ Untitled
General
- @ Security Add || Delete
£ &8 Group List
L 3R Listt
L g8B Lst2
£ g8 Convertional
L=E IPSCT
- . Capacty Plus
=] (:ﬂ Linked Capacity Plus
D= i —_
= &8 Advanced

ﬁ- Network
[ Forwarding Rules
Application Overide Rules

Site Id Group List COutbound Data Limit GPS Latitude GPS Longitude
1 List 1 |2 56 84
2 List2 > |2 56 84
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Also, to transmit location data using CSBK or Enhanced CSBK, enable CSBK Data in radio settings:

Fie Edit View Device Features

@m = 3| 31 | ¥

RM | Open Save | Reports | Delete

Untitledl

= ﬁ DP4801

...... General Seftings

g Accessories

------ Buttons

...... Ed Text Messages

...... i3] Telemetry

...... B Menu

...... & Security

2% Network

------ € Voice Announcement
------ Bl Job Tickets

- [@8 Signaling Systems
- Encoder

- Decoder

[ 88 Contacts

- RX Group Lists
= ﬁ Channels

~JL8: IPSC 1441 Slot 1
- JLE: IPSC 141 Siot 2
J'I.ﬂ Lindbpa 430125
{‘]g Moi

& Channett
-4 Channel3
- 1 Channel Pogl

c % Channeiz

- Scan
- Roam
[ @8 Capacity Plus

Remote  Window  Help

&

Cut Copy Paste

bz bR b

Search | Read Wrte Clone

192168111 -

|x|

142 slot 2

Group List
Emergency Alarm Indication
Emergency Alarm Ack

Emergency Call Indication

Top RX IX
Contact Name
Emergency System
VOX
Power Level
TOT (sec)
TOT Rekey Delay (sec)
Allow Interruption

TX Interruptible Freguencies

Admit Criteria

In Call Criteria

RSS| Threshold (dBm)
GPS Revert

Frivate Call Confirmed
Data Call Confirmed

Enhanced Channel Access

Cal -
Sys1 -
r

G
o=

9

r

| channe Free
Follow Admit Crteria +
100

Selected =

I I

CSBEK Data

K

4

Note: Remember that Enhanced CSBK can be used on Enhanced GPS channels only.
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How to Configure NAI Talkgroups

To configure slot groups, click Talkgroups in the Networks tab of SmartPTT Radioserver Configurator.

g Connect Plus
-y NAI Systems
Elh' MAI - IP Site Connect 1
= T_ " Slot 1

s
{ % Security Settings
= T_ " Slot 2

b Talkgroups

L. Security Settings

..... & DDMS Settings
..... B MNIS Data Gateway
g Capacity Max Networks
g SIF/RTP Interfaces
..... FS SmartPTT Radioservers

Control Station Talkgroups
[ Copy ] Paste
[ Al Call |
[ Add ] [ Remove ] [ & Up ] [ ¥ Down
MName 0
Al Call
Group 1 1
Group 2 2

Note: The configuration process of the virtual control station talkgroups for NA/ - IP Site Connect, NAI - Extended

Range Direct Mode or NAI - Capacity Plus networks is absolutely similar to the configuration of MOTOTRBO control

station talkgroups.

For NAI - Linked Capacity Plus network type, parameters of wide area and local talkgroups are set in the Control

Station Talkgroups window. All the configured talkgroups are displayed in SmartPTT Dispatcher. For more

information about wide area and local groups of Linked Capacity Plus network see Motorola System Planer.

Wide area talkgroup calls are available to the subscribers that are in the coverage area of sites designated in

MOTOTRBO CPS for this talkgroup. Select check boxes in the required columns of the Talkgroups tab in the

repeater MOTOTRBO CPS settings. Each column corresponds to the site where the talkgroup is available for a call.

B8 DR 3000
= General Settings

Talkgroups

Al'Wide Area Takgroups |

@ Security
Network
o | o |
' Cm“’ﬂﬂ;’ cal ID Site 1 Site 2 Site 3 Site 4 Site 5 Site & Site 7 Site 8 Site 9 Site 10
1 = 2 v v r r r r r r r
2 = - 2 2 v [ [ [ - - [
3 = r r =2 v v r r - r r
» 4 = 2 2 I3 v v I~ I~ ~ - I~
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In order to display wide area talkgroups in SmartPTT Dispatcher, add necessary talkgroups in SmartPTT
Radioserver Configurator, define talkgroup identifiers that correspond to the identifiers of the wide area talkgroups in

the repeater MOTOTRBO CPS settings and select Wide in the Site Number field.

""" % Control Stations Control Station Talkgroups
-4y Connect Plus
[-jﬂf MAl Systems [ Copy ] Paste
=g NAI- Linked Capacity Plus 1
4" Slot 1
Y Sites [ AlCal )

[ Add ” Remove ] [ i Up ” # Down

" &% Securty Settings

----- B8, DDMS Settings Name ID Site Number
L. MNIS Data Gateway
g Capacity Max Networks Group 1 ! Side h
w SIP/RTP Interfaces Group 2 2 Wide
----- F9 SmartPTT Radioservers
Group 3 3 Wide
Group 4 4 Wide

The talkgroups that are not specified in the repeater MOTOTRBO CPS settings are considered as local. The local
talkgroup call does not go beyond the site where the call is initiated.

Add the required local talkgroups in SmartPTT Radioserver Configurator, define identifiers for them and select site
number from the list in the Site Number field.

Note: Make sure that identifiers of wide area and local talkgroups do not match.

----- % Cortrol Stations Control Station Talkgroups
iy Connect Plus
[_jﬁf MAI| Systems [ Copy ] Paste
=g NAI- Linked Capacity Plus 1
£ Sot 1

‘[ Sites [ All Call ]

[ Add ” Remove ] [ i Up Down

-t Securty Settings

= l DOMS Settings Mame 0] Site: Mumber
L..Em MNIS Data Gateway
-y Capacity Max Networks Group 1 ! L
-4y SIP/RTP Interfaces Group 2 2 Wide
----- FN SmatPTT Radioservers
Group 3 3 Wide
Group 4 - Site 1 4 1
Group 5 - Site 2 b 2
Group & - Site 3 & 3
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It is important to specify all talkgroups supported by the system in SmartPTT Radioserver Configurator. Otherwise,
the operator can't initiate a call to such a talkgroup until the talkgroup member has made a group call to the
operator.

To add the All Call, click All Call. In NAI - Linked Capacity Plus networks, you can add a wide All Call and a local
All Call, which is limited to one site. To add a wide All Call, which available to all sites, click All Call. Make sure
that Site Number is set to Wide. To add an All Call limited to one site, click All Call, and in the Site Number
column select the site number where the All Call will be heard. Please note, that you do not need any IDs for local

All Calls. Only dispatchers can initiate the local All Call from the dispatch console.

Note: Local All Calls operate within one site in networks where woice transmission is carried out via a repeater. In

hybrid networks, where woice transmission is carried out via a control station, a local All Call operates as the global

All Call.
..... %4 Cortrol Stations Control Station Talkgroups
-4y Connect Plus
[{Ig MAI Systems [ Copy ] Fasts
=g MNAI- Linked Capacity Plus 1
EI T_ Slat 1
T stes [ Al Cal |
-t Securty Settings [ Add ” Fenove ] [ 2 “ = Dne ]
= l DOMS Settings Mame 1D Site Number
LB MNIS Data Gateway
g Capacity Max Networks AlCal fde
g SIP/RTP Interfaces Al Call - Site 1 1
----- F9 SmatPTT Radioservers
All Call - Site 2 2
Group 1 1 Wide
Group 2 2 Wide
Group 3 3 Wide
Group 4 - Site 1 4 1
Group 5 - Site 2 5 2
Group & - Site 3 & e
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Security Settings

The NAI systems (IP Site Connect, Extended Range Direct Mode, Capacity Plus, Linked Capacity Plus) support
three types of privacy mechanisms — Basic, Enhanced, and Advanced Encryption Standard (AES).

Both Basic and Enhanced Privacy utilize Motorola proprietary algorithms and therefore are not interoperable with
other vendor’s privacy offerings. The main differences between Basic and Enhanced Privacy are that the Enhanced
Privacy provides higher level of protection by means of 40-bit key length. Enhanced Privacy supports multiple keys
in a radio compared to one key in the case of Basic Privacy.

The Advanced Encryption Standard (AES) is a specification for the encryption of electronic data established by the
U.S. National Institute of Standards and Technology (NIST). The AES feature supports 256-bit key length, unlike
Enhanced Privacy. Similar to Enhanced Privacy, the AES also supports multiple keys. For AES encryption a
special license is required.

The Security Settings window allows you to specify the encryption keys for incoming and outgoing traffic on the

digital channel.

----- ‘L . Control Stations Security Settings
g Connect Plus
g NAI Systems [ Copy Paste
g MAI - IP Site Connect 1
=N T. Slat 1 Basic Privacy

b Talkgroups —
i % Semnhr Sd_ﬁngs I{EY 1 =
21" Siot 2
Lo Ta"{gmups Enhanced Fll'i'ﬂ'EC}"

LTt Secuity Settings [ Ad || Remove |
..... & DDMS Settings

..... BB MNIS Data Gateway Key ID Key Value
EEI--h‘ MAI - Single Frequency Repeater 1
-y NAI- Capacity Flus 1

EEI"h' MAI- Linked Capacity Plus 1

g Capacity Max Networks

w SIP/RTP Intefaces

..... B9 SmartFTT Radioservers

AES
[ Add H Remove ]
Key ID Key Value
TX Privacy
Type |MNo | KeyID
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Copy: Copy encryption settings of the channel to the clipboard.

Paste: Paste encryption settings of the channel from the clipboard.

Basic Privacy
To configure Basic Privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator in the Key field specify the key for the

basic encryption mode. The value ranges from 7 to 255.

Security Settings

[ Copy ] | Paste

Basic Privacy

wew ]

Note: Make sure that Key set in SmartPTT Radioserver Configurator matches Basic Privacy Key set in radio
settings in MOTOTRBO CPS and MOTOTRBO Network Interface Senice Configuration Utility. If basic

encryption keys of receiving and transmitting sides do not match, the receiving side hears only a distorted

voice.

2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Basic. In
the Basic Privacy Key field specify the key for the basic encryption mode. The value ranges from 1 to 255

(see the Note above).

= [ DPaso1 - .
------- General Settings Secunty

------- Q ACCcessones
------- Buttons

Top Erivacy 5 Restricted Access to System
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3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select Basic.

- @@ Channels

Top

DR 3000 .
= Security

Erivacy

Privacy Type

e o]

4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Basic Privacy

Key field specify the key for the basic encryption mode. The value ranges from 7 to 255 (see the Note abowe).

= @ Urtitled
General

[ 8 Conventional
- b Capacity Plus
i - Linked Capacity Plus

Basic Privacy Key

5. In the radio settings in MOTOTRBO CPS select the Privacy checkbox to enable the encryption mode on the

required channel.

= f§ DPaso1

------- B Job Tickets

[ @8 Signaling Systems
[ Encoder

[ Decoder

[+ [ Contacts

- RX Group Lists

% 173 - Shot2

N0 N 174 - Siot1

i T 174 - Slot2
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Top

‘oice Announcement File

Dual Capacity Direct Mode

Timing Leader Preference

Scan/Roam List

Auto Scan

Caolor Code

Repeater/Time Slot

Phone System

ARS

Enhanced GFPS

‘Window Size

174 - Slot1

BX IX

I MNone j
r
I Mone j

|1?4 |

|On System/Ste Change |

Select to enable the J

IE vl privacy
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Enhanced Privacy
To configure Enhanced Privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator add an enhanced privacy key for

incoming traffic. Enter its ID and value in the corresponding fields.

Click to add the
enhanced privacy
leey

Click to remowve the
selected enhanced

Enhanced Privacy privacy key

\[\ Add H Hemuve‘r,'

Key (D Key Value
1 0123456785

Note: Key ID and Key Value must match the values set in the radio settings in MOTOTRBO CPS and
MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields are the same, but
the values in the Key Value fields do not match, the receiving side hears only a distorted wice. If the key

identifier of the transmitting side does not coincide with one of the key identifiers in the list of the receiving side,

then transfer to the receiving party will not be heard.

2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Enhanced

and add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note abowe).

= § DP4s01 -
- Bl General Settings Secu"ty

-~ EE Buttons

- [l Text Messages Pn'vacy

I Privacy Type IEnhanoad jl

Top Brivacy S Eestricted Access to System

Click to add the B e I?. Click to remove the
4 enhanced privacy Basic Privacy K&y |4 = =zelected enhanced
-3l Announcement ey privacy key
-~ B Job Tickets Add | Delete
B @8 Signaling Systems
- Encoder Key ID Key Alias Key Value
B Decoder » 1 Privacy Key1 1
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3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.

E--fillesl DR 3000

[ @8 Channels

Top Brivacy

IPr'rvawTvpe IEnhanoed vll

4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Enhanced field

add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note above)

= 4 Untitled

General
=B

[ 8 Group List

[+ 48 Convertional

cﬂ Capacity Plus

[ ®: Linked Capacity Plus
- {88 Advanced

Click to add the
enhanced privacy
by

Click to remowe the
selected enhanced
privacy key

Add || Delete

Alias

Key ID Key Value

o Enhanced Keyl

1 0123456789 |

5. In the radio settings in MOTOTRBO CPS to enable the encryption mode on the required channel select the

Privacy checkbox and in the Privacy Alias field select the enhanced privacy key for this channel.
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& § DP4sod -
! B 174 - Slot1
- [0 (General Settings
g Accessories Top RX T
- HE Buttons
- [ Text Messages Woice Announcement File INO,-,E j
- @0 Telemetry
T Menu Dual Capacity Direct Mode [
P Security = Timing Leader Preference IEIigibIe -I
@) Announcement Scan/Roam List |Nme j
B Job Tickets Auto Sean [
[ Signaling Systems
- Encoder Color Code |1 3:
] Decoder
® Repeater/Time Slot |1 vl
[ @ Centacts L
B RX Group Lists Phone System |174 j
E-| 88 Channels
R #RS | On SystemiSite Change v |
~d=@: & Tone Enhanced GPS [
L 173 - Slot1
S 173 - Slot2 Window Size
- Select the enhanced
- privacy key
S 174 - Slot2
L 145 - Siot! IPF'W‘EE" Alias IPrivacy Key1 Iﬁ]
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AES Privacy
To configure the AES privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator add an AES privacy key for incoming

traffic. Enter its ID and value in the corresponding fields.
Click to add the Click to remove the
AES privacy key AES selected AES privacy key

Qi\- Add ] [ Remave

Key ID Key Value
1 5876543210

Note: Key ID and Key Value must match the values set in the radio settings in MOTOTRBO CPS and in
MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields are the same, but
the values in the Key Value fields do not match, the receiving side hears only a distorted wice. If the key
identifier of the transmitting side does not coincide with one of the key identifiers in the list of the receiving side,

then transfer to the receiving party will not be heard.
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2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Enhanced

and add the AES privacy key. Enter its ID and value in the corresponding fields (see the Note abowe).

£ § DP4sot .
.. B8 General Settings Security

- §  Accessones Top  Privacy AES — Restricted Access to System
- HE Buttons

- [ Text Messages Privacy

- T Telemetry

ﬁ Menu :

[PrwacyType IEnhﬂnoed 'I
T Network Basic Privacy Key |1 3:

{311 Announcement

B Job Tickets Add | Delete |

- @8 Signaling Systems

. @ Encoder Key ID Key fias Key Valus
.. @ Decoder » 1 Privacy Key 1

- [ Contacts

o g oy o O s O O s Y e O e |
| Ly iy i i Iy Ly L

RX Group Lists Click to remove the
selected AES privacy

Channels key

Scan

Roam

Capacity Plus Key ID Key Aias Key Value

3 1 Symmetric Key 987643210

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.
-fillasl DR 3000 .
_____ General Setings Security

Top Erivacy
m Sen::urit',rl

....... Metaork

E Privacy
------- 'z Link Establishment
.(:_> Sites o .
rivacy Type | Il
....... <a§ Talkgroups I Enhanced hd

- Channels
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4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Symmetric Keys
field add the AES symmetric privacy key. Enter its ID and value in the corresponding fields (see the Note

abowe)

= @ Urtitled

G I - i
=nera Click to add the AES Click to remove the
privacy key selected AES privacy

=3 Group List key
[ = Con\r[;ntional Add ] [ De.-leie'—‘]_/

cﬂ' Capacity Flus
2 (ﬂ Linked Capacity Plus Alias Key ID Key Value

- @8 Advanced 7 Symmetric Keyl |'I |33?654321D |

5. In the radio settings in MOTOTRBO CPS to enable the AES encryption mode on the required channel unselect

the Privacy checkbox and in the AES Alias field select the AES privacy key.

B o 174 - Slot1

& (@ o) o X
Bl &8 Zonet
-------:=:§- & Tone Voice Annocuncement File INc.ng j
~-IL% 173 - Slott
L 173 - Slot2
ng Timing Leader Preference |E|igib|g vI
I8 174 - Siot2
S8 145 - Siot! Scan/Roam List |Nme j
o TLE: 145 - Slot2
o ILE: Lingbpalss
U Lneppald? Color Code [+ 2]
n_g Lncppa1sT
eﬂ CapGroupi
0& CapGroup2
eg Al Cal
ﬂ :.g-:. Analog (COM)
- TL8 216 - Slot]

Dual Capacity Direct Mode |

Auto Scan [T

Repeater/Time Slot |4 -

Phone System |174 j

m

#R3 |on systemsie Change |

Enhanced GRS [
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- m Channel Pool ‘Window Size IS 'l
- ZoneZ Pri r
i LCP2
B _ _ Select the AES
G- Digital Privacy Aliss IPrimc*,r Keyl privacy key
F- @8 C3BK

I AES Alias j

H- @@ RA13 [ |symmetric Key1
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TX Privacy

TX Privacy

Type INa vl Key (D
No |

Basic
Enhanced
AES (Symmetric Key)

Type: Allows you to select encryption mode for outgoing traffic on the side of SmartPTT Dispatcher.

If No is set, radioserver does not support outbound traffic encryption.

If Basic is set, the key specified in the Key field in the Basic Privacy section is used for encryption of outgoing
traffic.

If Enhanced is set, specify the Key ID value from the Enhanced Privacy table, which will be used to encrypt
outbound traffic.

Select AES (Symmetric Key) with the required Key ID, if you want to use AES (Symmetric Key) for outgoing traffic.
If TX Privacy is not set, and you have AES encryption for incoming traffic, AES (Symmetric Key) will be used for
incoming traffic by default.

AES (Symmetric Key) — AES encryption (DMR-compliant implementation, MOTOTRBO firmware R2.4 and later).
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How to Configure Control Stations

To transmit wice packets over control station, you need to configure its settings. Control station settings become

available, when you select wice packet transmission over control stations, not repeaters.

----- % Control Stations HAl - Linked Capacity Plus Network
ﬂ Connect Plus )
g NAI Systems Active
E'"h:' NAI- Linked Capacty Plus | Name NAI- Linked Capacity Plus 1
& '-L Slot 1
...... n Talkgroups Metwark 1D 1
i hegin Control Stations
...... g8 DD Seftings Peer D 1
------ - MNIS Data Gateway Interface 192.168.37.85  ~| Port 50000
g Capacity Max Metworks
i SIP/RTP Interf Master repeater
ﬁ P Had'aces address (IP remotehast:50000 Test
""" = omd I0SENERs Address:Part)
Authentication key
Voice transmission | Control Stations ~
Group call hang time, ms 3000 =
Private call hang time, ms 4000 =
Mzx number of telephone calls 100 =
Data transmission
Maritoring

To configure the control station settings, right-click Control Stations and click Add > MOTOTRBO control station.

You can also add a remote control station, for more information about a remote control station see this article.

----- % Control Stations NAI Control Station
H Connect Plus )
Sy NAI Systems Active
Bh MAl- Linked Capacity Plus 1 Name Cortrol Station 1
B '-L Slot 1
------ a Talkgroups IF Address 152.168.10.1
El ‘., Control Statmns _
ERS Coril Station 1 Fadio 1D ‘
...... (] Pqulu Working Channel Zone 1 Channel 1
------ -, DOMS Settings
...... g8 MMNIS Data Gateway Reserved for
ﬁ Capacity Max Networks @ Dispatcher
H SIP/RTP Inteffaces
----- F9 SmartPTT Radioservers Talkgroup
Name: Control station name.
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IP Address: Local IP address of the control station. The following address format and range are used: (0071-223).
(000-255).(000-255).(001-253). Users can use any address except 127.x.x.x in the range from 1.x.x.x to 223.x.x.x.
We recommend to use the address 192.168.170.1 by default, and in case of conflicts with other network interfaces

you should select a different IP address.

Note: If two or more control stations are connected to the PC, one of the first three octets of the IP address must be

unique for each control station.

Radio ID: Unique radio identifier used during communication with it. In the IP Site Connect network, the ID is to be
set in the range from 1 to 16776415. In the NAI - Capacity Plus or NAI - Linked Capacity Plus networks, the ID is to
be set in the range from 7 to 65535.

Working Channel: Select the channel and the zone to be set at the control station at the radioserver launch.
Reserved for: Allows you to define how the control station is to be used. It can be used for private calls
(Dispatcher) or for group calls (Talkgroup). This parameter is available only for NA/ - Extended Range Direct Mode,
NAI - Linked Capacity Plus and NAI - Capacity Plus networks. You can use one control station per one dispatcher
or per one talkgroup. To allow group calls, select Talkgroup. At that, the dropdown list with added talkgroups
becomes enabled. To allow private calls to and from the dispatcher, select Dispatcher and add profiles — one per
dispatcher. In the profile, select the reserved control station. At that, ID will change and will match Radio ID set in

the NAI Control Station settings.

..... B9 Papocepeep Mpoguns
----- % IMaueHzmm
- Cnyxiel pagoce g Mpodune 1
[t [dononHuTensHeie Moy
g- 'ﬂ HDOHJHJ'IH PUNETP PaaMOCTAHLAR
Ca 7 Beones
A aﬁnHEHToE: Mpuraep: 1-95, 150
EEI--[ﬂ MeTagaHHEE ID paspelEHHER paaMoc TaHUMIA 1-16776415
[ PackpeITe Boe ] [ CBepHyTE BoE ] 4 Beep: A Bz

=¥ MAI- Linked Capacity Plus 1-Cnot 1

--[¥] Baipenernan KC: KoHTponeHas cTaHums 1
----.ID. 1

|| YacTHble BLIs0ELI

[T Npocnywreanme yacTHLE BoISOBOE MeX Ly SB0HEHTEMM

= .Cn:.'xﬁbl pPaOMocETH
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Also, make sure the following settings are made in CPS in control stations' configurations:

1. When using for talkgroups:

¢ In General Settings, clear Private Calls.

@ DM4601

- EE Buttons

- B8 Text Messages
ﬁ Menu

@J)) Announcement
- Job Tickets

[l @8 Signaling Systems
H- &8 Encoder

m

General Settings

Top CWID  Audio Profile  Microphone — Battery Saver  Ales  Over-the-Air Programming
T~ Fersistent LRRP Requests  Lone Worker Bower Up Password and Lock  Front Programming Passwol

-

Delete Aft~~ 5 Tone Radio ID

-,
S

=l

GNS5 IGPSI'QZSS

~
Private Calls [

Site Search Timer (sec) |45 ==

ARS Inttislization Delay (min) |ﬂ. 3;

-
s

¢ In Network under Control Station section, select Voice Only.

------- General Settings
....... g Ancessones
------- Buttons:

------- Ed Text Messages
------- @ Telemetry

....... B menu

------- @) Announcement
- Job Tickets

B~ B8 Signaing Systems
El- @8 Encoder

m

Network

IP Site Connect

Top  Radio Network  Services — Control Station Bluetooth  Bluetooth Serial Port

USE HID Data Routing

Control Station

N mEmEmmmm s s Voice Only |V

Data Modem System Type IND“B vI
Diata Modem Window Size |5 vl

¢ In the Channel settings, in RX Group List, select the talkgroup, for which the control station is reserved in

SmartPTT Radioserver Configurator.

RX Group Lists

[—jﬁ Channels

E- & Zonet

0L NALIPSC_217

k@ NA_CP_217

L# NALLCP_21T

L. Digtal443

ﬂg Analogddimde
& craican

ﬂg Analog 441
1L Digitd43 CSBK En

30 CapGroup1

-e?: CapGroup2
{#. capaical

= M Channel Pool

SmartPTT PLUS 9.1

-

m

NAI_IPSC_217
Top RX IX
I
Offset (MHz)
Freguency (MHz) WDDDDDD IBDDDDDD Freguency (MHz) IEDDDDDD
_ew |
Ref Frequency [Defaut | Ref Frequency [Defaut |
Group List INcne j Contact Name ICaM
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Emergency Alarm Indication None Emergency System |5‘l51
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2. When using for dispatcher:

¢ In General Settings, select Private Calls.

=-@=P DM4601

-~ H@E Buttons h
- B8 Text Messages
o 0 Telemetry

:ﬁ Menu

al

m

@J)) Anncuncement
- Job Tickets

[ Signaling Systems
H- €8 Encoder

General Settings

Top CWID Audio Profile Microphone Battery Saver Alerts Over-the-Air Frogramming
== Fersistent LRRP Requests  Lone Worker  PowerUp  Password and Lotk Front Programming Passwol

Delete At~ 5 Tone Radio ID

e

-
~—

-

~—
e

-

GNSS |gpsiazss |

-
Private Calls  [v

Site Search Timer (sec) |45 ==

ARS Initislization Delay (min) |ﬂ. 3:

il

¢ In Network under Control Station section, select Voice Only.

------- General Settings
------- ) Accessories
------- Buttons:

------- Ed Text Messages
....... g T,B'E'netry

....... B Menu

- Job Tickets
- Signaling Systems
El- @ Encoder

m

Network

Top Radio Wetwork  Services Control Station IP Site Connect Eluetooth Eluetooth Serial Port
USE HID Data Routing

Control Station

Drata Modem System Type INO,-.B vI
Drata Modem Window Size |5 vl

¢ In the Channel settings, in RX Group List select None.

RX Group Lists -
[—jﬁ Channels
E- & Zonet
~-rLd: NALIPSC 217
e nu_cp_a17
ol NA_LCP_21T
-----IL:Q: Digitaldd3
{1# Anslogadimde
-{}g. CRAICal
{4 Anslog 441
~-IL Digitd43 CSBK En
-e?: CapGroup1 =
ﬂ'ﬁ' CapGroup2
.e:?: CapAiCal

o -

NAI_IPSC_217

Jop RX IX

Offset (MHz)
Frequency (MHz) [240,000000 fo-000000 Frequency (MHz) [445.000000
g o | g
Ref Frequency |Defaut Ref Freguency |Defauit +
|Gmup List |NmE jl Contact Name |m1

L L]

Emergency Alarm Indication 1= Emergency System |3y51

Note: All Calls can be initiated via a control station reserved for a group. If the control station is reserved for the

dispatcher, you can only listen to All Calls.
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To select audio devices and set up VolP parameters, click Audio in the Networks tab of SmartPTT Radioserver

Configurator.
""" % Control Stations Audio Settings
H Connect Plus _
C)-jag MAI Systems Active
=g NAI- Linked Capacity Plus 1

(= 1 Slat 1 Audio input
..... ¢.a TEI"{QI‘GIIJDS [DS - Default, 1 T]
L Bee Contral Stations
- DDMS Settings Cod
.8 MNIS Data Gateway = |CCITT wLaw v

g Capacity Max Networks

iy SIP/RTP Interfaces Fomat 8000 Hz. 20ms. 64 (88)kbps  ~ |

----- B9 SmartPTT Radioservers
Audio output

DS : Defau, 1:L v

Audio input: An audio device to which the control station audio output is connected.

Input line: Audio mixer line used for connections. The control station audio output can be connected to the line
input of the audio device.

Codec: Outgoing audio stream compression method.

Format: Sampling frequency of an outgoing audio stream.

Example:

Specifications of the codec format 8000 Hz, 20 ms, 64 (86) kbps:

8000Hz is the sampling rate

20 ms is the frame size

64 kbps is the wice data bit rate

86 kbps is a full bit rate (required network bandwidth)

Audio output: An audio device to which the control station audio input is connected.
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How to configure local slots

As soon as the local slot is added to the Local Slots table, a new section appears in the settings tree.

Note: Local slots become available only when Repeater is selected for wice transmission.

----- % Control Stations NAl Control Station
iy Connect Plus _
g NAI Systems Active
=g NAI - IP Site Connect 1
=-%" Slot 1 Peer 1D - Slot PeerID 1, Slot 1
""" Talkgroups Mame Local slot 1
----- 5% Securty Settings
=1 Slot 2 Slot 1D 3 =
----- 2 Talkgroups
_____ i SECIJI'ih" SEﬂII'IQS Radio 1D 16448250 bl
ERl Local siot | CAI Network 12 3
----- 2 Talkgroups
----- Gt Security Settings CAl Network for Groups | 225 %
..... = DDMS Settings
_____ = MNIS Data Gateway Allow Telephone Interconnect
-y Capacity Max Networks T¥ Time-Out Timer, s |60 -
g SIP/RTP Interfaces
----- FS SmaritPTT Radioservers Cptions

[] Emergency alam corfimed

[ Mlow transmit intemupt

GP5 Transmission Mode | Data -

Corfimed Events
Private calls

Active: Allows you to enable or disable a local control station.

Peer ID - Slot: Peer identifier and slot number. Data is taken from the Local Slot table.

Name: Name of the local slot. It is used in SmartPTT Radioserver Configurator and in SmartPTT Dispatcher.

Slot ID: The identifier of the local slot, which will be used for group calls. This will be used in a group call mask. It
must be unique in the system.

Radio ID: Unique radio identifier used during communication. It can match Radio ID of the virtual slots.

CAIl Network: CAl-network ID. Use the default value of 72.

CAI Network for Groups: Group CAl-network ID. Use the default value of 225.

Allow Telephone Interconnect: Allows telephone calls on the slot.
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TX Time-Out Timer, s: Time period during which the radio can transmit without interruptions. When time is out, the
transmission is interrupted.

Emergency alarm confirmed: Determines if the emergency alarm is allowed to be acknowledged.

Allow transmit interrupt: Enables or disables the ability to interrupt a radio subscriber.

Private calls: This feature sets private calls on the current digital channel as confirmed.

GPS Transmission Mode: Allows you to select the way how to transmit location updates: as a data packet in
multiple bursts or as a single CSBK (Control Signaling Block). For more information see GPS Transmission Mode.
To configure groups of the local slot, click Talkgroups. Configure talkgroup settings as ordinary IP Site Connect
talkgroups.

If you use encryption, go to Security Settings. For more information on how to configure encryption settings, see

Security Settings in NAl systems.

DDMS Settings

The Device Discovery and Mobility Senice (DDMS) is a senice that monitors the presence of ARS capable radio
units and reports their parameters (IP address, Radio ID, etc.) to interested applications, such as SmartPTT
Radioserver and MNIS.

To set up DDMS settings, click DDMS Settings.

----- % Control Stations DDMS Settings
g Connect Plus

Ij—jg MAl Systems Active

Elh MAI - IP Site Connect 1
- 1 Slat 1 Server Address  localhost: 3000

o Talkgroups
- % Security Settings
= "!" Slot 2

t-af Talkgroups

LB Security Settings
----- - 4 DDOMS Settings
----- &, MNIS Data Gateway
ey Capacity Max Networks
g SIP/RTP Interfaces
----- F9 SmartPTT Radioservers
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Server Address: IP address of the PC with the MOTOTRBO DDMS Administrative Client application installed on it,
and port number of the DDMS server. The port number in this field must match the port number in the PortWatcher

field of the MOTOTRBO DDMS Administrative Client (Interfaces > Watcher Settings).

- o “
£ MOTOTREQ DDMS E.L
DDMS File  Action Help
Server Address Iocalhost

6|00 [¢]a HE v

Service E Watcher Setti
Interfaces I PortWatcher 3000 |
!E ARS Settings Watcher O 14400

N Viecher Scincs | [ RSHS 0

MNIS Data Gateway

To configure data transport over NAI network, set up MNIS Data Gateway settings.

..... % Control Stations MHIS Data Gateway
iy Connect Plus
£-tag NAI Systems Socket Type (acrlSockt 2
=g NAI- 1P Ste Connect 1 Inteface 192.168.37.85 -|
=y Slat 1
- Talkgroups MNIS Cortrol Interface loopback:55000
------ 4% Securty Settings -
£Y Sot2 MMNIS ID 1 :
= Talkgroups Location Part 4001 z
LR Secunty Settings
..... & DDMS Settings TMS Part 4007 <
----- - § MNIS Data Gateway 4008 a
g Capacity Max Networks Telemetry Port :
iy SIP/RTF Interfaces
----- FN SmatPTT Radioservers

o Socket Type: Defines the software interface type to activate the connection:

o Local Socket: Select if the MOTOTRBO Network Interface Senvice senice is running on the same computer
as the SmartPTT Radioserver.

o Remote Socket: Select if the MOTOTRBO Network Interface Senice senice and SmartPTT Radioserver are
installed on different computers. In this case, data exchange is provided by the MNIS Data Gateway Relay
program.

e Interface: Select the proper variant of the local IP-address of the computer where MOTOTRBO Network

Interface Senvice is running. It should match the interface in the Tunnel IP Address field of MOTOTRBO Network

Interface Senice Configuration Utility.
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e MNIS Control Interface: Type the information in the form of </P-address:port>:

o IP address: Type localhost, if MOTOTRBO Network Interface Senvice is running on the same computer as

the SmartPTT Radiosener. If MOTOTRBO Network Interface Service and the radioserver are installed on

different computers, enter the IP address of the computer where MOTOTRBO Network Interface Seniice is

installed.

o Port: Type the same value as in the MNIS Control Interface TCP Port of MOTOTRBO Network Interface

Senice Configuration Utility:

MOTOTRBO Network Interface Service Configuration Utility

Configuration  Wiew  Edit

1]

Service  Help

L H O O @

=oae N

------- General

....... ’ﬁ Security

- {8 Group List

#- {88 Conventional

------ e& Capacity Pluz

- <@ Linked Capacity Plus

[y |

------- = Forwarding Rules
(- Application Owemide Aules

SmartPTT PLUS 9.1
Radioserver Configurator User Guide

ARS Monitor D | Flone
Device Discovery and Mohility Service

Server Address | 127.0.01 |
Watcher Port 3000 -
MNIS Control Interface

FMIS Control Interface TCP Port

I | »
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e MNIS ID: The Common Air Interface (CAl) ID of the MNIS in the radio network. The ID is used by other calling
radios when addressing MOTOTRBO Network Interface Service. Make sure MNIS ID matches the MNIS
Application ID field in the General chapter of MOTOTRBO Network Interface Senice Configuration Utility. It is

also recommended that MNIS ID should match Radio ID in the radioserver slot settings.

MHNIS Data Gateway MOTOTRBO Network Interface Service Configuration Utility
Socket Type [Local Socket - Configuration  View Edit Service Help
|Interface [192.168.102 -]ll \j l | I o @
MHNIS Control Interface loopback: 5000 !
|MN\SID 1 B |2 = @ Unitled .
Location P 4001 z - [ Genera
atil rt
cation Fo H @ Securiy System Operation Mode
Y Ny jonal v
TMS Port 4007 lzl {8 Group List
Telemetry Port 4008 EI &4 Convertional MNIS Application ID |1 EI I 2
e& Capacity Plus

+ ;% Linked Capacity Plus
B @8 Advanced

m

MNIS P Address 132168101

| Tunel P Address 192183102 | 1
el IF Address

e Location Port: The port where the radioserver will expect GPS data.

o TMS Port: The port where the radioserver will expect text messages.

o Telemetry Port: The port where the radioserver will expect telemetry data.
The ports should match the ports set in the TMS UDP PORT, Telemetry UDP Port and Location Server UDP
Port fields in MOTOTRBO Network Interface Senice Configuration Utility (Advanced > Network).

MNIS Data Gateway MOTOTRBO Network Interface Service Configuration Utilit
Socket Type [J ocal Socket ;
Interface [192168.10.2
MHNIS Control Interface loopback: 5000
MNIS ID L
Location Port 4001 =] [ I A @ Security CAlMetwork. |12 3 ;
ITMS Port 4007 5‘ | 2 - @8 Group List _ 12
[retemetry Por la00e B 3 @ @ Conventional el roup etk
: - Capacity Plus o
6 Lnkad Capaciy P - e
B @ Advanced ;
. ARS UDP Port 4005 =
B Netwark o
[Ep Forwarding Rules 2 | TMS UDF Part |4DU? ;”
o Application Override Rules
3 |Te\emetry UDPPorl [4008 3
— ]
1 | Location Server LIDF Port |4DD1 :" :
)
< 0 ] ]
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Remote Socket is used when you want to connect more than one network such as Capacity Plus or Linked
Capacity Plus to SmartPTT Radioserver. To ensure proper functioning of all connected networks (wice and/or data
transmission), each network requires separate MNIS and DDMS senvices set up and running. At the same time,
multiple MNIS and DDMS can't be installed on one PC. To work around this problem, you should install and
configure MOTOTRBO Network Interface Senice Configuration Utility, MOTOTRBO DDMS Administrative Client and
MNIS Data Gateway Relay applications on multiple PCs. The number of PCs depends on the number of networks
(Capacity Plus or Linked Capacity Plus) connected to SmartPTT Radioserver. Thus, the transmission of wice data
from repeaters to SmartPTT Radioserver is carried out directly, and data transfer — via PC with MNIS Relay and the

MNIS and DDMS senice applications.

‘ ‘ e ]| s | g ‘ i
MNIS Relay ' DDMSs
‘ ‘ \\ ~ IP-network MNIS “E[BVY ‘
‘ Repeater ‘
~
i i

SmartPTT
Radio Server

Y

SmartPTT )
Dispatcher Capacity Pius 2

data packet transmission
o ity Plus 1 over IP network

logical transmission of
voice

¢ » legical transmission of
da%a

To configure this type of connection:
1. Install and run MNIS Data Gateway Relay on the computer where MOTOTRBO Network Interface Seniice is
running.

2. Run the MNIS Data Gateway Relay Configurator.

’
@ MMIS Data Gateway Settings = | =

MMIS Data Gateway |

MNIS interface:  [192.0.22 -|

Server interface: [ 152022
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3. In the MNIS interface field enter the same address as it is in the Tunnel IP Address of MOTOTRBO Network

]

In the Server interface field enter the same address as you did in the previous step.

Interface Senvice Configuration Utility.

&

In the Port type the available port of the computer.
Sawve changes and restart MNIS Data Gateway Relay.
In SmartPTT Radioserver Configurator double-click your network and click MNIS Data Gateway.

In the Socket Type field select Remote Socket.

© © N o O

In the MNIS Control Interface field type IP address of the computer where MOTOTRBO Network Interface
Senvice senvice is running and the port from the MNIS Control Interface TCP Port field of MOTOTRBO
Network Interface Service Configuration Utility.

10. In the MNIS Relay Address field type IP address of the computer where MNIS Data Gateway Relay senice is

running and the port from the Port field of MNIS Data Gateway Relay Configurator.

MHIS Data Gateway

Socket Type Remote Socket v]

MMIS Cortrol Interface 203.0.113.1:55000

MHMIS Relay Address 203.0.113.1:8850

MNIS ID 1 = MNIS Control Interface TCP Port
- (MMNIS Configuration Utility)

Location Port 4001 =

TMS Port 4007 =
- Server port

Telemetry Port 4008 = (MNIS Data Gateway Relay)

11. Configure other settings as describer previously.
12. Save changes and restart radioserver.

You should repeat this for every MOTOTRBO Network Interface Senvice data gateway you are installing.

MNIS and DDMS service settings

The following section describes MNIS senice settings in MOTOTRBO Network Interface Senice Configuration Utility
and DDMS senvice settings in MOTOTRBO DDMS Administrative Client, which are necessary for proper data
transmission over network.

You should configure the following settings in the MOTOTRBO Network Interface Senice Configuration Utility

application:
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1. In the System Operation Mode field of the General section, select a mode depending on the network
type selected in SmartPTT Radioserver Configurator. If NAI - IP Site Connect is used, select Conventional.

Other modes correspond to the NAI - Capacity Plus and NAI - Linked Capacity Plus networks.

= 4 12
@ Secun
L ity System Operation Maode [Cunvmtiunal T]
= &8 Group List
S ERTY MNIS Application 1D |1 =

2. In the Security section set the encryption keys that match the keys specified in the radio MOTOTRBO

CPS settings.

= DP 3601
General Seftings.
Basic Privacy Key € Accessories Too  Privacy
i Buttons
R g o
Conventional Telemetry
&9 Capacty Flus T menu
£# Linked Capacity Plus = Securty Frivacy Type  |Basic =
i Aiss KeyID  KeyValue
B8 pavenod Enhanced ey i o | i Netuore
- 2 Network =5} Signaling Systems
- B Forwarding Fules Enhanced Key2 z B | m Contacts Add Delete
) [ @8 RX Group Lists
[l B8 Channels | Key 1D Key tias Key Vaiue
- § Scan 1 Privacy Keyl 1234567890
B Roam 3 2 Privacy Key2 0987654321

3. Set up the following parameters in the Conventional/Capacity Plus/Linked Capacity Plus sections
respectively:

e |P address and UDP port of the Master repeater in the Master IP Address and the Master IP Port
fields. These values should match the values in the corresponding fields in the Master repeater
MOTOTRBO CPS settings and in the network settings of SmartPTT Radioserver Configurator.

o Authentication key, if it is set in the repeater MOTOTRBO CPS settings.

e Privacy settings that match repeater encryption settings in MOTOTRBO CPS.

= 12 E-film DR 3000
8 General General Settings Network

- @ Securty Master 1P Address 192180712 ; Q accessones Top  RadioNetwork LinkEstablishment |PSite Connect — Capacity Plus
& Group List 1 i@ Securty
@ Conventional Master UDP Port . Link Establishment
P = Domain 1 el sites
i Talkgroups Link Type [ master o
MNISLEpot @ Automatically Assigned - Channels
© Mol Acsigned | Authentatn Ky |“5 |2

E Domain 5

i >H Domain
[ TR Dorent Atrertcaonkey [ 5 MasteriP [ 152 168 7w L
E-:=,§ Domain & Master UDP Port [50000 3;
re. Capacity Plus
£ Linked Capacity Plus i1 DR 2000 -
Security
Advanced i
(=] Enable General Setiings
o @ Accessories Top  Privacy
Revert Channel 7] - e [N
o Networc Privac
Pz saes 3 e v
gl Talkgroups -
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4. It is recommended to clear the Data Call Confirmed field in the Advanced section and to specify the

identifier in the MNIS LE ID field explicitly.

= @ 12
- General
o @ Group List Data Call Confimed [
- 3B List1 Compressed UDP Data Header ]
& {88 Conventional Battery Saver Preamble
c.&. Capacty Flus Individual Data to Reqistered Site
[ o & Linked Capac:t'_.' Flus
= i TX Preamble Duration (ms) (120 2
- _EEE Metworlk
[ Forwarding Rules Conventional Channel Access | amal
Application Cven
MNISLEID = yse MNIS ID
@ Manually Assigned 5195 =

DDMS operation is closely connected to MNIS for data exchange (MNIS serves as DDMS Watcher). DDMS filteres

the registration senice packets (ARS), received by the repeater, and information on the radio presence in the

network is sent to all systems for further processing. Therefore, when you configure DDMS settings, make sure that:
a) The PortWatcher field in MOTOTRBO DDMS Administrative Client matches the WatcherPort field in

MOTOTRBO Network Interface Sernvice Configuration Utility settings (Advanced > Network).

Configuration  View Edit Service Help File  Action Help
\j ° @ 00 0 [&]% HE %
l L'_J % Service E]_Watcher Settings
- e o e [ =-K¥ Interfaces PortWatcher 3000
o @ Untiled - » 4 ARS Settings Waicher 10 12200
- 8 Ganerl AFS Martor | ST || tebGow o
) Loggi Notiy Rty 5
- @ Security ARS Moritor 1D & Logging iy Rate
& & Group Lit
@ {8 Conventional PortWatcher
- {4 Capachy Plus ;;: 3:81”6'&% for Waicher Subscribe requests
B {4 Linked Capacty Plus Server Address  127.0.01
=3 ﬁ Advanced Settings for Watcher interface B |
P o Welcher o
" [ Forwarding Rules

b) The PORT SU field (Interfaces > ARS Settings) in MOTOTRBO DDMS Administrative Client matches the
ARS UDP Port field in MOTOTRBO Network Interface Senice Configuration Utility (Advanced >

Networks).
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ﬂMDTOTRBDNEhmrk nterface Service Configuration UHility

Configuration  View  Edit  Service Help I File  Action Help

\j H o @ [C]® O [@]a& H@ %
l : i Service El_ARS Seftings
- s
© @ Urttled = Y s setings | PESTeWeaE of

General B Watcher Settings DeviceRefreshTime 240
L @ Secuity CAlNetwork  [12 2] [ Logging DeregistrationTO 120
: Fersistence TO 12000

& Group List

& Converional CAI Group Network PortSU
4% Capaciy Plus Port listening for inbound ARS messagss
[ Range: 1000 - 65535
£# Linked Capacity Plus
= @8 Advanced Settings for ARS/SU interface
ARSUDP Port [4005 2
# [ -
= Forwarding Fule| THS UDP ot

Application Ovey

Capacity Max

Capacity Max is a trunking MOTOTRBO system that supports the European Telecommunications Standards
Institute (ETSI) Digital Mobile Radio (DMR) Tier Ill operation.

Capacity Max system represents the enhancement of the Linked Capacity Plus functionality. It can include up to 15
sites and up to 15 trunked repeaters with up to 3,000 users per site. One slot on each site is allocated as a control
channel. Capacity Max also supports data revert repeaters: up to 6 per site and 12 time channels per site.

Capacity Max system supports connection via control stations. The parameters of the control station correspond to
the parameters of an ordinary MOTOTRBO control station.

Capacity Max systems offer the following advantages:

e The simple and efficient system architecture that utilizes standard Internet protocol (IP) network with a centralized

Capacity Max System Server (CMSS).
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OQ BNIS DAt IP Network

Gateway

SmartPTT ESX Server
Radioserver Capacity Max System Server

NISVRC| | Trunking
Gateway | | Controlier

IP Network

SmartPTT SmartPTT SmartPTT
Dispatcher Dispatcher Dispatcher
Console Console Console

CMSS represents the VMware Sphere version 5.5 ESX server and includes the following virtual resources:
o Trunking Controller based on the Red Hat Linux,
o MNIS VRC gateway, and
o Radio Management application that is used instead of MOTOTRBO Customer Programming Software (CPS)
to configure the system.
The system architecture also includes the MNIS Data gatewaty, which is installed separately.
e High security. All wice, data and control traffic within the IP network is encrypted, and all radios are securely
authenticated.
e High level of reliability and resilience. The system can include an optional redundant server in addition to the main
server and up to three alternate control channels per site.
Capacity Max is compatible with all MOTOTRBO repeaters, except DR3000 series with the 8MB RAM, and all
MOTOTRBO 4000 series portable and/or mobile radio stations.
To configure the Capacity Max system in SmartPTT Radioserver Configurator, you will need to use the following
applications:
e Radio Management application—to get the settings of the preconfigured virtual resources, and
o MOTOTRBO Network Interface Senice Configuration Utility—to set up the MNIS Data gateway.

Capacity Max configuration in SmartPTT Radioserver Configurator includes the following steps:

1. Adding new network and its basic configuration.
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Setting up the trunking controller.

o > w0 b

Setting up the security settings.

How to Configure Capacity Max

To add a new Capacity Max system, right-click Capacity Max Networks in the Networks tab of SmartPTT

Radioserver Configurator and click Add.

Setting up MNIS Data gateway settings for data transfer.

Setting up the MNIS VRC gateway and the talkgroups.

At that, Capacity Max System configuration menu appears on the right.

.. Control Stations
g Cornect Plus

H MNAI Systems
[—]H Capacity Max Metworks

(=W 1 Capacity Max 1
:.ma Trunking Controller

! MNIS Data Gateway

E‘h MHNIS VRC Gateways
g MNIS VRC Gateway 1

Talkgroups

L. Securty Settings

-y SIP/RTP Interfaces

- SmartPTT Radioservers

Name: Name of the created system.

Network ID: Unique ID of the network. The network ID must not match any ID of other SmartPTT Radioserver

networks.
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Capacity Max System

Active

MName: Capacity Max 1

Networl [D: 1

Radio ID: 1

Interface: [P«m -

Presence information
Data transmission
Voice transmission
[ Allow transmit intemupt

[T Prioritize calls during emengency
Channel Grant Watting timer (s): 15

TX time-out timer (s): (1]

R L

GP5S transmission mode: [Data




Radio ID: The identifier of the radioserver. This is the identifier radio subscribers will see at receiving private calls
and text messages from the dispatcher. If there are several dispatchers, you can create a profile for each operator

(Profiles) and define a unique identifier for each operator. Radio ID set in this window must correspond to the value

set in the Device ID field for the preconfigured radioserver device in the Radio Management application (see the

Capacity Max Systems settings, sorted by the Subscriber Access Control value).

E Radio Managerment EI

L

Capacity Max System Server Data » Subscriber Access..,

Capacity Max Systems ) — ) — . L
Wiew by: |®] Subscriber Access Contral || Talkgroup Site Association

OurSystem1 r y

OurSysteml | ? |

CurSysteml

OurSysteml Device Type = | Serial Number = Physical Serial Numb Device ID En
Console a a 605
Console a a 604
Console a a 600
Console a a 603
Console a J 601
Console a a 602
Data Gateway a J 300
Motorola Radio  B7ITNVISZS TEI408B45C 768584329 102 o

{ I 4

9 items found (0 currently selected).

Analyze Results| [Tasks|
Connected ToiLOCALHOST

Note: To open the Capacity Max System settings in the Radio Management application, click Actions > Manage

> Capacity Max System Server Data or press the Ctrl+Shift+G together.

Interface: The IP address of the PC where SmartPTT Radioserver is installed.

Presence information: Select this check box to enable connection with Trunking Controller.
Data transmission: Select this check box to work with MNIS Data Gateway.

Voice transmission: Select this check box to enable MNIS VRC Gateway.

Allow transmit interrupt: Select this check box if you need the ability to interrupt a radio subscriber.
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Prioritize calls during emergency: Sets a priority of the dispatcher call during the Emergency Call. If the check
box is selected, the dispatcher call has the highest priority during the Emergency Call in relation to other calls and
interrupts them in case of lack of resources.

Channel Grant Waiting timer (s): Time period in seconds during which the caller expects a response from the
called party (the FOACSU strategy). It is recommended to use the default value of 15 seconds that is set in the
Radio Management application (see the Capacity Max Systems:... settings in the Capacity Max Features menu

of the Primary_CMSS_config configuration, the Channel Grant Waiting timer field in the Timers tab).

E Radio Management EI

G ]O

Configuration View ® Primary CM55 config » Capacity Max Systems » OurSysteml

Set Categories q
Save As Close
g E Configuration: Primary_CMS55_config
v U Capacity Max Features General  Authentication  Timers  Capacity Max Sites  Adjacent Sites  Site Announcement
[ @ Capacity Max Systems: CapacityMaxSystems
@ Capacity Max Site Selection: CapacityMaxSy= ~ Timers =

(7] €MSS Network: Networik-1

Channel Grant Waiting timer (sec) | 15 I
» Il MNIS

Response Waiting timer (sec) | 20

Group Call Hang Time (sec) | 3 I

Private Call Hang Time (sec) | 4

Emergency Call Hang Time (sec) | 4

Inter-Repeater Messaging Delay | MNormal

Inactivity Check Timer (hour) | 0.5

T Amaeihs R o Cidae
1 —— L
4

Analyze Results| |Tasks| |Validation Results Waming UL Ei M Search Results |Help

Connected To:LOCALHOST Radio Count:1

»

Note: To open the Capacity Max Features of the Primary_CMSS_config configuration in the Radio Management
application, click Actions > Manage > Configurations or press Alt+C together. In the table that opened, select
the Primary_CMSS_config item and click Edit. In the Set Categories tab that opened, click Configuration:
Primary_CMSS_config > Capacity Max Features.

FOACSU (Full Off Air Call Set Up) stands for the strategy of assigning the traffic channel only when the called party

user has specifically answered the call. During the timeout the traffic channel is not allocated for the call.
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For correct work of the FOACSU private calls, make sure that it is configured in the Radio Management application

(see the Capacity Max Systems:... settings in the Capacity Max Features menu of the Primary_CMSS_config

configuration, the Individual Voice Call Type field in the General tab).

Radio Management

]O

Configuration View » Primary_CMS55_config » Capacity Max Systems » OurSysteml

Set Categories 1
Save As
- E Configuration: Primary_CMSS_config

Close

v i Capacity Max Features General  Authentication  Timers  Capacity Max Sites  Adjacent Sites  Site Announcement
[ @ Capacity Max Sy CapacityMaxSy
@ Capacity Max Site Selection: CapacityMaxSys ~ General i
{] EMSS Network: Network-1 - —
System MName | OurSystem
» [l MNIS —
System Type | Capacity M
MNetwork Model | Large
MNetworkID |1
| individual Voice Call Type | FoACSU |
Call Queve Enable [
Max Infrastructure Voice Interrupt Attempts | 3
Max Preemption Interrupt Attempts | 6 5
1 I ——————— 4
4 >
Analyze Results| |Tasks| |Validation Results Waming [NEEER Tl Search Results |Help
Connected To:LOCALHOST Radio Count:1
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TX time-out timer (s): Time period during which the radio can transmit without interruptions. After this time is over,
the transmission is interrupted. It is recommended to use the default value of 60 seconds, which is set in the Radio
Management application (see the MNIS System settings in the MNIS menu of the Primary_CMSS_config

configuration, the Transmission TOT field in the General tab).

ERadin Managerment EI

E©

Configuration View ® Primary_CM3S_config » MNIS System » MNISSystem-1

Set Categories 1

hd E Configuration: Primary_CMSS_config
» Il Capacity Max Features
v T MNIS
[ (] mnIS System: WiNISSystem-1 4t |
G MNIS Network: MNISMetwork-1

Close

General

Set Name | MNISSystem-1 | =
Last Modified Date  03/D1/2016 14:16:43

Comments | ‘

~ (3eneral

VRC Gateway Enable [
MNIS Gateway UDP Port | 50000 |

Transmission TOT (sec) | 60

Active Vioica Talkpath Limit | 100 |

nulnm

4 »
Analyze Resuhx.| Tasks |Va|idaﬁon Results RUETTLL I RE=GT ) Search Results | Help
Connected To:LOCALHOST Radic Count:1

Note: To open the MNIS menu of the Primary_CMSS_config configuration in the Radio Management application,
click Actions > Manage > Configurations or press Alt+C together. In the table that opened, select the
Primary_CMSS_config item and click Edit. In the Set Categories tab that opened, click Configuration:
Primary_CMSS_config > MNIS.

GPS Transmission Mode: Allows you to select the way how to transmit location updates: as data packet in
multiple bursts or as a single CSBK (Control Signaling Block).

Each solution has its own advantages and disadvantages:

GPS Advantages Disadvantages

Transmission

Mode

Data e No need to configure additional settings for e Increased traffic load on a channel

receiving GPS data

CSBK e Low traffic load on a channel ¢ Not all radios support CSBK commands
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e Increased GPS transmission frequency

rate—once in 15 seconds

Enhanced CSBK| e Low traffic load on a channel ¢ Not all radios support CSBK commands
e Increased GPS transmission frequency

rate—once in 7.5 seconds

Trunking Controller

Trunking controller of the Capacity Max network provides the actual information about the network status (registered
subscribers).
To configure primary trunking controller:
1. Make sure that trunking controller is configured via the Radio Management program, in particular, you can
obtain IP address and port from the Presence Server IP field. For their configuration, please refer to the

Motorola Radio Management User Guide.

[ Radio Management =S

G JO

Configuration View » CMS5_config ® CMSS Network » CMSSNetwork-1*

Set Categories a
Save Discard Close
v E Configuration: CMS5_config

v Tl Capacity Max Features General

@ Capacity Max Systems: TVZCapacityMaxSystems-1

@ Capacity Max Site Selection: CMS5SiteSelection-1 Sat Mame | CMSSMetwork-1 |

[ (7 cMSS Network: CMsSNetwork-1* {3t | _
Last Modlified Date  07/21/2016 16:32:10

» Bl mNIS

Comments | |

~) General

CMsS TP |102.0.

CMSS UDP Port |5

Trumking Contraller IP

Presence Server P IQEEEI.LFWI_’J_

VRC Gateway IP
.. 202g

3. In your Capacity Max network select Presence information to make trunking controller settings available.

2. Add a new Capacity Max network or select the existing one.
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-
@] SmartPTT Server Configuration - C:\Program Files (x88)\SmartPTT\Server\RadioService.exe.config

Settings | Metworks |Clien’[ List | Fules Iﬂdlmty I Log I Export/Import Settings I Sta’r.isticsl

H Connect Plus

g MAl Systems
[—jﬂ Capacity Max Networls

Elh- Capacity Max 1
Trunking Cortroller

----- B MNIS Data Gateway
h- MNIS VRC Gateways
i Talkgroups

% Security Settings
-y SIP/RTF Interfaces

----- F9 SmartPTT Radioservers

Capacity Max System

Active

Mame: Capacity Max 1

Metworl 1D 1

Radio 1D: 1

Interface: Any -

( Presence information

Data transmission

Voice transmission

4. Select the Trunking Controller menu and replace the default text “remotehost:50015” in the Primary

controller (IP address:Port) field with IP address and port of the Presence Server from Radio Management.

-
@] SmartPTT Server Configuration - C:\Program Files (x88)\SmartPTT\Server\RadioService.exe.config

m@g

Seftings | Metworks |Cliant List | Fules Iﬁdmty I Log I Export/Import Settings I Statisticsl

ﬂ Connect Plus
g MAl Systems
[-]ﬂ Capacity Max MNetwors
Elh- Capacity Max 1
R king Corirller

B MNIS Data Gateway
h- MNIS VRC Gateways

: Talkgroups

2% Security Settings
ﬂ SIP/RTP Interfaces
----- B9 SmartPTT Radioservers

Trunking Controller

Primary cortroller {IF Address:Fort) remotehost:50015

Redundant cortrallers

/7 IP Address:Por

| Mame

Replace with the IP address and
port of the Presence Server

Capacity Max supports up to four redundant trunking controllers to keep the subscribers online when the primary

controller goes offline. The order of redundancy is defined by the settings in Radio Management.

To configure additional trunking controllers:

1. Make sure that redundant trunking controllers are configured in Radio Management.
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Radio Management

1O

Configuration View » CMSS_config » Capacity Max Systems  TVZSysteml*

Set Categories 1
~ & Configuration: CMSS_config

v W Capacity Max Features
Capacity Max Systems: TVZCapacityMaxSystems-1*
pacity % pac %

General  Authentication

Save Save As

Timers  Capacity Max Sites  Adjacent Sites  Site Announcement

Discard

[ESS(ECE B3

Close

8] Capacity Max Site Selection: CMSSSiteSelection-1 Primary Trunking Controller P | 132,021
] CMSS Netwark: CMSSNetwork-1 i o
Primary Trunking Contraller UDP Port | 50000 [
> [l VNS

Call Monitor Apglication LIP | 182025 |
Call Monitor Application 1 UDP Port | 51112 | g
Call Monitor Application 21P 0,000 |
Call Monitor Application 2 UDP Port | 51112 |
Call Monitor Apglication 3P| 0.0.00 |
| Monitor Application 3 UDP Port | 51112 | g

Voice Interrupt Support

Telephone Support

192021
192.0.2.1
192.0.2.1

2. In your Capacity Max network select Trunking controller.

3. Click Add in the Redundant controllers area. A new controller will appear in the table.

m@g

~
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

Settings | Metworks |Clien’[ List | Fules Iﬂdlmty I Log I Export/Import Settings I Sta’r.istics|

Trunking Controller
g Connect Plus

ﬂ MAl Systems
[—]—-H Capacity Max Metworks
Elh- Capacity Max 1

h- Trunking Contraller

B MNIS Data Gateway

Primary cortroller (IP Address:Port) 132.0.2.1:50015

Redundant controllers

Add Remave i Up

Talkaroups | Name N IP Address:Port

4t Securty Seftings
g SIP/RTF Interfaces
----- F9 SmartPTT Radioservers

# Dowr

Click to add a new redundant
controller

4. Change the redundant controller IP address and port according to the settings in Radio Management. Rename

the controller if needed. You should name controllers differently.
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’
ﬁ SmartPTT Server Configuraticn - C\Program Files (x86)\SmartPTT\Server\RadicService.exe.config E@g

Settings | Metworks |Client List | Fules I.Adlwty I Log I Export/Import Settings I Sta'r.isticsl

Trunking Controller

g Connect Plus
g MAl Systems
E-dg Capacity Max Networks Primary controller (P Address:Port) 192.0.2.1:50015
E‘h‘ Capacty Max 1 Redundant controllers

=1 Trunking Contraller [ oy ” = ] & o # Down

g8 MNIS Data Gateway

g MNIS VRC Gateways Name IP Address:Por
Talkgroups
% Security Settings Redundant controller 1 remotehost: 50015
H SIP/RTF Interffaces
----- F9 SmartPTT Radioservers Change IP address and port to the
pre-configured ones in the Radio
Management program

5. Add more redundant controllers if needed. Change their IP addresses and ports according to the settings in
Radio Management.

Note: If ports of some controllers will be the same you will see an exclamation marks near them (##). You cannot
switch to another menu until you would change the ports.
You can change the order of the redundant controllers in the table. This helps to assign a new active controller in
case when others disconnect from each other.
To change the order of the controllers in the table:

1. Select the redundant controller.

2. Click Up or Down to mowe the redundant controller up and down.
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’
@ SmartPTT Server Configuraticn - C\Program Files (x86)\SmartPTT\Server\RadicService.exe.config

e

Settings | Networks | Client List | Rules | Activity | Log | Export/import Settings | Statistics [

Click to move the redundant

----- L Control Stations

Connect Plus

MAl Systems
=- Capacity Max Metworks
=g Capacity Max 1
; hr Trunking Contraller
. MNIS Data Gateway
MMNIS VRC Gateways
Talkgroups
% Securty Settings
H SIP/RTP Interfaces
----- B9 SmartPTT Radioservers

Trunking Controller

Primary controller (IP Address:Port)

Redundant cortrollers

controller up or down

i
192112150% \/

[ Add ” Remaove ] " Up [ + Down
Mame IP Address:Port
Redundant controller 1 192.0.2.1:50016

Redundant controller 2

Redundant controller 3

192.0.2.1:50017
152.0.2.1:50018

To delete a redundant trunking controller from the table:

1. In your Capacity Max Network select Trunking Controller.

2. Select the redundant controller.

3. Click Remove in the Redundant controllers area.

-
'@ SmartPTT Server Configuraticn - C\Program Files (x86)\SmartPTT\Server\RadicService.exe.config

ol

Settings | Networks | Client List | Rules | Activity | Log | Bxport/import Settings | Statistics |

..... 2. Control Stations
Connect Plus
NAI Systems
=" Capacity Max Metworks
Elh Capacity Max 1
R king Corroler

& MNIS Data Gateway
i MMIS VRC Gateways
Talkgroups

L5k Security Settings
H SIP/RTF Intefaces
----- FN SmartPTT Radioservers

SmartPTT PLUS 9.1
Radioserver Configurator User Guide

Trunking Controller
Primary cortroller (IP Address:Port) 192.0.2.1:50015
Redundant controllers
[ Add ] ’ Remaove ] & Up l [ # Down
kY
Mame \\ IP Address:Part
Redundant controller 1 152.0.2.1:50016
Redundant controller 2 192.0.2.1:50017

Redundant controller 3

Click to remove the selected
controller from the table
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MNIS Data Gateway

To set up data transfer over Capacity Max network, set up MNIS Data Gateway settings in SmartPTT Radioserver
Configurator and in the MOTOTRBO Network Interface Senice Configuration Utility.

To set up MNIS Data Gateway settings in SmartPTT Radioserver, click Capacity Max Networks > Capacity Max
> MNIS Data Gateway.

..... % Control Stations MHIS Data Gateway
-y Connect Plus
g NAI Systems Socket Type [Loca Soce g
[_]H Capacity Max Networks Interface [192 168.37.85 "l
Elh Capacity Max 1 —
h Trunking Cortroller MHIS Cortral Interface loopback 55000
2 4 MNIS Data Gateway -
. fag MNIS VRC Gateways MNIS ID ! =
b Talkgroups Location Part 4001 -
Lok Securty Settings
fag SIP/RTP Intefaces TMS Port 4007 >
----- P SmatPTT Radioservers
= Telemetry Port 4008 =
Redundant MMIS data gateway
Socket Type Remote Socket ~
MMNIS Cantrol Interface (IP Address:Port) remotehost:55000
MMIS Relay Address (IP Address:Port) rematehost: 3830
Location Port 40m v
TMS Port 4017 -
Telemetry Part 4018 :

Note: The Data transmission check box in the Capacity Max window should be selected. Otherwise, the MNIS

Data Gateway parameter will not be shown.

Socket Type: Defines the software interface type to enable communication between processes. Select the Local
Socket value if the MOTOTRBO Network Interface Senice Configuration Utility is installed on the same PC as
SmartPTT Radioserver. Select Remote Socket if MOTOTRBO Network Interface Senice Configuration Utility and
SmartPTT Radioserver are installed on a different PCs. In this case, information exchange between the processes is

supported by the MNIS Data Gateway Relay program.
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Interface: MOTOTRBO Network Interface Senvice interface. It should match the interface specified in the “Radio
Management” program (see the MNIS System settings in the MNIS menu of the DataMNIS_Config configuration,

the Gateway Tunnel IP field in the Tunnel Network tab).

Radio Management EIE

G ]O

Configuration View » DataMMIS_Config » MNIS Systern » MNISSystem-2

Set Categories 1

v E Configuration: DataMNIS_Cenfig

- Cl
» [l Capacity Max Features ose

v T MRS General  Tunnel Network
D MNIS Security: MNISSecurity-2
| (] MINIS System: MNISSystem-2 £ | Enhanced Data Enabled [ ] A
7] MNIS Advanced: MNISAdvanced-2 Active Voice Talkpath Limit | 0
D MNIS Metwork: MNISNetwork-2 Data Gateway Queue Size |25 s

D MNIS Forwarding Rules: MMISForwardingR -
TX Privacy Type | Maone -

D MNIS Application Cverride Rules: MNISApg
{7] MNIS Sites: MNISSitesList-2 TX Privacy Alias  None

~ ) Tunnel Network

Gateway P 192168101

| Gateway TuaneliP - 19216810.2 |

4 »
Analyze Resuhs| |Tasl(5| |Validation Results RUETHTLBESESEL IS ikl Search Results | Help
Connected ToLOCALHOST Radio Countl
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MNIS Control Interface: Use localhost, if MOTOTRBO Network Interface Senvice Configuration Utility is installed on
the same PC as the radiosener. If MOTOTRBO Network Interface Senice Configuration Utility and the radioserver
are installed on different PCs, enter the IP address of the PC where MOTOTRBO Network Interface Senice
Configuration Utility is installed. The port should match the port number specified in the Radio Management
application (see the MNIS Network settings in the MNIS menu of the DataMNIS_Config configuration, the Control

Interface TCP Port field in the General tab).

Radio Management

G ]O

Configuration View » DataMMIS_Config ® MNIS Network * MNISNetwork-2*

Set Categories n
Save Discard
A '@' Configuration: DataMNI5_Config
» Il Capacity Max Features Close
v T MNIS General
[l MMIS Security: MNISSecurity-2
(7] MMIS System: MNISSystemn-2 Telemetry UDP Port | 4008 | & -
[| MMIS Advanced: MNISAdvanced-2 Location Server UDD Port |4U'Dl | g
[ (7] MNIS Network: MNISNetwork-2* ¢ | —
User Defined UDP Port 1 |0 - Disabled | &5
[l MMIS Forwarding Rules: MNISForwardingR —
o ) User Defined UDP Port 2 |0 - Disabled |
[| MMIS Application Override Rules: MNISApg e ——— —
] MNIS Sites: MNISSitesList-2 User Defined UDP Port 3 |0 - Disabled | g3

XCMP High Efficiency Data Enable [ |
XNCMP Server UDP Port 4004

Battery Management UDP Port |40'09 | g
Control Interface TCP Port | 55000 | 8 |
4 I— |
Analyze Resu|13| |Tasl:5 | |Va|idation Results RIETUTHLREER-T =i il Search Results |Help
Connected To:LOCALHOST Radio Count:1

Note: To open the MNIS menu of the DataMNIS_Config configuration in the Radio Management application, click
Actions > Manage > Configurations or press Alt+C together. In the table that opened, select the
DataMNIS_Config item and click Edit. In the Set Categories tab that opened, click Configuration:
DataMNIS_Config > MNIS.
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MNIS ID: The Common Air Interface (CAl) ID of the MNIS in the radio network. The ID is used by other calling radios
when addressing MOTOTRBO Network Interface Senice. Make sure MNIS ID matches the corresponding field in the
Radio Management application (see the MNIS System settings in the MNIS menu of the DataMNIS_Config

configuration, the Data Gateway Radio ID field in the General tab).

Radio Management

L

Configuration View » DataMNIS_Config » MNIS Systemn » MNISSystem-2*

Set Categories 1
Save Discard
v & Configuration: DataMMIS_Config

» [l Capacity Max Features

v Tl MNIS
ﬂ MNIS Security: MNISSecurity-2

[ (] MNIS System: MNISSystem-2* 43 |

{7] MNIS Advanced: MNISAdvanced-2
(7] MNIS Network: MNISNetwork-2
ﬂ MNIS Forwarding Rules: MNISForwardingR Comments ‘
Cl MNIS Application Override Rules: MNISApp

Close

General  Tunnel Network

Set Name | MNISSystem-2

Last Modliffed Date  03/01/2016 14:53:02

~) General

{7] MNIS Sites: MNISSitesList-2

|Data Gateway Radio 10 | 201 | ﬁ
MNIS Gateway UDP Port | 50000 | 8
Transmission TOT (sec) | 60 1 g
Enhanced Data Enabled || 2

4 > -

Analyze Results|  [Tasks|  |Validation Resuits [ i Lne e ig] Search Results | Help
Connected To:LOCALHOST Radio Count:1
Location Port: The port where the radioserver will [ Racis Management =l o=

expect GPS data. @ B -EEI

Configuration View » DataMNIS_Config * MNIS Network »* MNISNetwork-2

TMS Port: The port where the radioserver will i [
v & Configuration: DataMNIS_Config
» Ml Capacity Max Features
v T MNIS
[7] MNIS Security: MNISSecurity-2

Telemetry Port: The port where the radioserver will (] NI System: MNISSystem-2 * General E

ﬂ MNIS Advanced: MNISAdvanced-2

Close

expect text messages.

General

[T MINIS Network: MNISNetwork 2 8 | CaNework 2|
eXpeCt telemetry data. (7] MNIS Forwarding Rules: MNISForwardingR CAI Group Network | 225 |
(7] MNIS Application Override Rules: MNISApy TMS UDP Port | 4007 |
The ports should match the ports set in the (] s e Mhassestc2 Telemetry P port (4008 |
Location Server UDP Port | 4001 | 8
. . . ser Definer o - Disable: a
corresponding fields in the Radio Management Ve OsfreaU0FForts 0-Domies_| @
User Defined UDP Port 2 |0 - Disabled | &
T e N - | i~
application (see the MNIS Network settings in the ) i
analyze Resuits| [Tasks| [Validation Results [ e LUl e Search Resuts FHelp |
MNIS menu of the DataMNIS_Config configuration, | tretedTetocaros Redlo Courtt
the Location Server UDP Port field, the TMS UDP
Port field, the Telemetry UDP Port field in the General tab).
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To set up MNIS Data Gateway settings in MOTOTRBO Network Interface Service Configuration Utility, do the
following:
1. Sawe MNIS Data Gateway settings from the Radio Management application as GWCFGX file. For that, click
Radios, right click the DATA MNIS... item in the table that opened and click Export > GWCFGX... or press

Ctrl+Shift+N together. In the Export GWCFGX window that opened, specify the file name and click OK.

Radio Management
Radio View
Groups 1
_ Show Details. Edit Configuration... Analyze
EE0cn 3
Serial Number Radio Alias Configuration Group Modified Job Status
»  DATAMNISO! Fimim RARITE Plmm B£81T = I
S71TRREETS Shoclbetal sy CtEsy mmmomEm Completed R
478IRU1Z23 Beete el = momomom Completed R
478IRU1225 Select Group.. Ctrl+Alt+G == o= o= w Completed A
LISESI9PLXA = m momwm ompleted R
S7ITNV1525 Edit Configuration... Ctrl+F mmomomw Completed A
807TOH1Z1S Select Configuration... Allt+5hift+F = omom W (ompleted A
S71TRRE02 m EEmE = E Cympleted
Select IP System Settings...
478IRCO016 ) - = mmm . Completed
Schedule Job.. Cirl+J
Cancel Job Alt+Shift+]
Select MVO... Alt+Shift+V
Analyze Alt+5hift+5
Reports
{ ]
Upgrade Firmware...
G items found (1 . R
3 Radio... Ctrl+Shift+R
Analyze Results| | Tasks Grid to File... Ctrl+Shift+S
Connected ToL OCALHOST Ok B
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2. Transfer the saved GWCFGXfile to your PC where the MOTOTRBO Network Interface Service Configuration

Utility is installed, to the Config folder that is located on the local disk C:/ProgramData/Motorola/Wireline

Gateway.
=N ECR
@Ovl !, » Computer » Local Disk(C:) » ProgramData » Motorola » Wireline Gateway » Config - |¢f|| Search Pro... }3|
Organize « Include in library « Share with - Mew folder = » [ @
b it Name : Date modified Type Size
!
Bl Deskiop || CapacityMax.gwcfgx 08.02.2016 12:37 GWCFGX File 3KB
& Downloads = gw_default_tuningxml 28042014 17:11 XML Document 3 KB
| Recent Places =] gw_indexxml 14122015 16:47 XML Dacument 1KB
4 Libraries
@ Documents
J? Music
[ Pictures
B Videos
L Computer
&, Local Disk (C:)
Gh Metwork
l 6 items
181
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3. Launch MOTOTRBO Network Interface Senice Configuration Utility and click Configuration > Select Active
Configuration. In the Select Configuration window that opened, select the GWCFGX file saved before and

click OK.

(Y MOTOTRBO Nework Interface Service Configuration Utility | = & 3% |

Configuration  View  Edit  Service  Help

D% = (m B

Select Corfiguration

CapacityMax gwchox

If MOTOTRBO Network Interface Senice and the SmartPTT Radioserver are running on different computers, or you
configure several MNIS Data Gateways, perform the following actions:
1. Install and run MNIS Data Gateway Relay on the computer where MOTOTRBO Network Interface Senvice is
running.

2. Run the MNIS Data Gateway Relay Configurator.

-
@ MNIS Data Gateway Settings = | =

MNIS Data Gateway |

MNIS inteface: 192022 -|

Server interface: [192.D.2.2 v] Port: |8830 Iil

3. Inthe MNIS interface field enter the same address as it is in the Tunnel IP Address of MOTOTRBO Network
Interface Senice Configuration Utility.

4. Inthe Server interface field enter the same address as you did in the previous step.

5. In the Port type the available port of the computer.

6. Sawe changes and restart MNIS Data Gateway Relay.
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7. In SmartPTT Radioserver Configurator double-click your network and click MNIS Data Gateway.

8. In the Socket Type field select Remote Socket.

9. In the MNIS Control Interface field type IP address of the computer where MOTOTRBO Network Interface
Senvice senvice is running and the port from the MNIS Control Interface TCP Port field of MOTOTRBO
Network Interface Senvice Configuration Utility.

10. In the MNIS Relay Address field type IP address of the computer where MNIS Data Gateway Relay senice is

running and the port from the Port field of MNIS Data Gateway Relay Configurator.

MHIS Data Gateway

Socket Type Remote Socket v]
MNIS Control Interface 203.0.113.1:55000
MMNIS Relay Address 203.0.113.1:88590

MMIS 1D 1 MNIS Control Interface TCP Port
(MMNIS Configuration Utility)
Location Port 400 =
TMS Port 4007 =
- Server port
Telemetry Port 40038 o (MNIS Data Gateway Relay)

11. Configure other settings as describer previously.

12. Save changes and restart radioserver.

MNIS VRC Gateway

Every Capacity Max network supports up to 15 MNIS VRC gateways. The first gateway is created always exists in
the network, so you can add 14 gateways more.

The order of the gateways matters a lot. All newly created profiles and talkgroups for your Capacity Max network will
be assigned for the first MNIS VRC Gateway in the list. Therefore, you should be careful when configure several
MNIS VRC Gateways.

To configure MNIS VRC gateway:
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1. Make sure that VRC Gateway is configured in the “Radio Management” program. For more information please

refer to Radio Management User Guide.

Radio Management

e

Configuration View P Primary_CMSS_config » CMSS Network » Network-1

Set Categories [l

v & Configuration: Primary_CMSS_config

Radio Management.

o]0

[E=SE=R S5

==k

Configuration View » Primary_CMSS_config » MNIS Network » MNISNetwork-1*

~ [& Configuration: Primary_CMSS_config

Presence ServeriP

System Advisor 1P

>

<

Analyze Results| [Tasks| [Validation Results [ u LUt pt ] Search Results Help

VRC Gateway iP 17216113
CMSS Internal Network | 192.168.23L0

v ' Capacity Max Features Close v T Capacity Max Features
(i Capacity Max Systems: CapacityMaxSystem J— Capacity Max Systems: CapacityMaxSystem
(i Capacity Max Site Selection: CapacityMax5, Capacity Max Site Selection: CapacityMaxSy
(] CMSS Network: Network-1 43 ~) General a (] CMSS Network: Network-L1
» Il VNS — - T MNIS
CMSSIP (1721619
‘ (7] MINIS System: MNISSystem-1
fom 1 2
CMSS UDP Port | 50000 < (] MNIS Netweork: MNISNetwork-1* L3
Trunking Controller P 172.16.1.10:50000

17216.1,10:50015

17216114

»

<

| Connected To:LOCALHOST

Radio Count1 | [ Connected To:LOCALHOST

Set Categories 0

Save

Close.
General

SetName | MNISNetwork-1 ]

Last Modified Date  03/01/2016 11:57:45

Comments | |
~) General

Discard

ISENErTCP Port | 6000 a

(<[]

[Analyze Results| [Tesks|  [Validation Results (L RNERRPPRt Y Search Resutts Help

Radio Count:1

2. In your Capacity Max network select Voice Transmission to show and allow to configure

MNIS VRC Gateways.

’
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

:@g

Seftings | MNetworks |Client List I Rules I Activity | Log I Export/Import Settings I Statistics|

t_ Control Stations
H’ Connect Plus

H MAI Systems
[—jH’ Capacity Mz Networks

Elh Capacity Max 1
E Trunking Corttroller

B MMIS Data Gateway
h MMIS VRC Gateways

Talkgroups
t Securty Settings
-y SIP/RTP Interfaces
- B SmartPTT Radioservers

Capacity Max System
Active

Mame: Capacity Max 1

Metwork |D: 1

Radio 1D: 1

Interface: 152021 -

Presence information

Data transmission

Allow transmit intemupt
Prioritize calls during emergency
Channel Grant Waiting timer (s):

TH time-out timer (g):

GPS transmission mode: [Data

3. To add a new MNIS VRC Gateway right-click MNIS VRC Gateway and click Add.
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-
@] SmartPTT Server Configuration - C\Program Files (xB8)\SmartPT\Server\RadioService.exe.config E@g

Seftings | Metworks |Cliant List | Fules Iﬁdmty I Log I Export/Import Settings I Statisticsl

----- % Cortrol Stations MHIS VRC Gateways

g Connect Plus

g MAI Systems

[—jg Capacity Max Metworks
Elh Capacity Max 1

h- Trunking Contraller

.. MNIS Data Gateway

..
h Talkgroups ’_ Add
LG4 Security Settings
ﬂ SIP/RTP Interfaces
----- FN SmartPTT Radioservers

4. Select the newly created or existing gateway.

Note: By default, all new gateways obtain equal IP addresses and ports. When you select one of those, you will not

be able to leave the meny until you make its IP address and port unique within the site.

5. Configure the gateway options.

el -
""" < Control Stations MNIS VRC Gateway
H Connect Plus
H MAl Systems
-4y Capacity Max Networks Name MNIS VRC Gateway 1
E‘h‘ Capacity Max 1 Primary gateway address and port remotehost: 56000
h Trunking Controller Redundant gateway address and
i MNIS Data Gateway port
=i MNIS VRC Gateways _ 40000 -
h‘ MNIS VRC Gat 1 Yoice port (local) IZI
;alkg;toyugzﬂ. Recording of voice calls between radio subscrbers
L. ER ecL |r|g5
Bxample: 1-55, 150

g SIP/RTP Interfaces
----- F9 SmartPTT Radioservers

Radio |Ds for voice calls recording 116776415

Telephaone calls

Bxample: 1-55, 150
Radio |0s for phone calls 116776415
Talk paths (1)
@ Private (1) ) Group (0)
Active Mame D

ju—y

Default radio 1D

e Name: The name of the gateway in SmartPTT Radioserver Configurator. Rename your gateway if needed.
e Primary gateway address and port: IP address from VRC Gateway IP and port from Server TCP port

which were configured in your CMSS Network in Radio Management.

SmartPTT PLUS 9.1 185
Radioserver Configurator User Guide



¢ Redundant gateway address and port: IP address of VRC Gateway IP and port from Server TPC port of
the additional CMS server you assign to be redundant. You can leave this field empty if you do not have
redundant VRC gateway.

¢ Voice port (local): The port at which SmartPTT Radioserver will expect the wice data.

¢ Recording of voice calls between subscribers: Select this to activate wice recording feature, that allows
the dispatcher to hear private calls made from radio subscribers to other radio subscribers, dispatchers or
telephone subscribers.

o Radio IDs for voice call recording: Enter radio IDs for which the recording should be active. Follow
the example, to specify the IDs.

e Phone calls: Select this if you want to allow telephone calls for this gateway.

o Radio IDs for phone calls: Enter radio IDs for which phone calls should be available. Follow the
examples, to specify the IDs.

e Talk paths: You can reorganize the default gateway for radios and profiles here.

o Private: Select this to view the subscriber profiles which assigned to the current gateway. Profiles can
be assigned to the gateway (Active is selected), not assigned (Active is unselected) and unavailable
on it (Active is unselected, profile name is discolored). If the profile is unavailable, it means that it is
selected on the other gateway. By default all new profiles will be selected on the first gateway in the

list and their ID will be the same as that of the first gateway in the list.
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o Group: Select this to view talkgroups created for the current site. For more information see Talkgroups

in the Capacity Max chapter.

Talk paths (&)
i@ Private (2) i Group (3)

Active Name D
Default radio 1D, Profile 1, Profile 4 |1
Profile 2, Profile 5, Profile 9, Profil... |2
Profile 3, Profile &, Profile 7, Profil... |3

Talk paths (&)

() Private (2) @ Group (3)

Mame n]

Group 2 2
Group 3 3

SmartPTT PLUS 9.1 187
Radioserver Configurator User Guide



Talkgroups

To configure Capacity Max talkgroups, click Talkgroups. At that the following window opens.

..... .. Cortrol Stations Control Station Talkgroups
g Connect Plus
-y NAI Systems [ Copy ] [ Paste ]
[-jg Capacity Max Networks
=g Capacity Max 1
h- Trunking Controller [ i ]
-. MMNIS Data Gateway "
&1-fag MNIS VRC Gateways [ Add ” Remove ] [ i Up ” # Down ]
MName D Site: Number Voice gateway
Ltk Security Settings
jag SIP/RTP Interfaces Al Cal - Site T ! T | MNIS VRC Gateway 1 |7
----- B9 SmartFTT Radioservers Group 1 1 Wide * |MMIS VRC Gateway 2 |~
Group 2 2 Wide * | MMIS VRC Gateway 2 |~

To add a talkgroup, click Add. To add an All Call, click All Call. The added talkgroups will also appear in the
Profiles window. To change the order of groups in the list, use the Up and Down arrows. The order defined in the
window will be used in SmartPTT Dispatcher. To copy added groups to the clipboard, click Copy. To paste copied
groups from the clipboard, click Paste. To delete the selected talkgroup, click Remove.

Name: Talkgroup alias displayed by the control station.

ID: Talkgroup unique identifier used during communications. It should be set in the range of 7-65535 for a talkgroup,
and in the ranges of 1-16776415, 16777056—-16777183 or should be equal to 16777214 for an All Call.

To edit the talkgroup name or ID, set the cursor on the corresponding field and make changes.

Site Number: Site number list allowed for transmitting. In the Capacity Max network the talkgroups can be only

wide-area, while All Call can be wide-area or local.

Note: In the Capacity Max network you can add only wide-area talkgroups, so only the Wide value is available
for groups in the Site Number field. In order to display wide area talkgroups in SmartPTT Dispatcher, add
necessary talkgroups in SmartPTT Radioserver Configurator, define talkgroup identifiers that correspond to the
identifiers of the wide-area talkgroups in the Radio Management settings. You can add a wide-area All Call and
a local All Call, which is limited to one site. To add a wide-area All Call, which is available to all sites, click All
Call. Make sure that Site Number is set to Wide. To add an All Call limited to one site, click All Call, and in
the Site Number field select the site number where the All Call will be heard. Please note, that you do not

need any IDs for All Calls.

Voice gateway: List of available wice gateways. You can assign a certain wice gateway for each talkgroup.
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Note: If there are some available wice gateways, all talkgroups will use by default the first voice gateway in the
list. If the talkgroup is not registered on any wice gateway, the Voice gateway field will be empty. If Voice
transmission is not selected in the Capacity Max network settings, the Voice gateway column will be

hidden.

You should create talkgroups in accordance with the settings in the Radio Management program (see the Capacity
Max Systems settings, sorted by the Talkgroup Site Association value). For more detailed information, please

refer to the Motorola Radio Management User Guide.

Networics | Client Lt | Rules | Activity [ Log | Export/import Settings | Statistics | [l Radlio e )
- Cortrol Stations Control Station Talkgroups
g Comect s
‘s NAl Systems o= F
-ha Capacty Max Networks ( 2 ] = J
-l Capacity Max 1
Trunking Controller apacity Max System Server Data alkgroup Site As...
a AlCal Capacity Max System S Data » Talkgroup Site As
B, VNS Data Gateway
1-fag MNIS VRC Geleways [ psd J[ Remve | [ &0 [ #0own | Capacity Max Systems [ i , .
g MNIS VRC Geteway 1 . = T E— Viewby: () Subscriber Access Control (8] Talkgroup Site Association
e o Nomber S— = Tekgroup Tte Resocaton
‘g MNIS VRC Gateway 2 Oursysteml -
h MNIS VRC Gateway 3 Al Call Wide ~ |MNIS VRC Gateway 1 |~ ‘ ? ‘
A Call-Ste 1 1 ~ | MNiS VRC Gateway 1 |~ L
%, Securty Settngs
wy SIP/RTP Interfaces Al Call - Site 2 2 ~ | MNIS VRC Gateway 1 | ¥ TalkgroupID = Queue Priority | Allowed Sites =
3 SmarPTT Radioservers Group 106 106 Viide = |MNIS VRC Gateway 2 |~ 06 6 ~  Site Selection 1 - l
Group 107 107 Wide ~ |MNIS VRC Gateway 2 |~ 07 6 ~  Site Selection 1 -
Group 108 0 |wide ~ | MNiS VRC Gateway 2 [~ o S cectiont
1 - ite Selection h
Group 109 108 Wide ¥ |MNIS VRC Gateway 2 | ¥
108 6 - Site Selection 1 -
Group 110 10 Wide ~ | MNIS VRC Gateway 2 |~ e Selection
Group 111 m Viide ~ | MNIS VRC Gateway 3 |~ ue & ~ | Site Selection 1 -
Group 112 1z [wide ~ | MNIS VRC Gateway 3 [~ 1 6 - SiteSelection 1 -
Group 113 n3 [wide | MNIS VRC Gateway 3 |~ 12 6 ~  Site Selection 1 -
Group 114 14 [wide ~ | MNIS VRC Gateway 3 [~ — P —— .
114 6 - Site Selection 1 ~ I

103 items found (0 currently selected).

Analyze Results ’E‘

Connected To:LOCALHOST

Note: To open the Capacity Max System settings in the Radio Management program, click Actions > Manage >

Capacity Max System Server Data.

Security Settings

Capacity Max network supports two types of privacy mechanisms — Enhanced and Advanced Encryption Standard
(AES). The Enhanced Privacy utilizes Motorola proprietary algorithms and therefore is not interoperable with other
vendor's privacy offerings. The Enhanced Privacy provides high level of protection by means of 40-bit key length and
supports multiple keys in a radio. The Advanced Encryption Standard (AES) is a specification for the encryption of
electronic data established by the U.S. National Institute of Standards and Technology (NIST). The AES feature
supports 256-bit key length, unlike Enhanced Privacy. Similar to Enhanced Privacy, the AES also supports multiple

keys. For AES encryption a special license is required.

SmartPTT PLUS 9.1 189
Radioserver Configurator User Guide



The Security Settings window allows you to specify the encryption keys for incoming and outgoing traffic on the

digital channel.

H Connect Plus

H MAl Systems

BH Capacity Max MNetwarks

Elh Capacity Max 1
h Trunking Cantroller

o & MHNIS Data Gateway

E-hg MNIS VRC Gateways

Talkgroups
%
g SIP/RTP Interfaces

..... F9 SmartPTT Radioservers

Security Settings

[ Copy ) i

o
o
(1]

Enhanced Privacy
[ Add ][ Remove ]

Key IO Key Value

[ Add ][ Remove ]

Key IO Key Value

TX Privacy

Type |No | KeyID

Copy: Copy encryption settings of the channel to the clipboard.

Paste: Paste encryption settings of the channel from the clipboard.
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Enhanced Privacy
To configure Enhanced Privacy, perform the following actions:
1. In the Security Settings window of SmartPTT Radioserver Configurator add an enhanced privacy key for

incoming traffic. Enter its ID and value in the corresponding fields.

Click to add the
enhanced privacy
lemy

Click to remove the
selected enhanced
privacy key

Erhanced Privacy

ﬁ‘\[\ Add ][ Hemove‘r—’

Key ID Key Value
1 0123456789

Note: Key ID and Key Value must match the values set in the radio settings in the Radio Management
program and MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields are
the same, but the values in the Key Value fields do not match, the receiving side hears only a distorted woice.
If the key identifier of the transmitting side does not coincide with one of the key identifiers in the list of the

receiving side, then transfer to the receiving party will not be heard.
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2. In the Privacy Keys tab of the Radio Management program add the enhanced privacy key. Enter its ID and

value in the corresponding fields (see the Note abowe).

Radio Management

3

Resource View » Privacy Keys

Resources 1

Firmware
Language Packs

Woice Announcements

Click to add the

enhanced
privacy key

Key ID Key Alias Key Value = In-Use Templates and Sets | In-Use Templa)

1 Privl 0123456789 1

Text To Speech Packs
Symmetric Keys
RAS Keys

Privacy Keys
OTAP Keys

Analyze Results| |Compare Results| | citag)
Connected To:LOCALHOST

4 ——

Litems found (0 currently selected).
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Then open the configuration of the required radio station and in the Set Categories menu click General >
Security. To make the added enhanced privacy keys available for selection, add them in the selection set. To

do that, in the Privacy field click the Add button.

Radio Management EIE

ki O

Configuration View » B0TTQH1216 » Security ® Security-101

Set Categories 1
Close
v 'E]' Configuration: B07TQH1216
v T General General  Privacy AES  OTAR  Restricted Access to System  Ower-the-Air Programming
D Welcome Bitmap

D Language Packs: PCRLanguag ) Privacy B

Privacy Type | Enhanced ‘ l

Basic Privacy Key 0 - (Blank)

D General Settings: GeneralSetti
D Accessories: Accessories-101

D Control Buttons: ContralButtc
D Text Messages: TextMessages Enhanced Privacy Keys
D Telemetry: Telemetry-101
(] Menu: Menu-101

I[ D Security: Security-101 £} ]I i ) Key Alias Key Value
D Network: Network-101

@ Vaoice Announcement: Vaiced Click to add the enhanced
D Indeor Location: Indoorlocati privacy key in the selection set

4 »

Analyze Resuhs| |Compare Resu Iis| IEH Gl (Validation Results REEU T R T gl Search Results [Help
Connected To:LOCALHOST Radio Countl
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At that the Add Keys window will open. Select the required keys, which you want to be available for selection in

the Privacy Alias field when specifying the enhanced key on the channel and click OK.

E Add Keys E

[ g

Key I Key Alias Key Yalue Comments
"> 1 Privl 0123456789

1 items found (1 currently selected).

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.

DR 3000 :
= Security

Top Brivacy

ot Privacy
------- = Link Estabishment
i stes —
rivacy Type | Il
....... Ca Talkgroups I Enhancead -

e Channels

SmartPTT PLUS 9.1 194
Radioserver Configurator User Guide



4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Enhanced field

add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note abowe).

= @ Untitled
General Click to add the Click to remowve the
-- v:—:nhanu:lfg privacy selec.'t_ed entanu:ed
& @8 Group List s privagy key
[ & Convertional Add ] ’ Delete
eﬂ Capacity Plus
[ <% Linked Capacy Plus Alias Key D Key Value
E & Advanced # | Enhanced Key1 E 0173456783 |

5. In the radio settings in the Radio Management program to enable the encryption mode on the required channel

select the Privacy checkbox and in the Privacy Alias field select the enhanced privacy key for this channel.

Radio Managerment E=8 B T

=16 O

Configuration View » 807TQH1216 » Zone ¥ Zonel®

Set Categories 1
Save Discard Close
v [& Configurstion: B07TQH1216 E
» Il General
» [l Job Tickets a’ L e e 4 B
» Bl Mandown i e
> [l Systems = Position SetName Channel Type ChannelName | Voice Announ:  Phone System | Privacy Privacy Alias AES Alias
> :
: Encoder (XY 1 Personality-101  Capacity Max Personaiity TG101Channel  None PhoneSystemsl Privi, None
> Decoder - A
s 2 Personality-164  Capacity Max Personality TG102Channel  None Ph temsl Privl Mens
» Il Contacts
> Il R Group Lists s 3 Personality-163  Capacity Max Personsliyy TG103Channel  None Select to enable Privl | Select the enhanced
. the privacy privacy key
» [l Capacity Max Features s 4 Personality-162  Capacity Max Personality TG104Channel  None Priv
¥ W Zone/Channel Assignment s 5 Persenality- 161 Capacity Max Personality Enhanced None PhoneSystemsl Privl Mene
v [ Zone* L 6 Personality-160  Capacity Max Personality SiteAlICall None PhoneSystemsL Privl Meone
& Zonel &} s 7 Personality-158  Capacity Max Personsliyy MultiSiteAlICall  None PhoneSystems? Privi None
® Channel Pool .
s 8 Personality-158  Capacity Max Personslity TG65536 None PhoneSystems1 Priv None -
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AES Privacy

To configure the AES privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator add an AES privacy key for incoming

traffic. Enter its ID and value in the corresponding fields.

Click to add the
AES privacy key

Q'ir.t‘:'u::h::l ] [ Remove

Click to remowve the
selected AES privacy key

Key ID

Key Value

1

3876243210

Note: Key ID and Key Value must match the values set in the radio settings in the Radio Management

program and in MOTOTRBO Network Interface Service Configuration Utility. If the values in the Key ID fields are

the same, but the values in the Key Value fields do not match, the receiving side hears only a distorted woice.

If the key identifier of the transmitting side does not coincide with one of the key identifiers in the list of the

receiving side, then transfer to the receiving party will not be heard.
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2. In the Symmetric Keys tab of the Radio Management program add the AES privacy key. Enter its ID and value

in the corresponding fields (see the Note abowe).

Radio Management E’E

3

Resource View P Symmetric Keys

Resources 1

Firmware

Language Packs KeyID | KeyAlias  KeyValue | In-Use Templates and Sets

Woice Announcements 1 Syml 9876543210 1 0]

Text To Speech Packs

Symmetric Keys
RAS Keys

Privacy Keys
OTAP Keys

4 —— 4

1 items found (0 currently selected).

Analyze Re-sulls| |Compar=e Resulis| Tasks(6%)
Connected To:LOCALHOST
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Then open the configuration of the required radio station and in the Set Categories menu click General >
Security. To make the added AES privacy keys available for selection, add them in the selection set. To do

that, in the AES field click the Add button.

Radio Management El@
Configuration View » B07TTQH1216 » Security * Security-101
Set Categories q
Close

v E Configuration: B07TQH1216
v Tl General General  Privacy AES  OTAR  Restricted Access to System
[l Welcome Bitmap Over-the-Air Programming

[| Language Packs: PCRLanguag
(] General Settings: GeneralSetti ~)AES -
(] Accessories: Accessories-101
(] Control Buttons: ControlButte
[l Text Messages: TextMessages -'I-* -ED l
[l Telemetry: Telemetry-101
(] Menu: Menu-101 - 1 ) Key Alias Key Value

w Security: Security-101 £k "

[l Metwork: Network-101

key in the =election set

Click to add the AES provicy ‘

El Woice Announcement: Voiced

[l Indoor Location: IndoorLocati
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At that the Add Keys window will open. Select the required keys, which you want to be available for selection in

the AES Alias field when specifying the AES privacy key on the channel and click OK.

E Add Keys E

[ ¢

1 KeylD Key Alias Key Value = Comments
'» 1 Syml 9876543210

1 items found (1 currently selected).

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.

DR 3000 :
= Security

Top Brivacy

ot Privacy
------- = Link Estabishment
i stes —
rivacy Type | Il
....... Ca Talkgroups I Enhancead -

e Channels
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4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Symmetric Keys
field add the AES symmetric privacy key. Enter its ID and value in the corresponding fields (see the Note

abowe)

= @ Urtitled

Click to add the AES Click to remove the
m.‘iemri'ryl privacy key selected AES privacy

=3 Group List key
[ g Con\r[;ntional Add ] [ De.-leie'—‘]_/

eﬂ' Capacity Flus
23 -:—?{‘:- Linked Capacity Flus flias Key ID Koy Value

- @8 Advanced 7 Symmetric Keyl |'I |33?654321D |

5. In the radio settings in the Radio Management program to enable the AES encryption mode on the required

channel unselect the Privacy checkbox and in the AES Alias field select the AES privacy key.

| Radio Management [l ===
Configuration View » B07TQH1216 » Zone * Zonel®
Set Categories 1
Save Discard Close
v [T Configuration: B07TQH1216 a
» Ml General
» [l Job Tickets = B
(] : ]
» [l Mandown (1 | | ]
> I Systems S Channel Type Chanrel Name | Voice Announ: | Phone System | Privacy Privacy Aliss | AES Alias
g : Encoder 1 1 Personality-101  Capacity Mar Personalige TG101Channel  Neone PhoneSystems1 |;J None symi
» [l Decoder -
e 2 Personality-164  Capacity Mar Personality TG102Channel  None PhoneSystemsl Mone ne
» [l Contacts
. - u lect the P Select the AES
> Bl R Group Lists & 3 Personality-163  Capacity Max Personaligs TG103Channel  Alone PhoneSystems] Unselect the Privacy’]  Non Eeae e
» Il Capacity Max Features 4 4 Personality-162  Capacity Max Personality TG104Channel  None Non
¥ U Zone/Channel Assignment B3 5 Personality-161  Capacity Max Personality Enhanced Nene PhaneSystemsL O None None
v [ Zone % 6 Personality-160  Capacity Mar Personalits SiteAlICall None PhoneSystems1 O None None
& 7 Personality-159  Capacity Max Personality MultiSiteAlCall  None PhoneSystemsl (] Mone Mone
Channel Pool .
@ Channel Pool i# 8 Personality-158  Capacity Max Personality TG5536 None PhoneSystemsl ] None None B

TX Privacy

T¥ Privacy

Type INﬂ vl Key ID
|

Enhanced
AES (Symmetric Key)

Type: Allows you to select encryption mode for outgoing traffic on the side of SmartPTT Dispatcher.
If No is set, radioserver does not support outbound traffic encryption.
If Enhanced is set, specify the Key ID value from the Enhanced Privacy table, which will be used to encrypt

outbound traffic.
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Select AES (Symmetric Key), with the required Key ID, if you want to use AES (Symmetric Key) for outgoing traffic.
If TX Privacy is not set, and you have AES encryption for incoming traffic, AES (Symmetric Key) will be used for
incoming traffic by default.

AES (Symmetric Key) — AES encryption (DMR-compliant implementation, MOTOTRBO firmware R2.4 and later).

SIP/RTP Interfaces

Backed up with Cisco special hardware, SmartPTT can operate with cable radio networks. The cable radio network
interface allows converting analog woice signals into digital IP packets. So far, we have run successful tests on
Cisco 2900 only.

Cable radio networks allow SmartPTT to connect to analog radio systems and other systems supporting cable radio
network interfaces. The dispatcher can monitor calls from and to these systems. In this version, only All Calls and

Group Calls are supported. Group Calls require additional bridging configurations.
Note. Cable radio network support requires a special license.

To add a cable radio network interface, right-click SIP/RTP Interfaces and click Add. The following window will

open:

L ;
""" < Contral Stations SIPIRTP Interface
W Connect Plus
-y NAI Systems Pictive
W Capacity Max Networks
[—]W SIP/RTP Interfaces
=l =1 SIP/RTF Interface 1 Mame SIP/RTP Interface 1
L ‘[ SIP/RTF gateway
----- B9 SmartPTT Radioservers Network ID 1
Interface Auto - Pott 5060 =
Master Peer Address (IP .
Address:Port) remotehost 5060
Start RTP Part 18650 5
Mo Voice Timer, ms 100 =
Call Hang Time, ms 3000 =
Send KeepAlive timer, ms 5000 =
Idle SIP/RTP device disconnect timer, s 15 -
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Active: Enables the network.

Name: Network name, which will be used in SmartPTT Dispatcher.

Network ID: Unique ID of the network, which is used inside SmartPTT system. It is important that you have no other
network with the same Network ID.

Interface: A local IP address which is used as gateway between the radioserver and Cisco hardware. This IP
address must also be defined in the Cisco device settings.

Port: Port number used for interconnection between the radioserver and Cisco hardware. This port must not be used
in any other networks. The default value is 5060.

Master Peer Address (IP Address:Port): The IP address and port of the SIP/RTP device (Cisco hardware), which is
used as the network master peer.

Start RTP Port: This is the first RTP port is to be used by the SIP/RTP device for wice channels. The default value
is 18650.

No Voice Timer, ms: Time period for which the radioserver reserves the channel for a call session. If during this
time period the SIP/RTP device has not sent any wice packet, the radioserver activates Call Hang Time.

Call Hang Time, ms: Time period during which the radioserver reserves the channel for a call after the end of
transmission. During the timeout, only the participants of the call can transmit.

Send KeepAlive timer, ms: Time interval for the radioserver to send a special packet (keepalive) to the SIP/RTP
device to notify that the radioserver is active and running.

Idle SIP/RTP device disconnect timer, s: Time interval when the radioserver waits for a special packet (keepalive)
from the SIP/RTP device to notify that the device is active and running. If the radioserver has not received this packet

from the SIP/RTP device during this time period, the device gets the Offline status.
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SIP/RTP gateway

To set up the SIP/RTP gateway, click SIP/RTP gateway. At that, the following window will open:

Lo i
..... %2> Control Stations SIP/IRTP gateway
ﬁ Connect Plus
g WAl Systems Active
-y Capacity Max Networks
C-mg SIP/RTP Interfaces N SIP/RTP
. at
-y SIP/RTP Interface 1 e =
Lt _"[' SIP/RTP gateway Local SIP ID 16448250 =
----- BN SmartPTT Radiosarvers
Peer ID 1 -
T¥ Timeout Timer, s |60 <
Disconnect Timeout, s (10 =

Active: Enables the SIP/RTP gateway.

Name: Any random name of the SIP/RTP gateway. It used only in SmartPTT Radioserver Configurator.

Local SIP ID: The identifier of the radioserver. This will be used as a Radio ID by radio subscribers wishing to make
the incoming All Call.

Peer ID: The identifier of the Cisco device. This will be used as a Radio ID for outgoing calls.

TX Timeout Timer, s: Time period during which the radio can transmit without interruptions. After this time is over,
the transmission is interrupted.

Disconnect Timeout, s: Time period during which the channel is blocked one way after TX Timeout Timer
expiration. After this time period is over, the channel becomes available for transmission. While the channel is

blocked, calls going in the opposite direction are not affected.
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SmartPTT Radioservers

SmartPTT Bridging senvice allows joining two radioservers into a single radio network with the help of intelligent

means of patching for voice and data streams. Thus, radio subscribers or talkgroups under control of one radioserver

become available for another radioserver for wice call and data packet transmissions.

Masrer Peer

\— \— \—

Repeater Itepeater Repeater

w w w

SmartPTT SmartPTT , _ -
Radio Server Radio Server Repeater Repeater Repeater

=4 ﬁi‘“ﬂ im im

Disparcher Disparcher

Note: Currently, bridging senice between two radioservers is supported with all network topologies, except for

topologies with control stations.

SmartPTT Bridging senice allows joining radio networks, managed by two different radioservers, to cover distributed

regions. The important advantages of the network are dynamic redirection of private and group calls and data

packets from one radioserver to another, and short woice delay (60 ms).

How to Configure SmartPTT Radioservers

Configuration of bridging senice between two radioservers includes:
1. Adding an external radiosenrver:
e basic configuration of the external radioserver
e control station configuration of the external radioserver
o talkgroup configuration
2. Activating bridging senvice
3. Configuring bridging settings in SmartPTT Dispatcher

These actions are required for both joined radioservers in the system.
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SmartPTT Radioservers

To add a new external radiosener, right-click SmartPTT Radioservers in the setting tree of the Networks tab of

SmartPTT Radioserver Configurator and click Add.

..... E Capacity Max Networls

g SIP/RTP Interfaces

...... | ] = adiose

Add

Configuring SmartPTT Radioserver

To configure the newly added network, click SmartPTT Radioserver 1 under SmartPTT Radioservers. At that,

the following window opens.

;S Cortrol Stations SmartPTT Radioserver
g Connect Plus _
g MAI Systems Active

H SIP/RTP Interfaces Mame SmantPTT Radioserver 1
- SmartPTT Radioservers
EE_. | SmartPTT Radioserver 1 Network 1D 1
- 1" Control Station
b Talkagroups Peer ID 1
.. Securty Seftings
Interface |152.168.37.85 | Port 50000 [
Link Type [F‘eer V]
Master Radioserver
Address (IP 192.168.0.142:50000 Test
Address:Port)
Messaging Delay, ms 60 =
Group Call Hang Time, ms 3000 =
Private Call Hang Time, ms 4000 =
Emergency Call Hang Time, ms 4000 =

Authentication Key

Name: SmartPTT Radioserer system name.
Network ID: Unique ID of the SmartPTT Radioserver system.

Peer ID: Unique ID of the radioserver in the network.
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Warning! Peer ID must be unique. No other repeater in this network can have the same ID.

Interface: IP address of the local SmartPTT Radiosenver. Specify the IP address of the PC where the radioserver is
installed.

Port: A port number associated with the IP address of the local SmartPTT Radioserver.
Warning! Port number must be unique.

Link Type: Select the role of the local SmartPTT Radioserver: Peer or Master.
Master Radioserver Address (IP Address:Port): IP address and port of the other SmartPTT Radioserver, which

plays the role of the Master in the network.

Note: Select Master in the Link Type field for one of the radioservers acting as a master, select Peer for another. If
Master is selected in the Link Type field, the Master Radioserver Address field becomes dimmed. If Peer is
selected in the Link Type field, make sure that the Master Radioserver Address field contains the interface and

port number of the master repeater, that is the second radioserver.

Messaging Delay, ms: Message exchange delay between repeaters.

Group Call Hang Time, ms: Duration for which the repeater reserves the channel after the end of a group call
transmission. During this time, only members of the talkgroup that the channel is reserved for can transmit. After
expiration of the group call hang timer, the radio will transmit using the TX contact name (digital group) specified for
this channel in MOTOTRBO CPS.

Private Call Hang Time, ms: Duration for which the repeater reserves the channel after the end of a private call
transmission. During this time, only members of the private call that the channel is reserved for can transmit. After
the hang timer expires, the radio transmits using the TX contact name specified for this channel in MOTOTRBO
CPS.

Emergency Call Hang Time, ms: Duration for which the repeater reserves the channel after the end of an
emergency call transmission. During this time, only members of the talkgroup that the channel is reserved for can
transmit.

Authentication Key: Repeater authorization key (to be equal to the Authentication key in MOTOTRBO CPS).
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To delete the SmartPTT Radiosenver, right-click on the selected SmartPTT Radioserver system and click Delete.

EIE SmartPTT Radioservers
EI'

- art P adiose

= 1 Control Station Delete

b Talkgroups
L% Security Settings

Control Station Configuration
To set up the SmartPTT Radioserver control station, right-click Control Station in the setting tree of the Networks

tab SmartPTT Radioserver Configurator. At that, the following window opens.

% Control Stationis SmartPTT Control Station
gy Connect Plus
iy NAI Systems Active
g Capacity Max Networks -
: ! Contral Stat
iy SIP/RTP Interfaces Ame rol station
EIE SmantPTT Radioservers Radio ID 1
=-E8 SmartPTT Radioserver 1
=] CAl Network 12
-al Talkgroups
L3 Securty Setti CAl Network for
seuty nes Groups 225

[] Mllow Telephone Interconnect

TX Time-Out Timer, s &0

L 1L

Options
[] Emergency alam corfimed

[ Alow transmit intemupt

[] Compressed UDP data header

Confimed Events
Frivate callz

[ Data calls

Name: Virtual control station name.

Radio ID: ID of a virtual control station of the network.

CAIl Network: CAl-network ID. Use default value of 12.

CAI Network for Groups: CAl-network for groups ID. Use default value of 225.

Allow Telephone Interconnect: Allow telephone interconnect on the channel.

TX Time-Out Timer, s: Continuous radio transmission timeout. After this time, transmission is interrupted.

Emergency alarm confirmed: Determines if the emergency alarm is allowed to be acknowledged.
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Allow transmit interrupt: Enables or disables the ability to interrupt a radio subscriber.

Compressed UDP data header: Enabling this item reduces delays in data transmissions.

Private calls: This feature sets private calls on the current digital channel as confirmed.

Data calls: This feature enables individual packets in data calls (ARS, GPS and Text Message) on the current

digital channel or personality to be confirmed.

Configuring Talkgroups
To configure talkgroups, click Talkgroups in the setting tree of SmartPTT Radioserver Configurator. At that, the

Control Station Talkgroups window opens.

> Control Stations Control Station Talkgroups
ﬁ Connect Plus
g NAI Systems [ Copy ] Paste

EIE SmantPTT Radioservers [ All Call ]
EIE SmartPTT Radioserver 1 [

= T, Control Station Aad ” o ] [ e —
..... Mame B
...... 4t Securty Settings Al Cal
Group 1 1

Note: Configuration process of SmartPTT Radioserver control station talkgroups for this network is similar to the

configuration of control station talkgroups (see Control Station > Talkgroups).

Security Settings

SmartPTT Radioservers support three types of privacy mechanisms — Basic, Enhanced, and Advanced Encryption
Standard (AES).

Both Basic and Enhanced Privacy utilize Motorola proprietary algorithms and therefore are not interoperable with
other vendor’s privacy offerings. The main differences between Basic and Enhanced Privacy are that the Enhanced
Privacy provides higher level of protection by means of 40-bit key length. Enhanced Privacy supports multiple keys
in a radio compared to one key in the case of Basic Privacy.

The Advanced Encryption Standard (AES) is a specification for the encryption of electronic data established by the
U.S. National Institute of Standards and Technology (NIST). The AES feature supports 256-bit key length, unlike
Enhanced Privacy. Similar to Enhanced Privacy, the AES also supports multiple keys. For AES encryption a

special license is required.
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The Security Settings window allows you to specify the encryption keys for incoming and outgoing traffic on the

digital channel.

=¥ SmartPTT Radioservers
=-#% SmatPTT Radioserver 1
g 1" Control Station

o Talkgroups
Y Cecunity Settings

Security Settings

u]
o
@
[ 1]

[ Copy

Basic Privacy

Key 1 =

Enhanced Privacy

[ Add ] [ Remove ]
Key ID Key Value
[ Add ] [ Remove ]

Key D Key Value

TX Privacy
Type [No | KeyD

Copy: Copy encryption settings of the channel to the clipboard.

Paste: Paste encryption settings of the channel from the clipboard.
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Basic Security
To configure Basic Privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator in the Key field specify the key for the

basic encryption mode. The value ranges from 7 to 255.

Security Settings

[ Copy ] | Paste

Basic Privacy

wew ]

Note: Make sure that Key set in SmartPTT Radioserver Configurator matches Basic Privacy Key set in radio
settings in MOTOTRBO CPS and MOTOTRBO Network Interface Senice Configuration Utility. If basic

encryption keys of receiving and transmitting sides do not match, the receiving side hears only a distorted

voice.

2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Basic. In

the Basic Privacy Key field specify the key for the basic encryption mode. The value ranges from 1 to 255

(see the Note abowe).

= [ DPaso1
------- General Settings Securlty

....... € Accessories Privacy Restricted Access to System
------- Buttons

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select Basic.

DR 3000
= - _ Securlty

Privacy

Privacy
Privacy Type Igam vI

- @@ Channels
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4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Basic Privacy

Key field specify the key for the basic encryption mode. The value ranges from 7 to 255 (see the Note abowe).

= 4 Urtitled
General

[+ &8 Conventional
ﬁﬂ Capacity Plus
B {#- Linked Capacity Plus

Basic Privacy Key

5. In the radio settings in MOTOTRBO CPS select the Privacy checkbox to enable the encryption mode on the

required channel.

= [ DPaso1

------- B Job Tickets

E- @8 Signaiing Systems
[ Encoder

[ Decoder

[ [ Contacts

- RX Group Lists

=& Zonet

I8 173 - Siot!
ST 173 - Shot2

D 174 - Siot

b U 174 - Slot?
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Top

Woice Announcement File
Dual Capacity Direct Mode
Timing Leader Preference
Scan/Roam List

Auto Scan

Calor Code
RepeaterTime Slot
Phone System
ARS

Enhanced GFS

Window Size

174 - Slot1

BX IX

IN-::-n& j

r
I Eligible b l
I Mone j

[174 ~

|on SystemiSite Change |

Select to enable the
privacy
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Enhanced Privacy
To configure Enhanced Privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator add an enhanced privacy key for

incoming traffic. Enter its ID and value in the corresponding fields.

Click to add the
enhanced privacy
lemy

Click to remowve the
selected enhanced

Enhanced Privacy privacy key

‘\[\ Add ][ Hemove‘r—’

Key ID Key Value
1 0123456789

Note: Key ID and Key Value must match the values set in the radio settings in MOTOTRBO CPS and
MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields are the same, but
the values in the Key Value fields do not match, the receiving side hears only a distorted wice. If the key
identifier of the transmitting side does not coincide with one of the key identifiers in the list of the receiving side,

then transfer to the receiving party will not be heard.

2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Enhanced
and add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note above).

=~ § Dr4so1 -
- Bl General Settings Secunty

- @A Buttons

T L Pvay
I Privacy Type |Enhanced jl

- Click to add the o I?L Click to remove the
arc enhanced privacy Basic Privacy Koy |4 = selected enhanced

-1 Announcement ey privacy key

- B Job Tickets Add |

Delete
[~ @8 Signaling Systems

Top Privacy S Restricted Access to System

- Encoder Key 1D Key Alias Key Value
- Decoder 4 1 Privacy Key1 1
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3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.

E--fillesl DR 3000

[ @8 Channels

Top Brivacy

IPr'rvawTvpe IEnhanoed vll

4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Enhanced field

add the enhanced privacy key. Enter its ID and value in the corresponding fields (see the Note above)

= 4 Untitled

General
=B

[ 8 Group List

[+ 48 Convertional

cﬂ Capacity Plus

[ ®: Linked Capacity Plus
- {88 Advanced

Click to add the
enhanced privacy
by

Click to remowe the
selected enhanced
privacy key

Add || Delete

Alias

Key ID Key Value

o Enhanced Keyl

1 0123456789 |

5. In the radio settings in MOTOTRBO CPS to enable the encryption mode on the required channel select the

Privacy checkbox and in the Privacy Alias field select the enhanced privacy key for this channel.
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& § DP4sod -
! B 174 - Slot1
- [0 (General Settings
g Accessories Top RX T
- HE Buttons
- [ Text Messages Woice Announcement File INO,-,E j
- @0 Telemetry
T Menu Dual Capacity Direct Mode [
P Security = Timing Leader Preference IEIigibIe -I
@) Announcement Scan/Roam List |Nme j
B Job Tickets Auto Sean [
[ Signaling Systems
- Encoder Color Code |1 3:
] Decoder
® Repeater/Time Slot |1 vl
[ @ Centacts L
B RX Group Lists Phone System |174 j
E-| 88 Channels
R #RS | On SystemiSite Change v |
~d=@: & Tone Enhanced GPS [
L 173 - Slot1
S 173 - Slot2 Window Size
- Select the enhanced
- privacy key
S 174 - Slot2
L 145 - Siot! IPF'W‘EE" Alias IPrivacy Key1 Iﬁ]

213



AES Privacy
To configure the AES privacy, perform the following actions:

1. In the Security Settings window of SmartPTT Radioserver Configurator add an AES privacy key for incoming

traffic. Enter its ID and value in the corresponding fields.
Click to add the Click to remove the
AES privacy key AES selected AES privacy key

Qi\- Add ] [ Remave

Key ID Key Value
1 5876543210

Note: Key ID and Key Value must match the values set in the radio settings in MOTOTRBO CPS and in
MOTOTRBO Network Interface Senice Configuration Utility. If the values in the Key ID fields are the same, but
the values in the Key Value fields do not match, the receiving side hears only a distorted wice. If the key
identifier of the transmitting side does not coincide with one of the key identifiers in the list of the receiving side,

then transfer to the receiving party will not be heard.
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2. In the Security window of the radio settings in MOTOTRBO CPS in the Privacy Type field select Enhanced

and add the AES privacy key. Enter its ID and value in the corresponding fields (see the Note abowe).

£ § DP4sot .
.. B8 General Settings Security

- §  Accessones Top  Privacy AES — Restricted Access to System
- HE Buttons

- [ Text Messages Privacy

- T Telemetry

ﬁ Menu :

[PrwacyType IEnhﬂnoed 'I
T Network Basic Privacy Key |1 3:

{311 Announcement

B Job Tickets Add | Delete |

- @8 Signaling Systems

. @ Encoder Key ID Key fias Key Valus
.. @ Decoder » 1 Privacy Key 1

- [ Contacts

o g oy o O s O O s Y e O e |
| Ly iy i i Iy Ly L

RX Group Lists Click to remove the
selected AES privacy

Channels key

Scan

Roam

Capacity Plus Key ID Key Aias Key Value

3 1 Symmetric Key 987643210

3. In the Security window of the repeater settings in MOTOTRBO CPS in the Privacy Type field select

Enhanced.
-fillasl DR 3000 .
_____ General Setings Security

Top Erivacy
m Sen::urit',rl

....... Metaork

E Privacy
------- 'z Link Establishment
.(:_> Sites o .
rivacy Type | Il
....... <a§ Talkgroups I Enhanced hd

- Channels
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4. In the Security window of MOTOTRBO Network Interface Senice Configuration Utility in the Symmetric Keys
field add the AES symmetric privacy key. Enter its ID and value in the corresponding fields (see the Note

abowe)

= @ Urtitled

G I - i
=nera Click to add the AES Click to remove the
privacy key selected AES privacy

=3 Group List key
[ = Con\r[;ntional Add ] [ De.-leie'—‘]_/

cﬂ' Capacity Flus
2 (ﬂ Linked Capacity Plus Alias Key ID Key Value

- @8 Advanced 7 Symmetric Keyl |'I |33?654321D |

5. In the radio settings in MOTOTRBO CPS to enable the AES encryption mode on the required channel unselect

the Privacy checkbox and in the AES Alias field select the AES privacy key.

B o 174 - Slot1

& (@ o) o X
Bl &8 Zonet
-------:=:§- & Tone Voice Annocuncement File INc.ng j
~-IL% 173 - Slott
L 173 - Slot2
ng Timing Leader Preference |E|igib|g vI
I8 174 - Siot2
S8 145 - Siot! Scan/Roam List |Nme j
o TLE: 145 - Slot2
o ILE: Lingbpalss
U Lneppald? Color Code [+ 2]
n_g Lncppa1sT
eﬂ CapGroupi
0& CapGroup2
eg Al Cal
ﬂ :.g-:. Analog (COM)
- TL8 216 - Slot]

Dual Capacity Direct Mode |

Auto Scan [T

Repeater/Time Slot |4 -

Phone System |174 j

m

#R3 |on systemsie Change |

Enhanced GRS [
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- IUE 216 - Slot2
- m Channel Pool ‘Window Size IS 'l
- ZoneZ Pri r
i LCP2
B _ _ Select the AES
G- Digital Privacy Aliss IPrimc*,r Keyl privacy key
F- @8 C3BK

I AES Alias j

H- @@ RA13 [ |symmetric Key1
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TX Privacy

Enhanced
AES (Symmetric Key)

Type: Allows you to select encryption mode for outgoing traffic on the side of SmartPTT Dispatcher.

If No is set, radioserver does not support outbound traffic encryption.

If Basic is set, the key specified in the Key field in the Basic Privacy section is used for encryption of outgoing
traffic.

If Enhanced is set, specify the Key ID value from the Enhanced Privacy table, which will be used to encrypt
outbound traffic.

Select AES (Symmetric Key) with the required Key ID, if you want to use AES (Symmetric Key) for outgoing traffic.
If TX Privacy is not set, and you have AES encryption for incoming traffic, AES (Symmetric Key) will be used for
incoming traffic by default.

AES (Symmetric Key) — AES encryption (DMR-compliant implementation, MOTOTRBO firmware R2.4 and later).

Bridging Service
To activate the bridging seniice, click Bridging in the setting tree of SmartPTT Radioserver Configurator. In the

opened window select the Active check box (see the Bridging section in the Help of SmartPTT Radioserver

Configurator).

Bridging Service in SmartPTT Dispatcher

To set up the redirection of wice calls and data packets correctly, configure routes, route groups and profiles for the
bridging senice in SmartPTT Dispatcher. For more information see Bridging in the Help file of SmartPTT
Dispatcher.

Example

The following example presents bridging configuration between two radioservers. Each of them works with the IP Site
Connect network topology.

User 1 (in SmartPTT Radioserver Configurator) makes the settings for direct connection of the radioserver to

repeaters' network, functioning in IP Site Connect system (Network ID = 7).
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The IP address and port number of the master repeater must be specified in the Master Repeater Address field

(the example displays connection settings only with one repeater).

In the Interface field select the IP address of the virtual repeater in the network with Network ID = 1.

-y Connect Plus
-y NAI Systems

Gl AP Site Comnect 211
|_:_|r‘[‘1 Slot 2111
Talkgroups
% Securty Settings
" Slot 211_2
{ Talkgroups

i./Z% Securty Settings
----- & DDOMS Settings
----- &8 MNIS Data Gateway
ﬁ Capacity Max Networks
ﬁ SIP/RTP Irtefaces
----- FN SmartPTT Radioservers

SmartPTT PLUS 9.1
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MNAI - IP Site Connect Network

Active

Mame MAI - IP Site Connect 211

Metwars ID 2

Peer ID 1

Interface 192.168.37.85 ~| Port 50000 |3
Master repeater

address ([P 152.168.7.211:50000 Test
Address:Port)

Authentication key

Voice transmission [Hf:peatas v]
Group call hang time, ms 3000 El
Frivate cal hang time, ms 4000 Iil
Mz number of telephone calls 100 El
Data transmission
Monitoring
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Slot and group settings for IP Site Connect network with Network ID = 1:

Slot
Active

MName | Slot 111_1

Slot 1D |1

Radio ID
CAl Network 12 B
CAl Network for Groups (225 lil

NAI - I Site Connect 1

Talkgroups

t Securty Settings

“'I‘” Slot 111_2

i Talkgroups

i t Securty Settings
-8, DDMS Settings

Bl MNIS Data Gateway

Slot
Active

Name | Slot 111_2

St ID |2 s

Radio ID 16448250 EI
CAl Network 12
CAl Metwork for Groups (225 lil

E‘"h NAI - 1P Ste Connect 1
B "9 Slet 1111

: Talkgroups

t Securty Settings

Talkgroups

t Securty Settings
&, DDMS Settings

B, MNIS Data Gateway
—

Control Station Talkgroups

[ Copy ] [ Faste ]

[ Al Cal ]

[ Add ” Remove ] | d#uUp ” # Down ]
Name 10]

Group 1 (Slot111_1) 1

Group 2 {Slat111_1) 2
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Control Station Talkgroups

[ Copy ] ’ Paste ]
[ Al Cal ]
[ Add “ Remaove ] | & Up ” ¥ Down ]
Name D
Group 1 (Slat111_2) 3
Group 2 (Slot111_3) 4
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User 2 also configures the IP Site Connect network connection (Network ID = 2) in SmartPTT Radioserver

Configurator. Fill in the Master Repeater Address and the Interface fields with data corresponding to the network

with Network ID = 2.

-y Connect Plus
-y NAI Systems

Gl AP Site Comnect 211
|_:_|r‘[‘1 Slot 2111
Talkgroups
% Securty Settings
" Slot 211_2
{ Talkgroups

i./Z% Securty Settings
----- & DDOMS Settings
----- &8 MNIS Data Gateway
ﬁ Capacity Max Networks
ﬁ SIP/RTP Irtefaces
----- FN SmartPTT Radioservers
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MNAI - IP Site Connect Network

Active

Mame MAI - IP Site Connect 211

Metwars ID 2

Peer ID 1

Interface 192.168.37.85 ~| Port 50000 |3
Master repeater

address ([P 152.168.7.211:50000 Test
Address:Port)

Authentication key

Voice transmission [Hf:peatas v]
Group call hang time, ms 3000 El
Frivate cal hang time, ms 4000 Iil
Mz number of telephone calls 100 El
Data transmission
Monitoring
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Slot and talkgroup settings for IP Site Connect network with Network ID = 2:

Slot
Active

Name | Slot 211_1

Slet 1D |1 : =g NAI - IP Site Connect 211
E_uﬁ1ﬂ
Radio ID 16448250 | Talkgroups
< 1 Security Settings
CAl Network 12 = E| Tf, Sot 211 2
CAl Network for Groups (225 B i Talkgroups
% Securty Settings
&8 DDMS Settings
&, MNIS Data Gateway
Control Station Talkgroups
[ Copy ] Paste
( Al Cal ]
[ Add ] [ Remaove ] [ @& Up # Down
Name D

All Call (Slot211_1)

Group 1 (Slot211_1)

Group 2 (Slot211_1)

Slot
Active

Name | Slot 211_2

SletID |2 = Bh MAI - IP Site Connect 211
=1 Slet 2111
Radio 1D 16448250 = P Talkgroups
t Securty Setti
CAl Network 12 e 4 Seurty Settings
CAl Network for Groups | 225 = i Talkgroups
Securty Settings
B8, MMNIS Data Gateway
Control Station Talkgroups
’ Copy ] Faste
[ Al Cal ]
[ (e ) [ 40
Name D
41l Call {Sl0t211_2)
Group 1 (Slot211_2} 3
Group 2 (Slot211_2) 4

Next, user 1 adds the SmartPTT radioserver (Radioserver 111) with the Master link type and chooses the

corresponding IP address in the Interface field of SmartPTT Radioserver Configurator.

SmartPTT PLUS 9.1

Radioserver Configurator User Guide

221




User 2 also adds the SmartPTT radioserver (Radioserver 211) and defines its connection type as a Peer. In the

Master Radioserver Address field User 2 specifies the IP address and port number of the Master repeater.

Liser 1
% Control Stations SmartPTT Radioserver
i Connect Plus )
-hag NAI Systems Active
w Capacity Max Networks Mame Radioserver 111
w SIP/RTP Interfaces
EIE SmartPTT Radioservers
28 | Radioserver 111 Network ID 3
é---"j[" Control Station 111
: Talkgroups Peer ID 1
Lt Securty Settings
Interface 192.168.37.71  ~| Pot [50001 |2
Link Type [Mastar v]
Liser 2 \
E Control Stations SmartPTT Radioserver
Connect Plus )
g NAI Systems Active
iy Capacity Max Networks N Aadi 1
. fag SIP/RTP Interfaces ame oSETET
=¥ SmartPTT Radioservers
E'E Radiozerver 211 Metwark |D 4
=-"{" Control Station 211
..... Talkgroups Peer ID 1
L5 Securty Settings
Interface 192.168.0.186 vl/ Pot (50001 2]
/
Link Type [ Peer '/ - ]
Master Radioserver
Address (P 152.168.37.71:50001 Test
Address:Port)
Messaging Delay, ms 60 El
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Settings for control station and its talkgroups of the radioservers:

User 1
SmartPTT Control Station Control Station Talkgroups
Acti
B Actve [ Copy ] | Paste |
Mame Control Station 111

[ Al Call J
Radio 1D m

[ Add ] [ Remove ] [ 4 Up ] | ¥ Down |
CAl Network 12
CAINetworkfor e hame D
Groups All Call {C5117)

Group 1 (C5111) 1

Group 2 (C5111) 2
User 2
SmartPTT Control Station Control Station Talkgroups
| Acti
Ve l Copy l | Paste |
Name Control Station 211

- ( Al Cal |

Radio ID 21

[ Add ][ Remove ] ’ i Up ]l ¥ Down |
CAl Network 12
CAl Network for TR e =
Groups All Call {C5211)

Group 1{C5211) 1

Group 2 {C2117) 2

After that, both user 1 and user 2 activate the bridging senice in SmartPTT Radioserver Configurator.

To apply settings, click Save and restart the senice in SmartPTT Radioserver Configurator (for user 1 and user 2).
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In the SmartPTT Dispatcher application of user 1 (Master), a radio with the IP address = 72.0.0.95 is registered at
Slot 111_1. The SmartPTT radioserver (user 2) with its radios and talkgroups is shown in the user 1 system as
Control Station 111. In SmartPTT Dispatcher of user 2, a radio with the IP address = 712.0.7.148 is registered at Slot

211_1. SmartPTT radioserver (user 1) in respect to user 2 is displayed as Control Station 211.

User 1 User 2
| Online Subscribers v | Online Subscribers v
Object Map Status Object Map Status
- B Radioserver 111 > - H Radioserver 211 »
- o Control Station 111 PTT > - e Control Station 211 PTT >
f& Groupl (C5111) PTT » #& Groupl (cs 211) PTT »
f& Group? (CS 111) - PTT > N & Group2 (cs 211) PTT »
g 12.00.211 (empty) PTT > § 1200111 (empty) PTT >
g 12.01.148 {empty) PTT > g 120095 (empty) PTT »
- e Slot 1111 PTT > - e Slot 2111 PTT >
& Groupl (Slot 111_1) PTT 27 & Groupl (Slot 211_1) PTT »
#& Group2 (Slot 111_1) PTT > #& Group2 (Slot 211_1) PTT »
H 120095 {empty) PTT > H 1201148 (empty) PTT >
- o Slot111 2 PTT > - md Slot2112 PTT >
#& Group3 (Slot 111_2) PTT > #& Group3 (Slot 2112) PTT »
@& Group4 (Slot 111_2) PTT > f& Group4 (Slot 211.2) PTT >
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In SmartPTT Dispatcher of user 1 set up the bridging senice of wice calls and data. To do this, create a group with
routes to redirect calls of all types in duplex mode (from Slot 111_1 and Slot 111_2 to Control Station 111). Make

this route group active.

Bridging Configuration

Radioserver: Radioserver 111

Profile: Bridging 111 <-> 211 Change Profile | Save Save As

Routes: O Al @ Active

+ Add Group  # EditGroup = Delete Group

Active | Route Group | - [ Show Details ]
El; Rtes 111 <-> 211 | ﬂ]
No | Source Network Source Direction Destination Network Target |
12 |PSite Connect 111-Slot 111 1 Al Ead Radioserver 111 - Contral Station 111 All
13 |PSite Connect 111-Slot 1112 Al e d Radioserver 111 - Contral Station 111 All

Apply

Make similar settings in SmartPTT Dispatcher for user 2.

Bridging Configuration
Radicserver: Radioserver 211
Profile: Bridging 211 <-> 111 Change Profile ] [ Save ] [ Save As ]
Routes: ® Al O Active
+ Add Group  # Edit Group = Delete Group
Active | Route Group | - [ Show Details ]
= 211 <> 111
] Hide Details
Routes
No | Source Network Source Direction Destination Network Target |
1 |F Site Connect 211-Slot 2111 Al Ead Radioserver 211 - Contral Station 211 All
2 |P Site Connect 211 - Slot 211_2 Al - Radioserver 211 - Contral Station 211 All
Apply
- Close
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System verification:
1. User 1 makes a private call to the radio registered in the system of user 2.

User 1 (an outgoing call):

i A & LO|E

u 12.0.1.148 tes dyy A
Qutgoing call ) - . KensasCity
I B e T
cound S
U
oy
4o
I}
=
1.
L
! Online Subscrib 4:40:27 PM < Private Call, 12.0.1.148 o
| Object [ Map | Sstatus
- B Radioserver 111 »
- ai Control Station 111 PTT » .
T OGGAd&ERDG
& Groupl (CS 111) PTT » I o | I
¥ | [Typs text and Ent
& Group2 (CS 111) PTT » | El il
i 1200211 O {empty) »
i 1201148 O {empty) »
- o Slot111 1 »
#& Groupl (Slot 111 1) PTT »
i Group2 (Slot 111 1) PTT »
i 120085 O (empty) PTT »
- o Slot111 2 PTT »
& Group3 (Slot 111 2) PTT »
#& Group4 (Slot 111_2) PTT »

User 2 (incoming call, a radio has a corresponding indication about the incoming call):

12.0.0.111
Incoming call

&

54028 AM > Private Gall, 12.0.1.145

Object [ Map | status

- H Radioserver 211 »
- &l Control Station 211 >
#& Groupl(cs 211) » ﬂ:ﬂ‘nﬂﬁﬁ Ifﬁ‘@(a
& Group2 (cs 211) » [ & “'”Type text and press Enter |'P| =
g 1200111 1 (empty) » \% '3a_ mm‘.}oq.
g 120085 O (empty) » 7% Wm ('/- /
L N
- e Slot 2111 >
#& Groupl (slot 211 1) >
#& Group2 (slot 211 1) >
H 1201148 1 (empty) »
- od Slot2112 »
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2. A group call is initiated by the radio registered in the system of user 2.
The radio, registered in the network of user 2, makes a group call. In this case, the group call is redirected to the

appropriate group of Control Station 111 (user 1).
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User 2:

=& &

Google Map X

Radioserver 211 / Control Station 211 / Groupl (C5 211)

Groupl (CS 211)
Incoming call

-

. 12.0.0.95

e e
9:42:58 AM = Group Call {5 sec.

)
9:42:58 AM > ...> Group Call, 12.0.0.85 (2 sec.)

5-43-08 AM > Group GCall

94308 AM > _> Group Call, 12.0.0.85 (1 sec )

Object [ Map [ status
- H Radioserver 211
- o Control Station 211
#& Groupl (CS 211)
#& Group2 (CS 211)
g 1200111 1 (empty)
g 120095 1 (empty)
- o Slot2111
#& Groupl (slot 211_1)
#& Group2 (slot 211_1)
H 1201148 | (empty)

- & Slot 2112

User 1:

ﬁ |Type text and press Enter

PTT
PTT
PTT
PTT
PTT
PTT

¥ ¥ ¥ ¥ ¥ ¥ ¥ ¥ V¥ VY Y

PTT

Groupl (CS 211)
Incoming call

. 12.00.95

/;}.
1
I

o .
53 AM > Group Call {5 sec

)
9:42:58 AM > ...> Group Call, 12.0.0.85 (2 sec.)

9-43-08 AM > Group Call

9:43.08 AM > ..> Group Call, 12.0.0.85 (1 sec.)

Object [ Map [ status
- B Radioserver 211
- o Control Station 211
#& Groupl (CS 211)
#& Group2 (CS 211)
g 1200111 1 (empty)
g 120095 1 (empty)
- & Slot2111
& Groupl (Slot 211 1)
#& Group2 (Slot 211 1)
g 1201148 1 (empty)
- o Slot 2112

ﬁ |Type text and press Enter

PTT

PTT
PTT
PTT
PTT
PTT

¥ ¥ ¥ ¥ ¥ ¥ V¥ ¥ ¥ VY Y

PTT

3. A private call from the radio, listed in the system of user 2, to the radio of user 1.

User 2:
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12.0.1.148
Incoming call

5

Object
- H Radioserver 211
- o Control Station 211
& Groupl (CS 211)
& Group2 (CS 211)
g 1200111 O (empty)
f 120095 O (empty)
- o Slot2111
& Groupl (Slot 211 1)
@& Group2 (Slot 211 1)
g 1201148 O (empty)

- o Slot 2112

User 1:

PTT
PTT
PTT
PTT
PTT
PTT

PTT

Y ¥ ¥ ¥ ¥ V¥ V¥ V¥ V¥ V¥ Y

12.0.1.148
Incoming call

Object Map Status
- B Radioserver 111
- a4 Control Station 111
& Groupl (CS 111)
&% Group2 (C5 111)
i 1200211 O (empty)
§ 1201148 O (empty)
- o Slot1111
@ Groupl (Slot 111 1)
#& Group2 (Slot 111_1)
g 120095 O (empty)

- o Slot111 2

PTT

PTT
PTT

¥ ¥ ¥ ¥ ¥ ¥ V¥V VY Y Y

PTT

Radioserver 211
Slot 211_1

2:44:13 AM > Offline
9:44:13 AM > Online

9:44:13 AM = Offline
9:44:13 AM > Onling
94413 AM > Private Call, 12.0.0.85...

T OhRKiAdeEHoq

I [l"l ‘ '||Type text and press Enter

4:45:42 PM > Offfline
4:45:42 PM > Online
4:45:43 PM > Offline
4:45:54 PM > Private Call, 12.0.0.95...
4:45:58 PM > Online

ChOGGKad&in®Q

! I I'l"'l |'||Type text and press Enter

4. A call from the control station of user 71 to the control station of user 2.

User 1:
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‘u 120.0211
Qutgoing call
©
T = =
i Object [ Map [ Status
- B Redioserver 111 »
- o Control Station 111 PTT »
#& Groupl (CS 111) PTT »
@& Group2 (CS 111) »
g 1200211 O (empty) »
g 1201148 O (empty) »
- ol Slot111 1 PTT »
#& Group1 (Slot 111_1) PTT »
#& Group2 (Slot 111_1) PTT »
g 120095 O (empty) PTT »
- o Slot111 2 PTT »
User 2:

12.0.0.111
Incoming call

Onli v
Object [ Map | status

- H Redioserver 211 »

- os Control Station 211 PTT »

& Group1 (CS 211) PTT »

& Group2 (CS 211) »

§ 1200111 O (empty) »

g 120095 O (empty) PTT »

- o Slot211 1 PTT »

& Groupl (Slot 211_1) PTT »

@& Group? (Slot 211_1) PTT »

§ 1201148 O (empty) PTT »

- a Slot211 2 PTT »
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Radioserver 111
Control Station 111

4:48:23 PM < Private Call, 12.0.0211

CEOGH Aad&E O

I [l'"'l ‘ 'HType text and press Enter

9:40:28 AM > Private Call, 12.0.1.145 (1 min. 4 sez.)
9:46:59 AM > All Call (45 s82.)

9:47:45 AM > All Call (34 sec)

9:43:24 AM > Private Call, 12.0.0.211...

CHhOBGATEHLDG
>l=

o
0~y

I [l'"'l |V||Type text and press Enter
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To redirect only group calls between two radioservers without setting up routes in SmartPTT Dispatcher, create

multigroups with the list of radios, that support group call bridging in SmartPTT Radioserver Configurator (for both

radioseners). For more details see the Multigroups section in the Help of SmartPTT Radioserver Configurator.

User 1

E F SmartPTT Radioservers
i E-F0 Radiossrver 111

=8 '|_ - Control Station 111

User 1, User 2

MultiGroups

Sample List of Subscrbes for MultiGroup: 1.5.10-20

tiser 2

BE SmartPTT Radioservers
| E-E3 Radiossrver 211

=5 'L ' Control Station 211

- | Add || PRemove | Apply ™
MuttiGroup Mame Subscriber 1Ds Tall: GrouE .
404,55 1
Y Y
Control Station Talkgroups Control Station Talkgroups
l Add ] l Remaove ] [ Copy ] | Paste | [ Add ] [ Remaove l [ Copy l | Faste |
MName D Name D
Group1 (Slat 111_1) 1 Group1 (Slet 211_1) 1
Group2 (Slet 111_1) 2 Group 2 (Slot 211_1) 2

The following example demonstrates a call to Group 1. Group 1 corresponds to the created Multigroup 1 with the a

list of radios — 95 (IP address = 72.0.0.95) and 404 (IP address = 712.0.1.148). The radio with the IP address =

12.0.1.148 (ID = 404) initiates a group call. The radio with the IP address = 712.0.0.95 (ID = 95) is also able to

participate in the call due to Multigroup 1.
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Groupl (CS 211)
Incoming call

Object

- B Radioserver 211
- o Control Station 211
& Groupl (CS 211)
& Group2 (C5 211)

g 1200111

§ 120095

- i Slot 2111

O

4 Groupl (Slot 211_1)

i Group2 (Slat 211 1)

§ 1201148

- m Slot211.2

User 1:

O

al&|&|O

{empty)
{empty)

(empty)

PTT

PTT
PTT
PTT
PTT
PTT
PTT

¥ ¥ ¥ ¥ ¥ ¥ V¥ V¥ V¥ V¥ VY

Groupl (Slot 111 1)
Incoming call

&

S i S

Radioserver 211 / Control Station 211 / Groupl {(CS_211)

. 12.0.0.95

9:52:10 AM = Group Call..

95153 AM > ..> Group Call, 12.0.0.95 (1 sec.)

9:52:10 AM > __> Group Call, 12.0.0.95 (1 sec )
9:52:11 AM > .. > Group Call, 12.0.0.85 (2 sec.)

ﬁ |Type text and press Enter

Object
- B Radioserver 111
- & Contral Station 111
#& Groupl (CS 111)
#& Group2 (CS 111)
g 1200211
E 1201148
- & Slot111.1
#& Groupl (Slot 111_1)
#& Group2 (Slot 111_1)
E 120095

- & Slot111 2

Map

|
|

|

SmartPTT PLUS 9.1

Radioserver Configurator User Guide

Status

(empty)
(empty)

(empty)

PTT

PTT

¥ ¥ ¥ ¥ ¥ ¥ VY V¥ ¥ V¥ VY

Radioserver 111 /Slot 111 1/

. 120095

4:51:52 PM = Group Call...

45137 PM » .. » Group Call, 12.0.0.95 (3 500}
4:51-40 PM > > Group Call, 12.0.0.95 (1 sec.)

4:51:52 PM > .. > Group Call, 12.0.0.95 (1 sec.)

“ ‘Type text and press Enter
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Client List

The Client List tab enables you to see the lists of client applications connected to the radioserver and to manage
the settings of the users created to work with the web application.

To open the list of client applications connected to the radioserver, click the Client List tab and click Active.

’
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E‘Elg

Settings | Metworks | Client List | Rules | Activity I Log | Export/Import Settings | 5tati5tic5|
) Al {mobile and web clients) @ Active

List of connected clients

Client Name Address Connect Time Profile
Dispatcher - Administrator 192.168.37.75:51145 08.12.2015 %:55:37
Michael @smartptt, Web 152.168.37 75:51182 08122015 %:56:35

Client Name: Name of the desktop version of the dispatch console, the operator's name, or web application
connected to the radiosenver. If Windows Authentication is enabled in SmartPTT Dispatcher > Settings >
General Settings, you can also see the name of the Windows group (which, in this case, corresponds to the name
of the operator) and the name of the Windows user logged into Windows.

Address: The IP address of the client application.

Connect Time: Time of the last session.

Profile: Assigned profile to the dispatcher or to the user of the web application.

Note: To assign a profile to the dispatcher, click Settings > Radioservers in SmartPTT Dispatcher. For more

information about profiles see Profiles in the Help document.

To connect the desktop version of the dispatch console to the radioserver, go to Settings > Radioservers in
SmartPTT Dispatcher and select the radioserver to which you want to be connected. At that, in the Client List tab of
SmartPTT Radioserver Configurator the connected dispatch console will show up.

How to connect the user of the web application to the radioserver, please check WebClient

Installation & Configuration for SmartPTT.
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To open the list of users created to work with the mobile and web clients, click All (mobile and web clients).

”
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E‘Elg
Settings | MNetworls | Client List | Rules | Activity I Log | Export/Import Settings | Statistics|
@ Al (mobile and web clients) ) Active
| Ad || Deete |
| Login Parameters
Poter Login Michael [ Change password
Maria Profile [ v]
Allow voice calls

The Login list: The list of users of the SmartPTT web application.

To add new user, click the Add button. In the Parameters section specify the user name in the Login field and set
the password by clicking the Change password button. The user name and password are case sensitive.

Profile: It contains the list of profiles created in SmartPTT Radioserver Configurator (see the Settings tab >
Profiles). Assigning a profile to the user is not obligatory, but enables you to limit the user's access to objects and

to provide additional opportunities in the organization of calls between user and radio subscribers. For more

information about profiles see Profiles in the Help document.

Allow voice calls: Select it to enable the user to make wice calls.

To edit the parameters of the existing user, click this user in the Login list, and edit the necessary fields in the
Parameters section.

To delete user, click this user in the Login list, and click the Delete button.

To save the changes, click the Save button in the bottom right corner of the SmartPTT Radioserver

Configurator.
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Rules

SmartPTT Radioserver allows you to set up rules to perform automatic actions (playback sounds, send messages,
play predefined wice notifications) based on conditions specified in the Rules tab in SmartPTT Radioserver

Configurator.

To set up rules, open the Rules tab in SmartPTT Radioserver Configurator.

r@ SmartPTT Server Cenfiguration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config EI&M
| Settings | Networks | Cliert List | Rules | Activity | Log | Bxport/import Settings | Statistics |
@ Events on radios (") Events on Dispatcher
‘gl Add [ Modify 3 Delete
Active  Name

Events on radios: Allows you to create rules related to subscriber radios.

Events on Dispatcher: Allows you to create rules related to SmartPTT Dispatcher.
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To create a new rule for events on radios, click Events on radios and then click Add. To change the existing rule,

click Modify or double-click on the rule name in the list of rules.

,
Rule |

Mame: Rule 1
Active:

Conditions

Direction: [Equal to v”lnmming v]
Event Type: [Equal to "”F\HS "] [Call "][M&BSEQE ~
Date:

Additional Information:
Contral Station:
Talkgroup:
Subscriber:

Status:

OO0OOo0OOOO

Duration:

Actions

<
]

Play Sound:

=
»

Send Message:

Example: 1-99, 150
@ Subscriber 510

(71 Talkgroup 1]
Send Message To Initigtor

Start Voice Motification: [ | Motification 1

Stop Curent Voice
Maotification: 1 | Any

Name: Any name of the rule.
Active: If selected, the rule will be used in the system.

Under Conditions you can select criteria of the rule.

Condition name Operation Value

Direction Equal to Incoming, Outgoing
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Condition name Operation Value
Event Type Equal to, Not equal to ARS, Call, Message, Telemetry,
Alarm, Block
Date Between Period of time
Additional Information Equal to, Contains Any additional information, e. g.
text messages, titles and
description of tasks, participants
of a group call.
Control Station Equal to, Contains Control station name
Talkgroup Equal to, Contains Talkgroup name
Subscriber Equal to, Not equal to Subscriber ID
Status Equal to, Not equal to One of system statuses of events
Duration Equal to, Not equal to, Greater than, Greater Duration of time (seconds)
than or equal to, Less than, Less than or equal
to, Between
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To create a new rule for events on SmartPTT Dispatcher, click Events on Dispatcher and then click Add. To

change the existing rule, click Modify or double-click on the rule name in the list of rules.

g
Rule e

Mame: Rule 2
Active:

Conditions

Connection to Radioserver: [Lost - Timeout {s): |10 =

Actions
Play Sound: [

Send Message: Messaage text -

Example: 1-93, 150
@ Subscrber 15

(7 Talkgroup 0 :

Start Voice Notification: [ | Notification 1

Stop Current Yoice —
Motification: T | Any

Connection to Radioserver: If Lost is selected, the system performs predefined actions when the connection
between SmartPTT Radioserver and the last dispatch console is terminated. If Restored is selected, the system
performs predefined actions when the first dispatch console connects SmartPTT Radioserver.
Timeout (s): Time period in seconds, after which the SmartPTT Radioserver performs actions defined under the
Actions area.
Under Actions you can define actions, which the system will perform when the rule conditions are fulfilled:
e Play Sound: When selected, you can specify the path to the folder with the audio file to play, and select a
subscriber or a talkgroup to whom you want it to be sent. Supported audio file formats are MP3, OGG, WAV.
o Send Message: When selected, you can type a text message, select recipients (subscribers or a talkgroup),
and the Send Message to Initiator option.
o Start Voice Notification: When selected, you can specify the notification to play (to learn how to create a

woice notification, see Voice Notifications). If the rule conditions were fulfilled at the moment when the operator
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played a woice notification, the wice notification specified in the rule actions won't play. To awoid this, select

Stop Current Voice Notification. You can also specify which notification must be stopped.

Activity

The Activity tab displays events that happen in the radio network. Mostly, it is used for debugging purposes, but it
can be useful for system administrators as well.

To open Activity, click the Activity tab in SmartPTT Radioserver Configurator.

’
@ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService exe.config E‘Elg
| Settings | MNetworks | Cliert List | Netwark Configuration | Rules | Awctivity | Log | Export/Import Settings | Statisticsl

Auto Scrol | CearActiviylog |
Fitter
[ Al Events [ Registration (ARS) [ Locations (Location) [ calls (cally Radio 1D
[] Messages (TMS) [T Telemetry (Tel) [ Cther (Other)
Date/Time Type System Event

There are six types of events logged:
¢ Registration,
e Messages,

e |ocations,

Telemetry,

e Calls,

Other (includes connection or disconnection of slots or control stations),
You can enter the radio ID into the Radio ID field to view the events related to the particular subscriber.
You should select one or several of those chekboxes to view events in the list.
All events are listed in the table with the following columns:
e Date/Time: The date and time of the event,
e Type: The one of the listed types above,
o System: The network where event happened,
e Event: The brief description of the event and its status.
You can apply the following settings for the list of events:
e Auto Scroll: Select to make auto refresh of the list of events. When a new event will happen in the system, it

will occur in the top of the list.
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o Clear Activity Log: Click to remove all events from the table. Events will be kept in the log files, they would be
unavailable in the table of the Activity tab.

Example: sending GPS

Type of the event Information on the event

Date and time in

the regional Sourse of the

format event

3 3 $ 3

Date/Time Type System Event

5/1/16 9:40:00 AM | Location | Control Station 1 @12.0.0.111 {111) TriggeredLocationReport id = 1, Lattude = 2577528, Longitude = 80 20889, Timestamp: 9/1/16 5:40:00 AM
T —— T
Initiator of 1D of the Timestamp in
the event event initiator the regional

farmat
Incoming event Description Content of
of the event the event

Network Configuration

In the Network Configuration tab you can set up elements of the networks used in the system. The added
elements will be displayed in the Topology tab of SmartPTT Dispatcher. You can also set up sending of alarm

notifications to predefined addresses.

”
ﬁ SmartPTT Server Configuration - C:\Program Files (xB6\SmartPTT\Server\RadioService.exe.config L =N ACY g
| Settings | Networks | Client List | Network Corfiguration | Rules | Activity | Log | Bxport/import Settings | Statistics |
-~ Radioserver L
{ag Connect Plus Network Monitoring
g MAl Systems W
WO A1 IP Site Connect 170 work. | e Nofificaiions
S [ Update Topology ] [ Expand All ] [ Collapse Al
4" SmartPTT Radioserver
42 UPS = NAI - IP Site Connect 170
fedsy Router = London
- SmatPTT Radiosenver
- UPS
" Router

Note: This tab is available only if there is a license for monitoring. If you have it, make sure you have selected the
Active check box in the Monitoring window.

To add elements of the network, select the network in the list. The supported network elements include: repeaters,
routers, UPS and location. To add devices, open the context menu by right-clicking on the existing network.
Radioservers are added automatically with the name Server.

To delete the created object, right-click on the object and then click Remove Repeater, Remove Device or

Remove Location respectively.
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Adding Repeater

To add a repeater, click Add Repeater in the context menu. At that, the window for setting up repeater parameters

will open.

-
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@g

| Settings | Networks I Client List | Network Configuration | Rules | Activity | Log | Export/Import Settings | Statisticsl

~-F Radioserver
ﬂ Connect Plus

-y MAI Systems General | Alam Notfications

-ty MAI - IF Ste Connect 170

Repeater

Biﬁ Londan Peer IO 2 =
SmartPTT Radioserver Mame Repeater 2
= UPS
& Router Description Repeater 2
1

SMNMP Parameters
Active
Community Community 1

e Peer ID: Unique identifier of the repeater.
o Name: Any random name of the repeater. The name will be used in the Topology tab in SmartPTT Dispatcher.
If the name is not set, the name from the repeater codeplug will be displayed.
e Description: Random description of the repeater.
o SNMP Parameters: Here you can set up the community name, which is used as a password for the external
SNMP client to connect to the repeater.
o Active: Enable/Disable the external SNMP client.
o Community: Community name used as a password for the external SNMP client to connect to the repeater.
In the Alarm Notifications tab you can set up automatic notification of alarms or errors occurred in the repeater.
You can have the notifications sent to your email address, to your cell phone, to an SNMP client or to radio

subscribers.
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Adding UPS and Routers and other devices

The supported devices include a router and an uninterruptible power supply (UPS). To add a device, click Add

Device in the context menu. At that, the following window will open.

-
ﬁ SmartPTT Server Configuration - C\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

ST

| Settings | Networks | Client List | Network Configuration | Rules | Activity | Log

I Export/import Settings I Statisticsl

Response Timeout, s 3

E Radioserver Device
g Connect Plus
B“ MAI Systems General | Alam Motifications
Bh- MAIl - IP Site Connect 170
Bé London Type [Gmﬂ]ﬂ N
Y SmatPTT Radioserver
ol
4% UPS Mame Router
Ll Description
Interface (192163.37.85 -| Por 162 4]
|P-address 152.168.37.86 Port |161 Iil
SMNMP Version Vi -
Community Community 2

Polling Interval, s an

[ Check Connection

SNMP Parameters

Active

Bxtemal Community Ext_Community 2

o Type: Device type. There are the following devices to choose from:

e Cisco02900 (router)
e Eaton9130 (UPS)
e Huawei Router

e UPS ATS-Convers

e Supermicro Server. This server allows you to receive information about the state of the radioserver and errors

occurred on the radioserver. To be able to receive alarms from the radioserver, add Supermicro Sener. If there

are any alarms on the radiosenver, you will see them in Monitoring event log in SmartPTT Dispatcher.

e Apc 5000

e Unknown (for other devices not specified in the list)

e Name: Random name of the device which is displayed in Topology in SmartPTT Dispatcher.
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e Description: Random description of the device.

o Interface: The radioserver IP address used for interacting with the device.

e |P-address: IP address of the device.

e SNMP Version: Version of SNMP protocol used in the system. There are two options: versions 1 and 2 (V1
and V2).

e Community: Community name, which is used as password to locally connect to the device over SNMP
protocol.

o Response Timeout, s: Time during which the server expects a response from the device. The maximum value
is 10 sec.

o Polling Interval, s: Time period at the end of which the radioserver sends a request to the device. The default
value is 30 sec.

e Check Connection: Checks if there is a connection to the device. At clicking the button a new window with
the information on the connection status opens.

e SNMP Parameters:
o Active: Enable/Disable the external SNMP client.
o External Community: Special community name which is used as password to connect to the device via

external SNMP client.

To set up the automatic alarm notifications from the device, go to the Alarm Notifications tab.
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Adding Location

If there are many repeaters and devices, they can be grouped by location. In LCP systems a location represents a

site (you can define Site ID). In Connect Plus systems a location can be used for added XRC controller. To add a

location, select the Add Location option in the context menu. At that, the following window will open.

-
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config

:Eg

| Settings | Networks | Client List | Metwork Configuration | Rules | Activity | Log

| Export/import Settings | Statistics |

-~-E Radioserver
gy Connect Plus
-y NAl Systems
E‘h MAI - IP Site Connect 170
& 2 I
b 'L SmartPTT Radioserver
g2 UPS

Location
MName London
Description London
Initial State ] Urfeld

o Name: Any random name of the location. The name is displayed in the Topology tab in SmartPTT Dispatcher.

e Description — random description of the location which is displayed in the Topology tab in SmartPTT

Dispatcher when howering the mouse pointer over the object.

o Initial State — defines how the location object is to be displayed in the Topology tab in SmartPTT Dispatcher.

If the check box is selected, all the devices and repeaters allocated to the location will be displayed by default.

If the check box is not selected, the devices won’t be seen inside the location by default. In this case, to see

the devices, you will need to click on the location object in the Topology tab.

To add or remove a device or repeater from the location, simply drag it to another place.

Note: When deleting a location with devices and repeaters allocated to it, all the devices will be deleted together

with the location.
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You can upload the network elements, instead of adding them manually. To do it, click Update Topology. At that,

a pop-up window will open and the update process will start:

rﬂ Topology Upd_ate‘ “ LEI&HN
e 499U se ]
Updating: 2/3 |

Changes Remove missing peers Update names

I Site Feer ID Change Type
1] 5 SmatPTT added Cancel | |

_ 1002 Mame change Repeater Tomsk 1-:Repeater 1 |

| cancelm || ok |

L. -

e Stop: Interrupts the ongoing update process. All the changes that were made prior interruption—these you can
see in the Changes table—will be applied after clicking OK.
o Remove missing peers: Checks if there are any missing peers to exclude them from network topology.
e Update names: Replaces names of repeaters by those defined in CPS.
The Changes table shows all the changes made during the update process. You can discard changes by clicking

Cancel. To discard all changes, click Cancel All. To apply the changes, click OK.

Alarm Notifications

SmartPTT can notify radio and telephone subscribers, and other users about errors or other malfunctions occurred

on devices used in the system or occurred during the redudnancy.
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To set up automatic radioserver redundancy error notifications, in the left list of the Network Configuration tab

click Radioserver (here your radioserver name is displayed) and create the list of notifications receivers.

@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config =l
| Settings | Networks | Client List | Network Corfiguration | Rules | Activity | Log | Export/import Settings | Statistics |
o - | Radioserver

Radioserver

Redundancy emor messages

Type Receiver

test@gmail.com

SMS = 71234567850
Message talkgro... | MAI- IP Ste Connect 170 - Slot 1; Group 1
Message fradio s... | 1-50, 78

SNMFP 0.0.0.0:162;V1;Community1

To do it, click Add. There are several types of receivers: individual radio subscribers, talkgroups, telephone

subscribers, email users, SNMP clients.
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To set up automatic alarm notifications, click Alarm Notifications in the Network Monitoring window:

.
] SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config | B

| Settings | Networks | Client List | Network Configuration | Rules | Activity | Log | Export/Import Settings | Statistics |

... Radioserver

Connect Flus Network Monitoring
MAl Systems

Network | Alam Notficat
W 11 IP Ste Connect 170 | Networ | Az Noficatons

= London Aams Select Ml || ResetAl |
'|'_ ' SmatPTT Radioserver
( [] Toelarm -

RecAlam

[¥] TempAlarm

[¥] AcPowerAlam

FanAlam
PaEepromComuption Type 1
PaEepromComuption Type2
PaEepromComuption Type3
ExciterEepromComuption Type 1
BxciterEepromComuption Type2 -

Receivers [ Add ] [ Remove ]

Type Receiver

SMS +4471234567850

SNMP 186.168.45.26:162V1;public

Message fradio s... |89, 2525, 4001-4005

Messaage ftalkaro... |IP Site Connect_170 - Slot 2_170; Group

Select all the alarms you want to be notified about. Then create the list of notifications receivers. To do it, click Add.
There are several types of receivers: individual radio subscribers, talkgroups, telephone subscribers, email users,
SNMP clients.

The alarm notifications set in the Network Monitoring tab are applied to all elements of the radio network, but you

can change them for each element of the network.
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Log

The Log tab was designed to give information about the radio senvice system events. Mostly it is used for debugging

purposes.

To see the log of the radio senice, open the Log tab.

-
@ SmartPTT Server Cenfiguration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config l =|s(E] g

| Settings I Metworks | Client List I Rules | Ad.nntyl Log | Export/Impart Settings I Statisticsl
RSCorfigurator Waming
Time:07.10.2016 10:58:14.000
Product:SmartPTT PLUS
Version 2016.10.06.01
Type:Waming
Source:ServerLogic
Tead:Systemn . Exception: License emor. Product activation key is missing.
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Export/Import Settings

SmartPTT Radioserver allows exporting configuration settings and database from one radioserver and importing them
into another. Thus, the process of setting up new radioserver(s) with similar configuration settings becomes much

easier and quicker.

How to Export or Import Settings

To export or import the radioserver settings or/and the database, click Export/Import Settings.

”
@ SmartPTT Server Configuration - C:\Program Files (x86)\SmartPTT\Server\RadioService.exe.config E@ﬂ

| Settings | Networks | Client List | Rules | Activity | Log | Export/Import Settings | Statistics |

Export
Save Export File As:

Browse

Settings
[7] Export Radioserver Database

Export

Import
Choose File to Import:

Settings
[ Import Radioserver Database
Cwemide Settings
@ Keep Server GUID
o Al

Note: Before exporting or importing the radioserver configuration settings and the database, stop the sener.

Otherwise, the buttons Browse, Export and Import will be unavailable.

Exporting the Settings and/or the Database
To export the settings and/or the database of the radioserver, take the following steps:

1. Stop the radiosenver.
2. Select the file where you want the settings to be exported by entering the path to the file in the Save

Export File As field or by clicking Browse.
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3. Select Export Radioserver Database if you want the database to be exported too.

4. Click Export.

Note: You cannot export the radioserver database separately, i.e., without the settings.

Importing the Settings and/or the Database
To import the settings and/or the database to the radioserver, take the following steps:

1. Stop the radioserver.
2. Select the file from where you want the settings to be imported by entering the path to the file in the
Choose File to Import field or by clicking Browse.
3. Select Import Radioserver Database if you want the database to be imported too.
4. Select the import mode:
1) Keep Server GUID: Import mode when the server globally unique ID is left unchanged. After
importing, there are two servers with same configuration settings, but different globally unique
GUID’s.
2) All: Import mode when all the server configuration settings, including the GUID, are replaced with the

imported values. After importing, there are two servers with absolutely identical settings and GUID’s.

5. Click Import.

Note: After importing the radioserver settings with the option to override all the existing settings (All), it is important

to delete one of the two servers to avoid GUID conflict.
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Statistics

The Statistics tab demonstrates you the following information:
¢ The total number of events on the radioserver (the Events field).
e The space on the hard drive used by the databases (the Database field).

e The space on the hard drive used by the audio records (the Audio field).

- 7 LY
@ SmartPTT Server Configuration - C:\Program Files (xEE]\SmartP'IT\Senrer\RadiDSewice.exf- ] E‘m

St [ vt ot .| ot G| e [y [ o3[ Bt L ISH1CS
Events

Registration 1]

Calls 1]

Messages 1]

Telemetry 1]

Alams 1]

Database

Radio Server Database mdf syl

Audio

Record Folder Size Mo Data

When the total size of records in your database exceeds 90% of the maximal size, a message will appear:

| =

Database Radio Server Database is 90.01% full. The program can be instable,
Please, activate the automatic database cleanup,

From this message you can learn the size of the records in your database. This message will appear at the every

start of SmartPTT Radioserver Configurator. Then, if database is not cleaned up, it will appear every 30 min.
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When the total size of records in your database reaches its maximum, another message will appear:

25|

Database Radio Server Database is full. Adding new records to the database is stopped
until the cleanup and restarting the server,

This message will appear at the every start of SmartPTT Radioserver Configurator. Then, if database is not cleaned

up, it will appear every 30 min.

Note: In rare cases you may see the message that database is 100.00% full. It actually means that database is

99.995% full.

28|

Database Radic Server Database is 100.00% full. The program can be instable,
Please, activate the automatic database cleanup.
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Input Sound Configuration Utility

Introduction

Input Sound Configuration Utility is a program that changes the parameters of the voice which
transmits to the SmartPTT Radioserver from the control station. Applying various filters you can
enhance the quality of the voice. It is not a service, so you do not need to keep this program

active while SmartPTT Radioserver is running.

Installation procedure

The program installs with the SmartPTT Radioserver. You do not need to make any actions to

assist this process.

Running the program

To run the program:
1. Go to the folder where SmartPTT Radioserver is installed (typically, it is C:\Program Files
\SmartPTT\Server\ or C:\Program Files (x86)\SmartPTT\Server\).
2. Open the ServerSoundConfigurator folder.

3. Run the ServerSoundConfigurator.exe file.
=

You may add the program shortcut to your workplace if needed.
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Using the program

Linking to the SmartPTT Radioserver

You should link Input Sound Configuration Utility to the SmartPTT Radioserver only at the first

start of the program.
To link Input Sound Configuration Utility to the SmartPTT Radioserver:

1. Run ServerSoundConfigurator.exe.
2. Click the Browse button to point the path to the SmartPTT Radioserver folder.

§1% Input Sound Configuration Utility I. = | = ﬁl

Server setup folder

Eru::-wse| Click to point the path to the server folder

Apply settings on-the-fly

3. Select Apply settings on-the-fly to apply changes immediately after you make them.

§1% Input Sound Configuration Utility I. =NNCY ﬁ]

Server setup folder
Erc:-w5E|C “Program Files (x85\5martPTT\5erver
Apply settings on-the-fly

Select to apply changes immediately after you make them

Note
If you unselect this, you should click Save to apply changes.

Linking to the SmartPTT Radioserver is complete.
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Adding the control station

To link Input Sound Configuration Utility to the control station:

1. Run ServerSoundConfigurator.exe.
2. Make sure that SmartPTT Radioserver is linked.
3. Inthe Pipelines area click Add to add a template for the control station.

’
'i'.!.'i' Input Sound Configuration Utility EIEIQ

Server setup folder
C:\ng ram Files (x88)\5martFTTS5ener
[C] Apply settings on-the-fly

Click to delete a template |

Pipelines

C5 name

iHighpass] |Lowpass| |EQ band| |Neten| |ighshelf| [Lowshet| [Bandnass]
Click to add a new template |

[ Add o )

Saw_-'\

| Click to apply changes |
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4. Copy the name of the control station from the Name field of the “"SmartPTT Server

Configuration” program.

5. In the CS name field paste the name of the control station copied from SmartPTT

Radioserver Configurator.

-
@ SmartPTT Server Configuration - C:\Program Files (x86)4SmartPTT\Server\RadioService exe.config

:@g

Settings | Metworks |C1ient List | Rules | ﬂctnntyl Log I Export/Import Settings | Sta'r.isticsl

|_:_|$;_, Control Stations

BN, Conro Siion|

o ¢ Channels
@ Audio
g Connect Plus
g NAI Systems
g Capacity Max Networks
w SIP/RTP Interfaces
----- BN SmartPTT Radiossrvers

Analog Control Station

Active

Name Wy Control Station

Copy the name of the
control station from there

C5 name My Control Station

[Highpass] [Lowpass] [EQ band] [NothHHig\hShelf] [LowSheli] [Bandpass]

Serial Port CcoMmi -
Switch Pin CD (1) -
R Pin CTS(8) -

Tx Pin RTS (/) =

TX Time-Out Timer, s

Analog Call Hangtime, ms

6. Click Save if Apply settings on-the-fly is unselected.

Paste the name of the
control station there

Warning
A You should create no more than one template for each control station.

Linking to the control station is done.
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Working with filters

Filter types
You can add seven types of filters to enhance the sound:

e Highpass: Click to mute all frequencies which are lower than the particular one.

transmittance

A

100% -

e Lowpass: Click to mute all frequencies which are higher than the particular one.

e N T,
ransmiiiance

A

100%

Freq, Hz

e EQ band: Click to amplify or attenuate particular range of frequencies.

transmittance

Freq, Hz

Gain, dB
A A
1% | +
\J
0% |
Freq, Hz
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e Notch: Click to mute the particular frequency.

transmittance

A

100%

Freq, Hz

o HighShelf: Click to amplify all frequencies which are higher that the particular one.

transmittance Gain. dB
ain,
A A
100% 417

frequency

0% } |
Freq, Hz

e LowShelf: Click to add a minimum frequency of the range to be attenuated.

transmittance

A
100% —- f
YGain, dB
0% | | .
Freq, Hz
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e Bandpass: Click to add a filter with a narrow passing band.

transmittance

100% .

| | £ N
frequency

Warning
A Try to avoid the possible intersection of filters with opposite effects.

To select a proper set of filters, please, refer to the technical documentation on your radios and

control stations.

Adding filters
Adding Highpass

To add a highpass filter:

1. Click Highpass in the control station template. A new line will appear.

’
'i'.!.'i' Input Sound Configuration Utility E@g

Server setup falder
C:\F‘ rogram Files (xB8)\5martPTT\Server
ol Apply settings on-the-fly

| Type the minimum frequency |

Pipelines

C5 name My Contrel Station
Highpass Freg Hz 44p

[highpass] [Lcwpa 55] [EQ I:uand] [Notch] [HighSheIf] [anSheH] [Bandpass]

| Click to add highpass filter | | Click to delete filter |
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2. Type the minimum frequency (measured in hertz) in the Freq, Hz field.
3. Click Save if Apply settings on-the-fly is unselected.
You should apply only one Highpass filter for each control station.

Adding Lowpass

To add a lowpass filter:

1. Click Lowpass in the control station template. A new line will appear.

’
'H.'i' Input Sound Configuration Utility E@g

Server setup folder

MC “Program Files (x86\5martPTT\5erver
[C] Apply settings on-the-fly
Pipelines | Type the maximum frequency |

C5 name My Control Station

Lowpass Freq, Hz 44p

[highpass] [Lc:wpa 55] [EQ I:uand] [Notch] [HighSheIf] [anShEH] [Eandpass]

| Click to add lowpass filter | | Click to delete filter |

2. Type the maximum frequency (measured in hertz) in the Freq, Hz field.
3. Click Save if Apply settings on-the-fly is unselected.
You should apply only one Lowpass filter for each control station.
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Adding EQBand

To add a gain filter:

1. Click EQband in the control station template. A new line will appear.

§1% Input Sound Configuration Utility EIE'&J

Server setup folder Type the central frequency
Browse|C\Program Files (x88)\5martPTT\Server

[C] Apply settings an-the-fly Bl RosdE

Type the gain index

Pipelines
CSname My Control Station Del
EQ band Freq Hz 44p  Width, Hz 1p Gain, dB  _2 Del

[I—.ighpassl [Lowpa 55] [EQ I:uandl [N-;:ut-::h] [HighSheIfl [Lchhelfl [Eandpass]

Click to add lowpass filter Click to delete filter

2. Type the required parameters:
e Freq, Hz: Type the central frequency (measured in hertz) for the range you need to amplify
or attenuate.
e Width, Hz: Type the width of a frequency band (measured in hertz) you need to amplify or
attenuate.
e Gain, dB: Type the gain index (in decibells). You can type positive values to amplify the

sound or negative values to attenuate the sound.

Information
If you type 2 in the Gain field, you will hear a twice-loud voice. If you type -3 in the Gain field

you will hear a thrice-low voice.

3. Click Save if Apply settings on-the-fly is unselected.
You can apply multiple gain filters with different frequency ranges for each control station.
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Adding Notch

To add a notch filter:

1. Click Notch in the control station template. A new line will appear.

’
'i'.!.'i' Input Sound Configuration Utility E@g

Server setup folder
C:‘-LF' rogram Files (xB8)\5martPTT\Server
[C] Apply settings an-the-fly

Pipelines ' Type the central frequency |
CSname My Control Station /

Motch Freg Hz 44p

|Highpass| |Lowpass| |EQ band| |Neteh| | HighShelf| [LowSheif| [Bandpass|

| Click to add notch filter | ' Click to delete filter |

2. Type the frequency you want to be muted in the Freq, Hz field.
3. Click Save if Apply settings on-the-fly is unselected.
You can apply multiple notch filters with different frequencies for each control station.

Adding HighShelf

To add a high-shelf filter:

1. Click HighShelf in the control station template. A new line will appear.

-
'i'.!.'i' Input Sound Configuration Utility EIEIQ
Server setup falder
C:\Prﬂgram Files (x88)\SmartPTT\Server
[C] Apply settings an-the-fly | Type the border frequency |
Pipelines / ' Type the gain index |
C5 name My Control Station / /
HighShelf Freg Hz 44g Gain, dB .3
|Highpass| |Lowpass| |EQ band| |Naten| | Highsheif| [Lowshei| [Bandpass| /
| Click to add high-shelf filter | ' Click to delete filter |
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2. Type the required parameters:

e Freq, Hz: Type the border frequency for the range you want to amplify.

e Gain, dB: Type the gain index (measured in decibells) for the amplifying range.

3. Click Save if Apply settings on-the-fly is unselected.

Adding LowShelf

To add a low-shelf filter:

1. Click LowShelf in the control station template. A new line will appear.

'i'.!.'i' Input Sound Configuration Utility

:.IEI$|

Server setup falder
C “Program Files (x85\5martPTT\5erver
] Apply settings on-the-fly

Pipelines

| Type the border frequency |

CS name My Contrel Station

I Type the gain index I—

/

LowShelf

Freq, Hz 440

Gain, dB

-2 .
[highpass] [anpa 55] [EQ I:uand] [Notch] [HighSheIf] [anShEIf] [Eandpass] /

' Click to delete filter |

| Click to add low-shelf filter |

2. Type the required parameters:

e Freq, Hz: Type the border frequency for the range you want to attenuate.

e Gain, dB: Type the gain index (measured in decibells) for the attenuating range.

3. Click Save if Apply settings on-the-fly is unselected.
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Adding Bandpass

To add a bandpass filter:

1. Click Bandpass in the control station template. A new line will appear.

§1% Input Sound Configuration Utility =NNC X

Server setup folder

Browse|C\Program Files (x88)\5martPTT\Server

[C] Apply settings an-the-fly

Type the frequency to pass

Pipelines
CSname My Control Station Del
Bandpass Freq Hz 440 Del

[I—.ighpassl [Lowpa 55] [EQ I:uandl [N-;:ut-::h] [HighSheIfl [Lchhelfl [Eandpass]

Click to add bandpass filter | | Click to delete filter

2. Type the frequency you want filter to pass in the Freq, Hz field.
3. Click Save if Apply settings on-the-fly is unselected.

Reordering filters
To reorder filters in the template you should create another template with the right order of filters.

You cannot change the order of filters in the current template.

Editing filters
To edit a filter:

1. Change values in the corresponding fields.
2. Click Save if Apply settings on-the-fly is unselected.

Deleting filter

To delete a filter:

1. Click Del next to the filter.
2. Click Save if Apply settings on-the-fly is unselected.
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